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Information in this document is subject to change without notice. No part of this document may be
reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without
the express written permission of:
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Sonotron NDT

4, Pekeris str., Rabin Science Park, Rehovot, 76702, Israel
Phone:++972-(0)8-9477701 Fax:++972-(0)8-9477712
http://www.sonotronndt.com

EC Declaration of Conformity

Council Directive 89/336/EEC on Electromagnetic Compatibility, as amended by
Council Directive 92/31/EEC & Council Directive 93/68/EEC

Council Directive 73/23/EEC ( Low Voltage Directive ), as amended by Council
Directive 93/68/EEC

We, Sonotron NDT Ltd., 4 Pekeris Street, Rehovot, 76702 Israel, certify that the product
described is in conformity with the Directives 73/23/EEC and 89/336/EEC as amended

ISONIC 2008

Portable Digital 8-Channel Ultrasonic Flaw Detector and Recorder

The product identified above complies with the requirements of above EU directives by
meeting the following standards:

Safety
EN 61010-1:1993

EMC
EN 61326:1997
EN 61000-3-2:1995 /A1:1998 /A2:1998 /A14:2000
EN 61000-3-3:1995

| IS0 9001 REGISTERED
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Sonotron NDT

4, Pekeris str., Rabin Science Park, Rehovot, 76702, Israel
Phone:++972-(0)8-9477701 Fax:++972-(0)8-9477712
http://www.sonotronndt.com

Declaration of Compliance

We, Sonotron NDT Ltd., 4 Pekeris Street, Rehovot, 76702 Israel certify that the product
described is in conformity with National and International Codes as amended

ISONIC 2008

Portable Digital 8-Channel Ultrasonic Flaw Detector and Recorder

The product identified above complies with the requirements of following National and
International Codes:

e ASME Section | — Rules for Construction of Power Boilers

e ASME Section VIII, Division 1 — Rules for Construction of Pressure Vessels

e ASME Section VIII, Division 2 — Rules for Construction of Pressure Vessels. Alternative
Rules
ASME Section VIII Article KE-3 — Examination of Welds and Acceptance Criteria
ASME Code Case 2235 Rev 9 — Use of Ultrasonic Examination in Lieu of Radiography
Non-Destructive Examination of Welded Joints — Ultrasonic Examination of Welded
Joints. — British and European Standard BS EN 1714:1998
Non-Destructive Examination of Welds — Ultrasonic Examination — Characterization of
Indications in Welds. — British and European Standard BS EN 1713:1998
Calibration and Setting-Up of the Ultrasonic Time of Flight Diffraction (TOFD)
Technique for the Detection, Location and Sizing of Flaws. — British Standard BS
7706:1993
WI 00121377, Welding — Use Of Time-Of-Flight Diffraction Technique (TOFD) For
Testing Of Welds. — European Committee for Standardization — Document # CEN/TC
121/SC 5/WG 2 N 146, issued Feb, 12, 2003
ASTM E 2373 — 04 — Standard Practice for Use of the Ultrasonic Time of Flight iffraction
(TOFD) Technique
Non-Destructive Testing — Ultrasonic Examination — Part 5: Characterization and Sizing
of Discontinuities. — British and European Standard BS EN 583-5:2001
Non-Destructive Testing — Ultrasonic Examination — Part 2: Sensitivity and Range
Setting. — British and European Standard BS EN 583-2:2001
Manufacture and Testing of Pressure Vessels. Non-Destructive Testing of Welded
Joints. Minimum Requirement for Non-Destructive Testing Methods — Appendix 1 to
AD-Merkblatt HP5/3 (Germany).— Edition July 1989

' 1SO 9001 REGISTERED |

MGMT. 8YS.
RvA G024

DNV Cartification B.V,, The Nathedands
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FCC Rules

This ISONIC 2008 ultrasonic flaw detector and data recorder (hereinafter called ISONIC 2008) has been tested and found to comply
with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try
to correct the interference by one or more of the following measures:

. Reorient or relocate the receiving antenna

. Increase the separation between the equipment and receiver

. Connect the equipment into an outlet on a circuit different from that to which the receiver is connected

. Consult the dealer or an experienced radio/TV technician for help

Safety Regulations

Please read this section carefully and observe the regulations in order to ensure your safety and operate the system as intended
Please observe the warnings and notes printed in this manual and on the unit

The ISONIC 2008 has been built and tested according to the regulations specified in EN60950/VDEQ805. It was in perfect working
condition on leaving the manufacturer's premises

In order to retain this standard and to avoid any risk in operating the equipment, the user must make sure to comply with any hints and
warnings included in this manual

Depending on the power supply the ISONIC 2008 complies with protection class | /protective grounding/, protection class IlI, or
protection class IlI

Exemption from statutory liability for accidents

The manufacturer shall be exempt from statutory liability for accidents in the case of non-observance of the safety regulations by any
operating person

Limitation of Liability

The manufacturer shall assume no warranty during the warranty period if the equipment is operated without observing the safety
regulations. In any such case, manufacturer shall be exempt from statutory liability for accidents resulting from any operation

Exemption from warranty
The manufacturer shall be exempt from any warranty obligations in case of the non-observance of the safety regulations
The manufacturer will only warrant safety, reliability, and performance of the ISONIC 2008 if the following safety regulations are closely

observed:

. Setting up, expansions, re-adjustments, alterations, and repairs must only be carried out by persons who have been authorized by
manufacturer

e  The electric installations of the room where the equipment is to be set up must be in accordance with IEC requirements

e  The equipment must be operated in accordance with the instructions

e  Any expansions to the equipment must comply with the legal requirements, as well as with the specifications for the unit concerned

. Confirm the rated voltage of your ISONIC 2008 matches the voltage of your power outlet

e  The mains socket must be located close to the system and must be easily accessible

. Use only the power cord furnished with your ISONIC 2008 and a properly grounded outlet /only protection class I/

. Do not connect the ISONIC 2008 to power bar supplying already other devices. Do not use an extension power cord

e Any interruption to the PE conductor, either internally or externally, or removing the earthed conductor will make the system unsafe
to use /only protection class I/

e Any required cable connectors must be screwed to or hooked into the casing

e  The equipment must be disconnected from mains before opening

e To interrupt power supply, simply disconnect from the mains

e Any balancing, maintenance, or repair may only be carried out by manufacturer authorized specialists who are familiar with the

inherent dangers

Both the version and the rated current of any replacement fuse must comply with specifications laid down

. Using any repaired fuses, or short-circuiting the safety holder is illegal

If the equipment has suffered visible damage or if it has stopped working, it must be assumed that it can no longer be operated

without any danger. In these cases, the system must be switched off and be safeguarded against accidental use

Only use the cables supplied by manufacturer or shielded data cable with shielded connectors at either end

Do not drop small objects, such as paper clips, into the ISONIC 2008

Do not put the ISONIC 2008 in direct sunlight, near a heater, or near water. Leave space around the ISONIC 2008

Disconnect the power cord whenever a thunderstorm is nearby. Leaving the power cord connected may damage the ISONIC 2008

or your property

e  When positioning the equipment, external monitor, external keyboard, and external mouse take into account any local or national
regulations relating to ergonomic requirements. For example, you should ensure that little or no ambient light is reflected off the
external monitor screen as glare, and that the external keyboard is placed in a comfortable position for typing
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Do not allow any cables, particularly power cords, to trail across the floor, where they can be snagged by people walking past

The voltage of the External DC Power Supply below 11 V is not allowed for the ISONIC 2008 unit

The voltage of the External DC Power Supply above 16 V is not allowed for the ISONIC 2008 unit

Charge of the battery for the ISONIC 2008 unit is allowed only with use of the AC/DC converters / chargers supplied along with it or
authorized by Sonotron NDT

Remember this before:

balancing

carrying out maintenance work
repairing

exchanging any parts

Please make sure batteries, rechargeable batteries, or a power supply with SELV output supplies power

Software

ISONIC 2008 is a software controlled inspection device. Based on present state of the art, software can never be completely free of
faults. ISONIC 2008 should therefore be checked before and after use in order to ensure that the necessary functions operate perfectly

in the envisaged combination. If you have any questions about solving problems related to use the ISONIC 2008, please contact your
local Sonotron NDT representative
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1. Introduction
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ISONIC 2008 uniquely combines functionality and mobility of high performance single/dual portable digital
ultrasonic flaw detector with recording, imaging, and data processing capabilities of smart computerized
inspection system

ISONIC 2008 resolves a variety of ultrasonic inspection tasks:

e A-Scan-based inspection using conventional pulse echo, back echo attenuation, and through
transmission techniques

¢ Single Channel Straight Line Scanning and Recording:

= Thickness Profile B-Scan imaging and recording is performed through continuous
capturing of wall thickness readings along probe trace

= B-Scan cross-sectional imaging and recording of defects for longitudinal and shear
wave inspection is performed through continuous measuring of echo amplitudes and
reflectors coordinates along probe trace

= CB-Scan horizontal plane-view imaging and recording of defects for shear, surface,
and guided wave inspection is performed through continuous measuring of echo amplitudes
and reflectors coordinates along probe trace

= TOFD Inspection — RF B-Scan and D-Scan Imaging
e Multi-Channel Straight Line Scanning and Strip Chart Recording:

= Multi-Channel Thickness Profile B-Scan imaging and recording is performed through
continuous capturing of wall thickness readings along probes trace

=  Multi-Channel Combined TOFD and Pulse Echo Weld Inspection and Recording is
performed through continuous capturing of TOFD RF A-Scans and pulse echo channels
amplitudes and reflectors coordinates along probes trace parallel to the weld

= Multi-Channel Pulse Echo Flaw Detection for shear, surface, and guided wave inspection
is performed through continuous measuring of echo amplitudes and reflectors coordinates
along probes trace
= etc
For Single and Multi-Channel Straight Line Scanning and Recording it may be used:

o0 Time-based mode (built-in real time clock)
0 True-to-location mode (built-in incremental encoder interface)
e XY-Scanning and Recording with C-Scan and B-Scan imaging is also possible if using optional

USB interface to multi-axis mechanical encoder and appropriate software package

For all types of Straight Line Scanning and XY-Scanning records A-Scans are captured for each probe
position along probe trace and may be played back and evaluated off-line at postprocessing stage. This
unique feature makes it possible off-line defect characterization through echo-dynamic pattern
analysis

Thickness Profile B-Scan Data recorded during Straight Line Scanning is presented in the format
compatible with various Risk Based Inspection and Maintenance procedures

ISONIC 2008 has practically unlimited capacity for storing of:

e Single A-Scans accompanied with corresponding instrument settings

e Ultrasonic signal spectrum graphs (FFT) accompanied with corresponding RF A-Scans and
instrument settings
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Various A-Scans sequence records along with corresponding Thickness Profiles, B-Scans, CB-
Scans, TOFD Maps, strip charts depending on mode of operation selected; each record is
accompanied with corresponding instrument settings

ISONIC 2008 complies with the requirements of National and International Codes:

oy Ny

ASME Section | — Rules for Construction of Power Boilers

ASME Section VIII, Division 1 — Rules for Construction of Pressure Vessels

ASME Section VIII, Division 2 — Rules for Construction of Pressure Vessels. Alternative Rules
ASME Section VIII Article KE-3 — Examination of Welds and Acceptance Criteria

ASME Code Case 2235 Rev 9 — Use of Ultrasonic Examination in Lieu of Radiography
Non-Destructive Examination of Welded Joints — Ultrasonic Examination of Welded Joints. —
British and European Standard BS EN 1714:1998

Non-Destructive Examination of Welds — Ultrasonic Examination — Characterization of
Indications in Welds. — British and European Standard BS EN 1713:1998

Calibration and Setting-Up of the Ultrasonic Time of Flight Diffraction (TOFD) Technique for the
Detection, Location and Sizing of Flaws. — British Standard BS 7706:1993

WI 00121377, Welding — Use Of Time-Of-Flight Diffraction Technique (TOFD) For Testing Of
Welds. — European Committee for Standardization — Document # CEN/TC 121/SC 5/WG 2 N
146, issued Feb, 12, 2003

ASTM E 2373 — 04 — Standard Practice for Use of the Ultrasonic Time of Flight Diffraction
(TOFD) Technique

Non-Destructive Testing — Ultrasonic Examination — Part 5: Characterization and Sizing of
Discontinuities. — British and European Standard BS EN 583-5:2001

Non-Destructive Testing — Ultrasonic Examination — Part 2: Sensitivity and Range Setting. —
British and European Standard BS EN 583-2:2001

Manufacture and Testing of Pressure Vessels. Non-Destructive Testing of Welded Joints.
Minimum Requirement for Non-Destructive Testing Methods — Appendix 1 to AD-Merkblatt
HP5/3 (Germany).— Edition July 1989
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2. Technical Data
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Number of Channels:
Pulsing/Receiving
Methods:

Pulse Type**:
Initial Transition**:
Pulse Amplitude**:

Pulse Duration*:
Modes*:

PRF**;

Optional Sync Output /
Input**:

Gain*;

Advanced Low Noise
Design**:

Frequency Band**:
Digital Filter*:
Ultrasound Velocity*:

Range*:

Display Delay*:
Probe Angle*:
Probe Delay*:
Display Modes*:

Reject*:
DAC/ TCG*

DGS*:

Multiple DAC/DGS
Curves*:

Gates*:

Gate Start and Width*:

Gate Threshold*:
Measuring Functions —
Digital

Display Readout*:

Freeze (A-Scans and
Spectrum Graphs)*:

Encoder Interface:
Encoding:

Imaging Modes:

Standard Length of one
Straight Line Scanning
record:

8

Parallel - all channels do fire, receive, digitize, and record signals
simultaneously

Sequential — cycles of firing, receiving, digitizing, and recording signals by
each channel are separated in time in a sequence loop

Bipolar Square Wave Pulse

<5 ns (10-90%)

Smoothly tunable (12 levels) 75V ... 400 V peak to peak into 50 Q - global
parameter for all 8 channels

50...600 ns for each half wave synchronously controllable in 10 ns step
Single / Dual

0 — optionally; 15...5000 Hz controllable in 1 Hz resolution

Max +5V, 1 <5 ns, t 2100 ns, Load Impedance > 50 Q

0...100 dB controllable in 0.5 dB resolution
81 pnV peak to peak input referred to 80 dB gain / 25 MHz bandwidth

0.2 ... 25 MHz Wide Band

32-Taps FIR band pass with controllable lower and upper frequency limits
300...20000 m/s (11.81...787.4 "/ms) controllable in 1 m/s (0.1 "/ms)
resolution

0.5...7000 ps controllable in 0.01 ps resolution

0...3200 ps controllable in 0.01 ps resolution

0...90° controllable in 1° resolution

0 to 70 us controllable in 0.01 us resolution - expandable

RF, Rectified (Full Wave / Negative or Positive Half Wave), Signal's Spectrum
(FFT Graph)

0...99 % of screen height controllable in 1% resolution
Theoretical — through keying in dB/mm (dB/") factor
Experimental — through sequential recording echo amplitudes from variously
distanced equal reflectors

46 dB Dynamic Range, Slope <20 dB/ps, Capacity < 40 points

Available for Rectified and RF Display

Standard Library for 18 probes / unlimitedly expandable

Main DAC/DGS Curve plus up to 3 (three) curves with individually
controllable levels in £14 dB range

2 Independent Gates /unlimitedly expandable

Controllable over whole variety of A-Scan Display Delay and A-Scan Range
in 0.1 mm /// 0.001" resolution

5...95 % of A-Scan height controllable in 1 % resolution

27 automatic functions /expandable; Dual Ultrasound Velocity Measurement

Mode for Multi-Layer Structures; Curved Surface / Thickness / Skip
correction for angle beam probes; Ultrasound velocity and Probe Delay
Auto-Calibration for all types of probes

Freeze All — A-Scans and Spectrum Graphs / Freeze Peak — A-Scans / All
measurements functions, manipulating Gates, and £6dB Gain varying are
available for frozen signals

Built-in controller and interface for incremental mechanical encoder
Time-based (built-in real time clock — 0.02 sec resolution) — for single
channel operation only

True-to-location (incremental encoder — 0.5 mm resolution) — for single and
multi-channel operation

Single Channel: Thickness Profile B-Scan, Cross-sectional B-Scan, Plane
View CB-Scan, TOFD

Multi-Channel: Strip Charts of 4 types (Amplitude/TOF P/E; Map; TOFD;
Coupling)

50...20000 mm (2"...800"), automatic scrolling

ISONIC 2008 from Sonotron NDT - Operating Manual — Revision 1.06 - Page 15 of 316



Method of Record:
Region of Interest*:

Off-Line Image
Analysis*:

Data Reporting**:

Data Storage Capacity:

On-Board Computer:
RAM:

Internal Flash Memory -
Quasi HDD:

Outputs:

Screen:

Controls:
Compatibility with the
external devices:

Operating System:
Power:

Complete raw data recording

Controllable over entire Display Delay, Probe Delay, Range, Ultrasound
Velocity and other appropriate channel settings

Recovery and play back of A-Scan sequence at various gain levels
Echo-dynamic pattern analysis

Defects sizing, outlining, pattern recognition

Converting strip types

Converting Record into ASCII Format / MS Excel format / MS Word Format
Direct printout of Calibration Dumps, A-Scans, Spectrum Graphs, Thickness
Profile B-Scans, cross-sectional B-Scans, plane view CB-Scans, TOFD maps,
strip charts

At least 100000 sets including calibration dumps accompanied with A-Scans
and/or Spectrum Graphs

At least 10000 sets including calibration dumps accompanied with
Thickness Profile B-Scans, cross-sectional B-Scans, plane view CB-Scans,
TOFD maps, strip charts, and complete sequence of A-Scans captured
during scanning

AMD LX 800 - 500MHz

1 Gigabyte

4 Gigabytes

LAN, USB X 2, PS 2, SVGA

6.5" High Color Resolution (32 bit) SVGA 640x480 pixels 133x98 mm (5.24" x
3.86") Sun-readable LCD; Maximal A-Scan Size (working area) — 130x92 mm
(5.12" x 3.62")

Front Panel Sealed Keyboard, Front Panel Sealed Mouse, Touch Screen

PS 2 Keyboard and Mouse, USB Keyboard and Mouse, USB Flash Memory
card, Printer through USB or LAN, PC through USB or LAN, SVGA External
Monitor

Windows™ XP embedded

Mains - 100...240 VAC, 40...70 Hz, auto-switch; Battery 12V 8AH up to 6
hours continuous operation

Housing: IP 53 rugged aluminum case with carrying handle
Dimensions: 265x156x101 mm (10.43"x6.14"x3.98") - without battery
265x156x139 mm (10.43"x6.14"x5.47") - with battery
Weight: 2.500 kg (5.50 Ibs) - without battery
3.430 kg (7.55 Ibs) - with battery
* individually controllable per channel
** common parameter / mode / feature for all channels
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3. ISONIC 2008 — Scope of Supply
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Detector and Recorder

. ISONIC 2008 Electronic unit — including:
> Internal PC (AMD LX 800 500 MHz, RAM 1G, Quazi-HDD Flash Memory
Card 4G, Windows XP Embedded, active TFT sVGA LCD High Color Sun-
Readable Touch Screen, Built-In Interfaces: 2XUSB; Ethernet; PS/2; Front
Panel Sealed Keyboard and Mouse; sVGA output)
> 100 ... 250 VAC AC/DC converter
> SE 254000 - 8 channel UDS 3-6 Pulser Reciver Card:
O Bipolar Square Wave — Tunable Width / Tunable Firing Level
Pulser; Single / Dual Modes of Operation; Special Probe Protection Circuit
to Prevent Probe Damage for Not Properly Adjusted Pulse Width
d Gain: 0...100 dB controllable in 0.5 dB resolution; Advanced
Low Noise Design: 81uV peak to peak input referred to 80 dB gain / 25
MHz bandwidth; frequency Band: 0.2 ... 25 MHz Wide Band / 32-Taps FIR
bandpass digital filter with controllable lower and upper frequency limits
O  Built-In Incremental Encoder Interface

. Software
O ISONIC 2008 Multi-Functional Package (SWA 99C08200)
®  Single Channel Operation
¢ A-Scan

= A-Scan (Full Wave / Negative Half Wave / Positive
Half Wave rectification; RF)
= Selectable A-Scan color scheme

= DAC, DGS, TCG

= Auto Calibration for Straight Beam and Angle Beam
Probes

= Curved Surface / Wall Thickness / Skip - Correction
for Angle Beam Inspection

= Smart Automatic Measurements of Gated Signals -
Flank / Flank First / Top / Top First

= FFT (Frequency Domain Signal Presentation) -
additional feature for defects evaluation and / or pattern recognition /
probes characterization

= Enhanced Signal Evaluation for Live and Frozen A-
Scans including Gain Adjustments whilst in Freeze Mode

= Dual Ultrasound Velocity Multiecho Measurements
Mode

= Comprehensive Setup and A-Scan / FFT graph
report, Direct Connection To any Type of USB or LAN Windows Printer

€  Thickness Profile Imaging and Recording (Typical
Application: Corrosion characterization)

= Continuous measuring of thickness value along
probe trace
= Time-based (real time clock) and true-to-location
(built-in incremental encoder interface) modes of data recording
= Recording of complete sequence of A-Scans along
with thickness profile
= Off-line evaluation of thickness profile images
featured with:
P Sizing of thickness damages at any location
along stored image - remaining thickness, thickness loss, and length
of damage

» Play-back and evaluation of A-Scans obtained
during thickness profile recording

» Echodynamic pattern analysis

> Off-line reconstruction of thickness profile image
for various Gain / Gate setup

= Comprehensive Setup and Scanning Reporting,
Direct Connection To any Type of USB or LAN Windows Printer

€  B-Scan cross-sectional imaging and recording of
defects for longitudinal and shear wave inspection (Typical
Application: Pulse echo inspection of welds, composites, metals,
plastics, and the like)
= Continuous measuring of echo amplitudes and
reflectors coordinates along probe trace

Item Order Code Note
(Part #)
ISONIC 2008 — Portable Digital 8-Channel Ultrasonic Flaw SA 80480
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Item Order Code Note
(Part #)

= Time-based (real time clock) and true-to-location
(built-in incremental encoder interface) modes of data recording
= Recording of complete sequence of A-Scans along
with B-Scan defects images
= Off-line evaluation of B-Scan record images featured
with:
P Sizing of defects at any location along stored
image — coordinates and projection size
» Play-back and evaluation of A-Scans obtained
during B-Scan imaging and recording

» Echodynamic pattern analysis

» Defects outlining and pattern recognition based
on A-Scan sequence analysis

» Off-line reconstruction of B-Scan defects images
for various Gain / Rejection level setup

» DAC / DGS B-Scan normalization

= Comprehensive Setup and Scanning Reporting,
Direct Connection To any Type of USB or LAN Windows Printer
€  CB-Scan horizontal plane-view imaging and
recording of defects for shear, surface, and guided wave inspection
(Typical Application: Long range pulse echo and CHIME inspection of
annular plates and piping, stress corrosion, etc; weld inspection,
surface wave inspection)
= Continuous measuring of echo amplitudes and
reflectors coordinates along probe trace
= Time-based (real time clock) and true-to-location
(built-in incremental encoder interface) modes of data recording
= Recording of complete sequence of A-Scans along
with CB-Scan defects images
= Off-line evaluation of CB-Scan record images
featured with:
P Sizing of defects at any location along stored
image — coordinates and projection size
» Play-back and evaluation of A-Scans obtained
during CB-Scan imaging and recording
» Echodynamic pattern analysis
» Defects outlining and pattern recognition based
on A-Scan sequence analysis

» Off-line reconstruction of CB-Scan defects
images for various Gain / Rejection level setup

» DAC /DGS CB-Scan normalization
= Comprehensive Setup and Scanning Reporting,
Direct Connection To any Type of USB or LAN Windows Printer
€  TOFD Inspection — RF B-Scan and D-Scan Imaging
(Typical Application: weld inspection; CHIME inspection)
= Time-based (real time clock) and true-to-location
(built-in incremental encoder interface) modes of data recording

= Averaging A-Scans whilst recording as per operator's
selection

= Recording of complete sequence of A-Scans along
with TOFD map

= Off-line evaluation of TOFD Map featured with:
» Improvement of near to surface resolution

through removal of lateral wave and back echo records from TOFD
Map

P Linearization and straightening of TOFD Map

P Increasing contrast of TOFD images through
varying Gain and rectification

» A-Scan sequence analysis
» Defects pattern recognition and sizing

= Comprehensive Setup and Scanning Reporting,
Direct Connection To any Type of USB or LAN Windows Printer

° Multi-Channel Operation

= Continuous capturing and recording of up to 8
channel complete sequence of A-Scans along probe trace and real time
creating of up to 8 channel strip chart

ISONIC 2008 from Sonotron NDT - Operating Manual — Revision 1.06 - Page 19 of 316




Item Order Code Note
(Part #)

= Time-based (real time clock) and true-to-location
(built-in incremental encoder interface) modes of data recording

= 4 types of strip chart selectable by operator:

¥V TOFD
VvV  Map
V' PE Amplitude / TOF
¥V Coupling
= Comprehensive Off-line evaluation of recorded strip
chart:

» Play-back and evaluation of A-Scans
» Marking Defects and Creating Defect List
» Varying layout of strip chart

Conversion of Map Strips into PE Amplitude
TOF strips and reverse conversion of PE Amplitude TOF strips into

Map Strips

» Varying ROI and rebuild of PE Amplitude/TOF
Strips

» Stripped C-Scan Creating

» Echodynamic pattern analysis

» Individual Postprocessing of Each strip based
on strip type:
VvV TOFD
v  Map

V'  PE Amplitude / TOF
= Comprehensive Setup and Scanning Reporting,
Direct Connection To any Type of USB or LAN Windows Printer

. USB Flash Drive for External Data Storage

. 12 months warranty

. Lifetime free software update

Backup Pen-Drive SFD 2008098 [Operating Manual on the
Backup Pen-Drive

Soft carrying bag with neck strap SK 2005101  [Optional item
Rechargeable Battery Ni MH 9 AH / 12V SK 2005102  (Optional item
Battery Charger SK 2005103  [Optional item
Required for battery charge
Travel Hard Case SK 2005104  [Optional item
IAllows safe cargo
transportation
External USB Keyboard SK 2005105  [Optional Item

Extremely Useful at
Postprocessing Stage

External USB Optical Mouse SK 2005106  [Optional Item
Extremely Useful at
Postprocessing Stage

Postprocessing SW Package for Office PC: IOFFICE - ISONIC Office SWA99C0203 |Optional item

= comprehensive postprocessing of inspection results files
captured by ISONIC 2001, ISONIC 2005, ISONIC 2006, ISONIC
2007, ISONIC 2008 instruments using Inspection SW Packages
of any type

= automatic creating of ISONIC 2001, ISONIC 2005, ISONIC
2006, ISONIC 2007, ISONIC 2008 inspection reports in MS

Word® format
Dual Channel TOFD preamplifier package including: SA 80442 Optional Item
= Dual Channel TOFD preamplifier Improves long cable

connection to ultrasonic
probes. Typical applications
are TOFD, Corrosion
Detection, etc performed
with probes fitted into
scanner / crawler frame —
refer to chapter 10 of this
Operating Manual

= Set of 2 low noise coaxial cables (10 meters length each) for
connection to the signal input of ISONIC instrument
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# Item Order Code Note
(Part #)

11 | ISONIC Alarmer - standard firmware configuration and hardware SE 554780987 [Optional Item
platform including: Refer to paragraph 9.6.5 of
= Internal Speaker functioning according to alarm logic settings of this Operating Manual
UDS 3-5 Pulser Receiver in the ISONIC 2005, 2006, 2007 instruments
/ UDS 3-6 Pulser Receiver of ISONIC 2008 Instrument
= Speaker Volume Control Wheel
= Headphone Connector
= 25-pin programmable Input / Output interface (blank)
= USB port and cable for connecting to ISONIC 2005, 2006, 2007,

2008 instrument
12 | Ultrasonic probes, fixtures, scanners, cables and other accessories Optional Items

depending on the inspection tasks to be resolved

Ultrasonic probes, fixtures,
scanners, cables and other
accessories from any

manufacturer may be used
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4. Operating ISONIC 2008
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Please read the following information before you use ISONIC 2008. It is essential to read and understand
the following information so that no errors occur during operation, which could lead damaging of the unit or
misinterpretation of inspection results

4.1. Preconditions for ultrasonic testing with ISONIC 2008

Operator of ISONIC 2008 must be certified as at least Level 2 Ultrasonic Examiner additionally having the
adequate knowledge of

e operating digital ultrasonic flaw detector

e basics of computer operating in the Windows™ environment including turning computer on/off,
keyboard, touch screen and mouse, starting programs, saving and opening files
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4.2. ISONIC 2008 Controls and Terminals

Probe Terminal

UDS 3-6 Channel #

Pulser Mode: Dual

Pulser Mode: Single

1-1 1 Receiver Input Firing Output / Receiver Input
2-1 1 Firing Output Not Used
1-2 2 Receiver Input Firing Output / Receiver Input
2-2 2 Firing Output Not Used
1-3 3 Receiver Input Firing Output / Receiver Input
2-3 3 Firing Output Not Used
1-4 4 Receiver Input Firing Output / Receiver Input
2-4 4 Firing Output Not Used
1-5 5 Receiver Input Firing Output / Receiver Input
2-5 5 Firing Output Not Used
1-6 6 Receiver Input Firing Output / Receiver Input
2-6 6 Firing Output Not Used
1-7 7 Receiver Input Firing Output / Receiver Input
2-7 7 Firing Output Not Used
1-8 8 Receiver Input Firing Output / Receiver Input
2-8 8 Firing Output Not Used
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®

PS 2 Port Switch has 2 positions:
Front — Front Panel Keyboard and Mouse active; PS2 Port inactive
Rear — Front Panel Keyboard and Mouse inactive; PS2 Port active
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4.3. Turning On / Off

ISONIC 2008 may be powered from:

O 100...250 VAC through external AC/DC converter
O External 11...16V DC source (12V — typical)
O Rechargeable battery (optionally)

AC Power Supply

O Ensure that power switch is in O position before connecting power cords

O Connect one end of AC power cord to AC/DC converter and plug another end into AC mains

O Connect DC power cord with suppression filter outgoing from AC/DC converter to DC Supply
Voltage Input of ISONIC 2008

External DC Power Supply

O Ensure DC mains do supply voltage between 11 V and 16 V

O Ensure that power switch is in @) position before connecting power cord
O Connect one end of DC power cord with suppression filter to DC Supply Voltage Input of
ISONIC 2008 and plug another end into DC mains

Battery

O Ensure that power switch is in O position
O Plug in battery and fix it using 4 screws

Power-Up and Turn Off

To Power-Up ISONIC 2008 set power switch into | position. An automatic system test program will then be
executed; during this test various texts and information appear followed by the screen as below while
booting up

Sonotron NDT

ISONIC Instruments Line

Wait until |ISONIC 2008 Start Screenl becomes active automatically upon boot up is completed

[ 1]|operate

[zl Postprocessing

[3]settings

[ 4 |Exit To Windows

m Shut Down
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| F
Click on | L1operte Jor press ' on front panel keyboard or |[F1| on external keyboard to operate

ISONIC 2008 — refer to Chapters 5 through 7 of this Operating Manual

F
Click on Jor press 2 _J on front panel keyboard or on external keyboard to start
postprocessing of multi-channel inspection files captured by ISONIC 2008 — refer to paragraph 7.4 of this

Operating Manual

E Postprocessing

-

Click on | Jor press _3 Jonfront panel keyboard or on external keyboard to proceed

with general settings of ISONIC 2008 — refer to Chapters 8 and 9 of this Operating Manual

Esatlngs

J -
Click on | or press _4_ on front panel keyboard or on external keyboard if it is
necessary to fulfill some general purpose Windows procedures such as setting up drivers for external
devices (printers, USB memory card, and the like), connecting to LAN, quasi-disk management, etc — refer
to Chapter 9 of this Operating Manual

z‘ Exit To Windows

= ' -
To turn ISONIC 2008 off click on ™™ Jor presson ' _5__ on front panel keyboard or [F5| on
external keyboard then wait until the screen as below appears:

iy

Windows:

Set power switch into O position upon

®

After turning ISONIC 2008 OFF wait at least 10...30 seconds before switching it ON again
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5. UDS 3-6 Pulser Recelver Channels
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5.1. Start Up UDS 3-6 Pulser Receiver

. . . . T‘Opsralo {
While ISONIC 2008 Start Screen| is active click on or press _J on the front panel

[ 1]|operate

[2]Postprocessing

[3]settings

[4]Exit To Windows

m Shut Down

keyboard or press on external keyboard

ISONIC 2008 from Sonotron NDT - Operating Manual — Revision 1.06 - Page 31 of 316



5.2. UDS 3-6 Main Operating Surface

ISONIC 2008 instrument comprises eight identical UDS 3-6 pulser receiver channels; each of them is
controllable through UDS 3-6 Main Operating Surface. Half tone background indication of channel number
is provided at the A-Scan background

UD53-6 - ISONIC Pulser/Receiver

4' |Chﬂnnel 1

05 Gain

= By

45 dB ‘
Meaz Yalue
AVC(A) ‘
Meaz Mode

«

0.01 Probe Delay

LER S

e By

4= By

Angle
-------- 60 °

BASICS  PULSER  RECEIVER _ GATE A ) i ma.‘
GATEB  ALARM  DAC/TCG JLITGILIEN Selection

[en By

[ T PRFNE- I «
Cloze EMI 2.1 dB Ereeze Save | Open| Print DG5S

Value Box - Digital Readout

To select channel for calibration / A-Scan inspection

UDS3-6 - IS0NIC Pulser/Receiver

ﬂ Channel 1
IR =

Each of UDS 3-6 channels may be calibrated independently on others except few parameters, which are
indicated as global in the present Operating Manual
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5.2.1. Channel's Main Menu

Channel's Main Menu consists of eight topics; each topic is associated with corresponding submenu
appearing as vertical bar showing names for five parameters or modes of operation, their current settings
and current value of increment/decrement for a parameter. The active topic is highlighted

UD53-6 - ISONIC Pulser/Receiver

4' |Chﬂnnel 1

Gain ‘ )
3 dB 1
Range ‘ )
15D mm 2
50 US Velocity ‘ )
32b0 mfs 3
10 Display Delay o
5.13 ps L
I -
]
BASIC PULSER RECEIVER GATE A Menu
GATE | ALA.HI'-'I DAC/TCG MEASURE Selection

: Active Toplc : i Main Menu : : Vertical bar — Submenu :
L — . R —— i Correspondlng to i
To activate a topic the following manipulations are applicable: : highlighted active topic ;
* Keyboard e e 5

pa—
B Press ™ J on front panel keyboard or on external keyboard until highlighting required topic
OR

B Press <Alt>+<M> on external keyboard = Menu Selection fore color changes to white - then use
e Mouse / Touch Screen
B Click on topic's name

-»

B Click on

e Combined

t »

B Click on Menu Selection = Menu Selection fore color changes to white - then use

‘ , ‘ / on front panel keyboard orI . . Ion external keyboard
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5.2.2. Sub Menu BASICS

To control Gain the following
manipulations are applicable:

. .
T

v dhdh dh 4 4

R Sk 3 3%

i T N Y NS

Mouse / Touch Screen

B Click or press and hold on the appropriate

Keyboard
-
B Press 1 J on front panel keyboard or or <Alt>+<G> on external keyboard = Gain fore color

changes to white - then use !J '_’J _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on Gain = Gain fore color changes to white - then use !J '_’J :J ij on front panel
keyboard or , , on external keyboard

®

Gain setup is also possible through a number of other submenus following the same rules as above
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e

T b | by | o by |

L
0% b
. I /
To control Range the following I
manipulations are applicable: I /
/
e Mouse / Touch Screen ly

B Click or press and hold on the appropriate

e Keyboard

®

-
Press 2 J on front panel keyboard or or <Alt>+<A> on external keyboard = Range fore color

changes to white - then use !J _J _J !J on front panel keyboard or , , , on

external keyboard
Combined

Click on Range = Range fore color changes to white - then use !J '_’J :J ij on front
panel keyboard or ,, , on external keyboard

Range setup is also possible through a number of other submenus following the same rules as above
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To control US Velocity the following
manipulations are applicable:

5 US Velocity

5920 mfs
100 Dizplay Delay

0 ps

Mouse / Touch Screen

B Click or press and hold on the appropriate

Keyboard

rd
m Press 3 J on front panel keyboard or or <Alt>+<U> on external keyboard = US Velocity fore

color changes to white - then use !J '_’J _J ij on front panel keyboard or , , , on

external keyboard
Combined

B Click on US Velocity = US Velocity fore color changes to white - then use !J '_’J !J !J
on front panel keyboard or , , , on external keyboard
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To control Display Delay the following l
manipulations are applicable: | /
/
e Mouse / Touch Screen 1/
4

B Click or press and hold on the appropriate
Keyboard

F
B Press _4 j on front panel keyboard or or <Alt>+<E> on external keyboard = Display Delay

fore color changes to white - then use !J '_’J _J !J on front panel keyboard or , , ,

on external keyboard

Combined
B Click on Display Delay = Display Delay fore color changes to white - then use !J '_’J !J

!J on front panel keyboard or , , , on external keyboard
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F
Click on this button or press 5 _

on front panel keyboard or or
<Alt>+<5> on external keyboard

Current value of
increment/decrement for
Reject setup,

%
to select value of
N \ increment/decrement for Reject
\ 'I ﬂﬂ M setting
S \ 5 US Velocity
: Current value of : \\ b920 mJs ‘
: Reject : gl 100 Display Delay
3 0/ £ \l
TIPS < 0 ps
~
~

To control Reject the following
manipulations are applicable:

/
/

I
I
e Mouse / Touch Screen I

B Click or press and hold on the appropriate

e Keyboard

F
B Press _3 _ on front panel keyboard or or <Alt>+<E> on external keyboard = Reject fore color

changes to white - then use ' ‘ ‘ , '.' on front panel keyboard or , , , on

external keyboard

e Combined

LINCIALING &

B Click on Reject = Reject fore color changes to white - then use =/, ~_/ on front

panel keyboard or , , , on external keyboard

®

¢ Signals below Reject level (small signals) are suppressed

¢ Signals exceeding Reject level (large signals) are presented on the A-Scan without affecting their
original height

¢ Part of large signal wave form below Reject level is suppressed

Rejoct = 20 %

WA R+ o+ o+

+ +
+ +
+ +
3- ¥
+ e
+ +
+ +
+ +
+ +

¢ Reject level may be applied to rectified signals only (Display Modes Full, NegHalf and PosHalf -
refer to paragraph 5.2.4 of this Operating Manual)
¢ Reject setup is also possible through a number of other submenus following the same rules as above
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5.2.3. Sub Menu PULSER

Current Pulser Mode

2

i o
N\ 1
N 45dB -
H E nde g
2
FPulze Width o
130 ns 1K
Firing Level o
12 ‘ 4
1 PRF .
500 Hz ‘ Z.
To control Pulser Mode the following Iy
manipulations are applicable: 1y
I
e Mouse/Touch Screen I/
B Click or press and hold on the appropriate
e Keyboard
F

B Press _2  on front panel keyboard or or <Alt>+<U> on external keyboard = Pulser Mode

fore color changes to white - then use !_ ?/ « , !' on front panel keyboard or , , ,
on external keyboard

e Combined

®

There are two Pulser Modes available: Single and Dual
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Current value of Pulse Width
(Duration of Half Wave of
Bipolar Square Wave Initial
0.5 Gain

Pulse) ‘ o
llllllllllllllllllll ‘I:IIIIIIIIIIIII 4 5 dB l
\ Pulzer Mode a
SI NGLE ‘ 2
-
3
ang Level a
4
4| o
Eﬂﬂ Hz | 5
L]
To control Pulse Width (Duration of Half Wave of I II
Bipolar Square Wave Initial Pulse) the following I
manipulations are applicable: I II
e Mouse/Touch Screen 7
B Click or press and hold on the appropriate
e Keyboard
-
B Press 3 J on front panel keyboard or or <Alt>+<E> on external keyboard = Pulse Width
fore color changes to white - then use ?_ , ‘ « '.' / on front panel keyboard orI . .

on external keyboard
e Combined

» & 3

S = r
g ey 1 S

B Click on Pulse Width = Pulse Width fore color changes to white - then use !_
on front panel keyboard or , , , on external keyboard

®

¢ Pulse Width (Duration of Half Wave of Bipolar Square Wave Initial Pulse) is tunable between 50 ns to
600 ns in 5 ns steps

+ Durations of positive and negative half wave of the initial pulse are varying synchronously

¢ Attempt to decrease Pulse Width below 50 ns switches initial pulse OFF and channel may be used then
as receiver only
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............................ .
Current value of :
Firing Level :
.............. e 0.5 Gain

45 dB ‘
\ Pulser Mode
S . SINGLE ‘
\ Fulse Width
N «

1 PRF
500 Hz "

|
To control Firing Level the following I
manipulations are applicable: I /

e Mouse/Touch Screen 1/
4

B Click or press and hold on the appropriate

e Keyboard
F 3
B Press _4 _ on front panel keyboard or or <Alt>+<L> on external keyboard = Firing Level fore

color changes to white - then use !_ ? ‘ , .' on front panel keyboard or , , , on

external keyboard

e Combined

LY

B Click on Firing Level = Firing Level fore color changes to white - then use =/,

on front panel keyboard or , , , on external keyboard

®

¢ There are 12 grades (1 through 12) for setting Firing Level — amplitude of initial pulse is controlled
from 140 V peak to peak (Firing Level = 1) to 400 V peak to peak (Firing Level = 12)

¢ Firing Level is a global parameter, which is common for all 8 UDS 3-6 channels of ISONIC 2008
instrument

» = (=

ISONIC 2008 from Sonotron NDT - Operating Manual — Revision 1.06 - Page 41 of 316



0.5 Gin

45 dB
Pulzer Made

SINGLE
Pulse Width

130 ns

Firing Level

12

To control PRF the following
manipulations are applicable:

I
/
e Mouse/ Touch Screen 1,
B Click or press and hold on the appropriate

e Keyboard

-
B Press _5 J on front panel keyboard or or <Alt>+<R> on external keyboard = PRF fore color

changes to white - then use !J '_’J :J !J on front panel keyboard or , , , on

external keyboard
e Combined

B Click on PRF = PRF fore color changes to white - then use !J '_’J :J !J on front panel
keyboard or , ,, on external keyboard

¢ PRFis global parameter, which is common for all 8 UDS 3-6 channels of ISONIC 2008 instrument

¢ There are 2 modes of pulsing in the ISONIC 2008 (refer also to paragraph 9.2 of this Operating Manual)

¢ Parallel - all channels do fire, receive, digitize, and record signals simultaneously. For parallel firing PRF
is global parameter for all 8 channels

¢ Sequential — cycles of firing, receiving, digitizing, and recording signals by each channel are separated
in time in a sequence loop. For sequential firing PRF per channel is defined as PRF/8

..........................

| | |
cra| | |

ial Fiving

1rPRC

— "

PRI - Pulsc Repeotition Mrequency
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5.2.4. Sub Menu RECEIVER

Current status of digital

To switch digital Filter ON / OFF the following
manipulations are applicable:

e Mouse/ Touch

(active) or OFF (inactive)

Filter — ON

0.1 Low Cut
Bl e
1 High Cut I
o s

l['
1y
1

Screen I/
]

B Click or press and hold on the appropriate

e Keyboard
F 2

B Press _1 J on front panel keyboard or or <Alt>+<E> on external keyboard = Filter fore color

4

changes to white - then use !_ ?/ « ! on front panel keyboard or , , , on

external keyboard

e Combined

B Click on Filter = Filter fore color changes to white - then use =/,

keyboard or

LINCINRI NS 4

o, O / on front panel

, , , on external keyboard
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S o Filter
RS ON ‘
S 1 0
1 High Cut
L
|

s By |mlw|-l.,

Dizplay 47
Full ‘ :
5 Reject Ir
0% “3
, 7
To control Low Cut frequency value of digital filter I /
the following manipulations are applicable: I
/
e Mouse/ Touch Screen I/
’
B Click or press and hold on the appropriate

Keyboard
>
M Press 2 J on front panel keyboard or or <Alt>+<W> on external keyboard = Low Cut fore

color changes to white - then use !J 2] :J !J on front panel keyboard or , , , on

external keyboard
Combined

B Click on Low Cut = Low Cut fore color changes to white - then use !J 2] :J !J on front
panel keyboard or , , on external keyboard
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|y
s
Rrille
Brlie »
Pl >

I
To control High Cut frequency value of digital filter /

the following manipulations are applicable:

Iy
Mouse / Touch Screen 1/
4
B Click or press and hold on the appropriate

Keyboard
-
B Press 3 J on front panel keyboard or or <Alt>+<H> on external keyboard = High Cut fore

color changes to white - then use !J 2] :J !J on front panel keyboard or , , , on

external keyboard
Combined

B Click on High Cut = High Cut fore color changes to white - then use !J 2] :J !J on
front panel keyboard or , , , on external keyboard
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Current mode of signal
presentation (Display)

A \ Filter
S ON ‘
S \ 0.1 Low Cut
S N 2 MHz ‘

\ 1
N 5
[ 1zp
L] Beject
0% :
|
To select mode of signal presentation I
(Display) the following manipulations I,
are applicable: !,
I,
e Mouse/Touch Screen Iy

B Click or press and hold on the appropriate

e Keyboard
-

B Press _4  on front panel keyboard or or <Alt>+<I> on external keyboard = Display fore color

changes to white - then use =, ', . T J

external keyboard

e Combined

B Click on Display = Display fore color changes to white - then use

panel keyboard or , , M on external keyboard
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2 =

on front panel keyboard or , , , on

/ on front



®

+ There are four Display modes for time domain signal presentation:

RF —no
rectifying

PosHalf —
positive half
wave
rectifying

NegHalf —
negative half
wave
rectifying

Full — both
waves
rectifying
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¢ Frequency domain signal presentation is available through FFT Display mode. Refer to paragraph 5.2.14
of this Operating Manual for instructions related to frequency domain signal presentation

Time Domain

UDS3-6 - ISONIC Pulser /Receiver
‘ Channel 1

_ 0.5 Gain
E ‘
UpperFre
; Rl «
] Dls la
+ MR- -
i 5 Reject
o K

EI\""\'EI """"""""""""""" E Uos 3-6

| &
Close Em | Freeze Print

= &y

Mo By

o By

ln By

L
DG5S

=
Open

Save

Frequency Domain Signal presentation is not possible if:
o DAC is active (refer to paragraph 5.2.9 of this Operating Manual)
0 TCG is active (refer to paragraph 5.2.9 of this Operating Manual)
o Digital Filter is active
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5.2.5. Sub Menu GATE A

Current status of Gate A

N 05 Gain
N  IEXL ‘

il 4

2 aStart *
26 mm

2 awidth [N
mm

10 aThrezhold I
45 2% ‘

7

o iy [ ety oy | |y

To switch Gate A ON / OFF the

|
following manipulations are applicable: I II
e Mouse/ Touch Screen Iy
B Click or press and hold on the appropriate
e Keyboard
F

B Press _2 _ on front panel keyboard or or <Alt>+<T> on external keyboard = aSwitch fore

color changes to white - then use !_ ?/ « , !' on front panel keyboard or , , , on

external keyboard
e Combined

B Click on aSwitch = aSwitch fore color changes to white - then use !_ ?/ « , !' on front

panel keyboard or , , , on external keyboard
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Gain -
3 dB ‘ L
aSwitch o
~
/
R o] 2
~ o
3
a"w'ldth -
8 mm ‘ 4/
aThreshold -,
45 %% * ,d
/
To control delay of Gate A (aStart) | /
the following manipulations are applicable: 1y
11/
e Mouse/Touch Screen 1/

B Click or press and hold on the appropriate

Keyboard
Fd
B Press 3 J on front panel keyboard or or <Alt>+<A> on external keyboard = aStart fore color

changes to white - then use !J '_’J !J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on aStart = aStart fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or , , , on external keyboard

Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)

®

¢ aStart setup is also possible through a number of other submenus following the same rules as

above
¢ Counting of aStart value starts after finishing of Probe Delay count (refer to paragraphs 5.2.12
and 5.2.13 of this Operating Manual)
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aStart
26 mm

g | 0 By [0 | 1=y

awidth
8 mm ‘ 2
10 aThreshold " o

4b 2% 5
To control duration of Gate A (awidth) , /
the following manipulations are applicable: I /

/

e Mouse/ Touch Screen 1y

B Click or press and hold on the appropriate

Keyboard
F
B Press _4 j on front panel keyboard or or <Alt>+<W> on external keyboard = aWidth fore

color changes to white - then use !J _J _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on awidth = awidth fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or , , , on external keyboard

Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)
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To control threshold level of Gate A
(aThreshold) the following manipulations
are applicable:

aT hrezhold
45 2% ;

/
/

|

|

|
Mouse / Touch Screen 1/

[ 4

B Click or press and hold on the appropriate

Keyboard

-
B Press'_5 J on front panel keyboard or or <Alt>+<E> on external keyboard = aThreshold fore

color changes to white - then use !J '_’J _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on aThreshold = aThreshold fore color changes to white - then use !J '_’J :J !J
on front panel keyboard or , , , on external keyboard

Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)
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5.2.6. Sub Menu GATE B

thdth
ozmm K

hT hreshold
B «

7

To switch Gate B ON / OFF the

|
following manipulations are applicable: I II
e Mouse/ Touch Screen Iy
B Click or press and hold on the appropriate
e Keyboard
F
B Press _2 J on front panel keyboard or or <Alt>+<T> on external keyboard = bSwitch fore
color changes to white - then use !_ , ‘ « ! on front panel keyboard or , , , on

external keyboard

e Combined

L)

B Click on bSwitch = bSwitch fore color changes to white - then use =/,

panel keyboard or , , , on external keyboard

» & (&
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b witch

ON
2 bS5tart

47 .9 mm

2 bwidth

13.2 mm
10 bThreshold

40 %5

To control delay of Gate B (bStart) (I
the following manipulations are applicable: 1y

11/
e Mouse/Touch Screen 1/

B Click or press and hold on the appropriate

Keyboard
Fd
B Press 3 J on front panel keyboard or or <Alt>+<A> on external keyboard = bStart fore color

changes to white - then use !J _J _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on bStart = bStart fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or , , , on external keyboard

Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)

®

Counting of bStart value starts after finishing of Probe Delay count (refer to paragraph 5.2.12 and
5.2.13 of this Operating Manual)
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To control duration of Gate B (bWidth)
the following manipulations are applicable:

Mouse / Touch Screen

B Click or press and hold on the appropriate
Keyboard

F
B Press _4 j on front panel keyboard or or <Alt>+<W> on external keyboard = bWidth fore

color changes to white - then use !J _J _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on bWidth = bWidth fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or , , , on external keyboard

Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)
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To control threshold level of Gate B
(bThreshold) the following manipulations
are applicable:

bSwnlch
N

2,  bwdth

13.2 mm
bThrezhold

40 %%

|

|

|
Mouse / Touch Screen 1/

[ 4

B Click or press and hold on the appropriate
Keyboard

-
B Press'_5 J on front panel keyboard or or <Alt>+<E> on external keyboard = bThreshold fore

color changes to white - then use !J '_’J _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on bThreshold = bThreshold fore color changes to white - then use !J '_’J :J !J
on front panel keyboard or , , , on external keyboard

Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)
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5.2.7. Drag and Drop: Gate A and Gate B

Gate A and Gate B may be manipulated through Drag and Drop provided that they are visible in the A-
Scan area. [Mouse pointer changes shape| while placing it above appropriate section of a gate

]

0.5 Gain
415 dB ‘

Mea: ¥alue
AVC(A) ‘

Meaz: Mode
«

0.01 Probe Delay

Iro By

e By

= By

10 Angle
60 °

BASICS ~ PULSER  RECEIVER _ GATE A Menu Ty ma.‘
GATEB _ ALARM _ DAC/TCG JCIEEIGEN Selection

[en By

[ T PRI N
Cloze MI 1.6dB Freeze Save | Open | Prnint DG5S

To manage a gate just press and hold left mouse button or touch screen stylus and drag, then drop through
releasing of left mouse button or touch screen stylus
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5.2.8. Sub Menu ALARM

------------------------------------- 1
Alarm Switch status for 3dB 3dB

! selected Gate is shown here 1 Range ‘ 1 Range ‘
FesssEsEEEEEEEEEEEEEEEEEEEEREEREE ‘- -: ‘I ﬂﬂ mm .I ﬂﬂ mm
AN Alarm Switch Alarm Switch ‘

GN ON

Alarm Logic Alarm Logic

Positive Negative
~ Setup Gate

GATE B

To select a Gate for Alarm Setup the 4 //
following manipulations are applicable: / p -
I ” -
/ - -
e Mouse/Touch Screen 1, o -
-
m Click or press and hold on the appropriate

e Keyboard

F
B Press _3 _ on front panel keyboard or or <Alt>+<T> on external keyboard = Setup Gate fore

color changes to white - then use ?_ ? « , '.' on front panel keyboard or , , , on

external keyboard
e Combined

LY

B Click on Setup Gate = Setup Gate fore color changes to white - then use =,
on front panel keyboard or , , , on external keyboard

® = =
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0.5 Gain

3 dB ‘
1 Ra
100mm B

8  Alarm Switch
ON

Alarm Switch
ON

R

Alarm Logic * Alarm Logic
Positive 7 Negative
Setup Gate I y g Sehup Gate
GATE A ‘ y 5 GATEB
L
/
To control Alarm Switch the Iy
following manipulations are Iy
applicable: 1y P
lr <, s
e Mouse/ Touch Screen llé//
B Click or press and hold on the appropriate
e Keyboard

-
B Press 2 J on front panel keyboard or or <Alt>+<W> on external keyboard = Alarm Switch

fore color changes to white - then use ?_ ? . , " on front panel keyboard or , , ,
on external keyboard

e Combined

D &

B Click on Alarm Switch = Alarm Switch fore color changes to white - then use ?

" on front panel keyboard or , , , on external keyboard
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"

A A A A A nn ke . Gai 05 Gain
Alarm Logic : 1 3 dB ‘
- » 1

................................ R al Range
» oo R

Alarm Switch
on K

Alarm Logic Alarm Logic

Positive : Negative
Setup Gale

o By

e By

len g = By

To select Alarm Logic the
following manipulations are applicable:

e Mouse/Touch Screen Iy 2
&

B Click or press and hold on the appropriate Ibuttonl

e Keyboard
-
m Press _4 J on front panel keyboard or or <Alt>+<L> on external keyboard = Alarm Logic

fore color changes to white - then use ?_ ? « , '.' on front panel keyboard or , , ,
on external keyboard

e Combined

LRI

B Click on Alarm Logic = Alarm Logic fore color changes to white - thenuse =, =, ~J ' T
on front panel keyboard or , , on external keyboard
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®

Alarm Example

: Gate A & : GateB =
"""" | el Terrerrrrrenes
/
UDS3-6 - ISONIC Pulser/Receiver
/
‘ 1Chﬂnnel 1

BASICS
GATE B

PULSER
ALARM

]

05 Gain
18 b dB ‘
10 Range

T

46 mm

o By

R0 US Velocity
3250 mjs ‘

e By

0.1 Display Delay '

12 .81 ps

e By

Beject

0%

[en By

v dh dh AL\ 4

RECEIYER
DAC/TCG

GATE A
MEASURE

Selection

Uos 3-6

|_ Value: OFF ﬁ w ] = Eh L
Cloze Alarm r\ ~ Freeze Save | Open | Prnnt DG5S
7 <
/ = N
sasasasassssisssasasasasas : sasasasasasSasssasasasasas :
: Alarm Indicator for : : Alarm Indicator for :
: Gate A : I GateB E

¢ There is a pulse matching with Gate A and exceeding its threshold; the Alarm Logic setting for Gate A
is Positive = Alarm Indicator for Gate A is active

+ There is a pulse matching with Gate B and not exceeding its threshold; the Alarm Logic setting for Gate
B is Negative = Alarm Indicator for the Gate B is active
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5.2.9. Sub Menu DAC/TCG
5.2.9.1 ISONIC 2008 with Software Release Dated July, 2010 or Earlier

: Current status of -
: DAC/TCG/DGS 1
S asssssssEsEEEEEEEEEEEEEEEEEER
.
Current quantity of * 2
:  stored echoes \ -
: composing DAC : 3/
. - -
— , i
: Status of DAC :
] AT =~~~ Show DAC a
Curve OFF 5
To select required mode for
DAC/TCG/DGS the following
manipulations are applicable: Iy
1/
e Mouse/Touch Screen Iy

B Click or press and hold on the appropriate
e Keyboard

Fa

m Press _2 J on front panel keyboard or or <Alt>+<T> on external keyboard = DAC/TCG/DGS

fore color changes to white - then use ? *_ . , " on front panel keyboard or , , ,
on external keyboard

e Combined

B Click on DAC/TCG/DGS = DAC/TCG/DGS fore color changes to white - then use ? ‘_ «

®

'.' on front panel keyboard or , , , on external keyboard

¢ There are four possible modes for DAC/TCG:
There are four possible modes for DAC/TCG:

OFF - DAC Curve switches automatically to OFF while in OFF

DAC - available if quantity of stored echoes is 2 (two) or more. DAC Curve switches
automatically to ON while in DAC mode. Both experimental and theoretical methods for creating
DAC are available

TCG - available if quantity of stored echoes is 2 (two) or more. DAC Curve switches
automatically to OFF while in TCG mode

Update - allows to create/update new/existing DAC. Update of existing DAC performed through
erasing of a number of sequentially recorded echoes, starting from the latest one, and/or
recording of new echoes. The maximal number of echoes recorded into the one DAC is 40
(forty). DAC Curve switches automatically to ON if the number of recorded echoes is 2 (two) or
more and switches automatically to OFF if number of recorded echoes is less than 2 (two) while
in Update mode

¢ ltis possible to Create / Modify / Activate DAC and TCG for all Display modes (RF, Full, Negative, and
Positive)

¢ To create / modify DAC/TCG or DGS refer to paragraphs 5.2.10, 5.2.11 of this Operating Manual
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5.2.9.2 ISONIC 2008 with Software Release Dated August, 2010 or Later

Control of ISONIC 2008 instruments with software release dated Aug, 2010 or later for DAC / TCG / DGS
functions is identical to earlier SW releases except the new ability of managing up to 3 independently
controllable DAC curves in addition to the main one:

UDS 3-6 - ISONIC Pulser/Receiver

R b

PR " WY S VUSRI VN SER Y A S e

BASICS PULSER RECEIVER GATE A / W‘ 3-‘
GATEB ALARM MEASURE . /
I .
Awrm \l l Freeze 51‘“‘7 dpe" Print DGS
T - W s
fllllllllllllllllllllll. : lllllllllllllllllllllllllllllllllll : : . . .
] Main DAC ! I Additional curves (Blue : ¢ Levelindicators for the of additional curves
Curve (red) : White, and Violet)) - e (Blue, White, and Violet), the levels are
T T T ey e T ¥ hrrsresserssreresesseeeeneneneet 1 indicated in dB relatively main DAC Curve
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To control levels of the additional DAC curves click on one of three indicators as above, for example on

1
T8 | The following screen appears:
UDS 3-6 - ISONIC Pulser/Receiver e
(& | \
- I
I
I
|
I
I
X /
-
L O
10 dB +4dB
PULSER RECEIVER -
GATEB ALARM DAC/TCG MEASURE uo‘ 3 ‘
® =RIERE 3
Close Alarm Frﬁzze ﬁ ﬂ Save pen || Print I DGS

The level of each additional DAC curve is controlled through clicking on in the corresponding
sliding bar. On completion click on a level indicator
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5.2.10. Create / Modify DAC
5.2.10.1 Theoretical DAC: dB/mm (dB/in)

Theoretical DAC represents pure exponential law for distance amplitude curve; said law is determined by
dB/mm (dB/in) factor and value of Probe Delay - refer to paragraphs 5.2.12, 5.2.13 of this Operating
Manual: at zero material travel distance theoretical DAC has start point at 100% of A-Scan height

Set DAC/TCG/DGS to Update then click

UDS3-6 - ISONIC Pulser/Receiver
\
‘l | Channel 1 \

05 Gain

= Ty

195 dB
DAC/TICG/DGS
Update ‘
2 aStart
-
Show DAC
__________ Curve OFF

+ + + + + + + + +
BASICS PULSER RECEIVER GATE A HE'“-_I dB!mml m 3-‘
GATE B ALARM DAC/TCG MEASURE Selection
I_ I_ Yalue: OFF i i E %

Close Em I Freeze Save Print

Cosa Ko

Mo By

o By

4= By

I By

e
DGS

=
Open

ISONIC 2008 from Sonotron NDT - Operating Manual — Revision 1.06 - Page 65 of 316



Click on this button or press

. B
...................................... . i 1 onfront panel keyboard or
: STl o : 3 Current value of : F1/or <Alt>+<1> on external
i dB/mm (dBfin) factor : : increment/decrementfor ;i keyboard to selectvalue of
SR { § dBJmm (dB/in)factor seiting | i incrementidecrement for dB/mm
N it § (AB/iN) factor setting
\ \ ]
[Popup subwindow] appears: \ \ L
\ \ \ |
N \ \ I
S \ \ I
" b Channel1 \
I
o)
1
DAC/TCG/DGS |
Update J
2 aStart o
43.1 mm 3
1
I
Show DAC ;
U s | CUNVE OFF |
BASICS PULSER RECEIVER GATE A Meny dB/mm 0.01 !
GATE B ALARM MEASURE 0 059 1
[ Value: OFF ‘ﬁ ﬂ . » -
7’
Close EMLI Freeze OK / // OFF
£
..................... | AP sz 7
Theoretical DAC accordingto  : ,///
: entered dB/mm (dB/in) factor : /7 -
T . 7 7
To control dB/mm (dB/in) factor the following L7
manipulations are applicable: % 7

e Mouse / Touch Screen

B Click or press and hold on the appropriate

e Keyboard
B Press L} , ‘ . = , ‘ on front panel keyboard or 1}, Q @ U on external keyboard
On completing dB/mm (dB/in) factor setting click on Ok or press =4/ on front panel keyboard

Enter|on external keyboard. This will return to main operating surface of UDS 3-6 Pulser Receiver and

dB/
activate theoretical DAC. Button o becomes green while theoretical DAC is setup; set
DAC/TCG/DGS to DAC to activate theoretical DAC or to TCG if it is necessary to perform time correction of
gain in accordance with theoretical DAC law.

dB/
To modify or switch theoretical DAC off set DAC/TCG/DGS to Update then click on o . Inthe
appeared popup subwindow modify value dB/mm (dB/in) factor as it is described above or click on

OFF then on OK
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5.2.10.2 Experimental DAC: recording signals from variously located reflectors

If theoretical DAC is active then it must be switched off according to paragraph 5.2.10.1 of this Operating
Manual prior to building of experimental DAC. Switch on Gate A then set DAC/TCG/DGS to Update. Place
probe onto DAC calibration block and maximize echo from the reflector closest to the probe (first echo) then
place Gate A over received signal and capture first DAC echo

UDS3-6 - ISONIC Pulser /Receiver

‘l'l Channel 1

05 Gain ‘
17b dB
DAC/TCG/DGS ‘
Update
0.5 aStart ‘
8.4 mm
. Show DAC
i'n + I'"-I +II|
g, H'I rl""n.""l. Pty 'I'-'ha'nlul .hw‘ II.-"" by i e A ’ Cu rve D FF
BASICS PULSER RECEIVER GATE A Menu dB /mm
GATE B ALARM DAC/TCG MEASURE Selection el
I_ I_ Yalue: OFF i i = = Eh .
Close MI Freeze Save | Open | Pnnt DGS

To capture DAC echo the following
manipulations are applicable:

e Mouse/ Touch Screen

m Click fon]

e Keyboard
-
B Press _4 J on front panel keyboard or or <Alt>+<R> on external keyboard = Rec fore color

changes to white - then use ' ‘ ‘ , '.' on front panel keyboard or , , , on

external keyboard

e Combined

* » Gl

B Click on Rec = Rec fore color changes to white - then use =, ' = on front panel keyboard or
on external keyboard

will appear

As a result the first DAC echo will be stored and corresponding
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Place probe onto DAC calibration block and maximize echo from next reflector then place Gate A over
received signal and capture next DAC echo. As result next DAC echo will be stored causing appropriate

modifying of [corresponding indications)

05 Gain
175 dB

DAC/TCG/DGS
Update

Show DAL
Curve OFF

¢ The highest echo in the Gate A will be stored said echo may either exceed Gate A threshold level or not
¢ Stored echo must be below 100% of A-Scan height
+ Atotal number of 40 echoes may be stored one by one by the same way as described above
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After creating a DAC (2 or more echoes stored) the DAC and / or TCG may be activated.
There are two styles of DAC indication in the DAC mode: Main Curve Only and Main Curve £ N dB, where

IN may be setup either as 2, 4, 6, 8,10, 12, or 14 dB|. To proceed follow the rules below:
0.5 Gain

175 dB

DAC/TCG/DGS
DAC
05 aStart

69 4 mm

40 0e ' elelele
Ny
v eV

Br:
]
0D A
aB Al
e+bdb
/ - _ - -
e Mouse/ Touch Screen /4 ” -
o - -"
B Click or press and hold on the appropriate e =

e Keyboard

F
B Press _3 J on front panel keyboard or or <Alt>+<H> on external keyboard = Show DAC fore

color changes to white - then use ' ‘ ‘ , '.' on front panel keyboard or , , , on

external keyboard

e Combined

LINCIAAIAR S

B Click on Show DAC = Show DAC fore color changes to white - then use

on front panel keyboard or , , , on external keyboard
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It's possible to erase the last stored echo from the DAC. To proceed set the DAC/TCG/DGS to Update:

To erase the last stored echo from the DAC the following manipulations are applicable:
e Mouse/ Touch Screen
B Click Jon],
F— ~
0.5 Gain

Tl «

= by

o3 By
v AhAh A A 4

175 dB

DAC/TICG/DGS ‘
Update
0.5

aStart

654 . mm

Show DAC

o I"Ih

L B L L

e Keyboard

F 3
B Press _4_J on front panel keyboard or ﬂ or <Alt>+<R> on external keyboard = Rec fore color
changes to white - then use ‘ , '.' on front panel keyboard or & ] on external keyboard
e Combined
B Click on Rec = Rec fore color changes to white - then use ‘ , '.' on front panel keyboard or

g, @ on external keyboard

As a result the last stored echo will be erased causing appropriate modifying of fcorresponding indications|

7
0.5  Gain ’*
175 dB
DAC/TCG/DGS

Update

p

o3 by
v AhAh Ah A 4

3
Show DAC
| Curve ON

p
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5.2.11. DGS
DGS A
To setup DGS set Display to Full then click on L= or press ﬂj on front panel keyboard or or

<Alt>+<D> on external keyboard. The following screen appears:

Disk shaped reflector (flat bottom hole - FBH)

EEIE B0 Sl 6 INTEIE ©f [sie] echo amplitude as function of metal travel

travel distance in the reference block for the
selected probe :

distance in the material under test for the
selected probe and FBH diameter

Ty

Range

200 mm
50 U5 Yelocity

3250 mifs

Mo By

It By

4 By

n By

lDGS Setup: SWB-45-5 / 3.8 mm

| — &
[GWh.455 ﬂ 17.5 dB Y
JEonaen D Taneier tovs YU g
[28nm 3TN0 dB ¥y | - NS
ERG | M ajerial‘Attenuation ‘
S P—
Vﬁ dBm‘ _!_ K1 AVKq15]=-235dB Backwall Echo
[ Reterence Atenuaton S
. =5
Close ]“ 0dB/m " ¥ 55 dem) + 2B (dB/m)  ( 1dB(dB/m)
S ~
T PO . N
: Equivalent Diameter ; :  Probe selection box &
:  (FBH)selectionbox  : e ;

ISONIC 2008 from Sonotron NDT - Operating Manual — Revision 1.06 - Page 71 of 316



To activate DGS follow the steps below:

Step 1: Probe Selection

The following manipulations are applicable for the Probe selection:

e Mouse/ Touch Screen

B Click on m |Scroll probes list to see the selected onel

MwB-60-2

SwB-45-2
SwWB-455 T

B Click on |selected probe

o Keyboard
B Press <Alt>+<P> on external keyboard = Probe fore color changes to white — then use .tx 2»
:J, !/ on front panel keyboard or , , , on external keyboard
e Combined
B Click on Probe = Probe fore color changes to white - then use .tx 2» tj !/ on front

panel keyboard or , , , on external keyboard
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Step 2: Equivalent Diameter of disk shaped reflector (flat bottom hole — FBH)

The following manipulations are applicable for the selection of the Equivalent Diameter of disk shaped
reflector:

e Mouse/ Touch Screen
m Click m  |Scroll diameters list to see the selected on

\

[o.-8 mm—per|

B Click on |selected equivalent diameter|

e Keyboard

B Press <Alt>+<D> on external keyboard = Equivalent Dia fore color changes to white — then use

_t/, 2» tj !/ on front panel keyboard or , , , on external keyboard

e Combined

Z;

B Click on Equivalent Dia = Equivalent Dia fore color changes to white — then use .tx . ﬂ

!/I on front panel keyboard or , , , on external keyboard
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Step 3: Attenuation in the reference block

I ——
V4

|Mw3 60-4 Jl 1 dB Y /

[Eauvalent Dia | Transter Loss I} ;
[1.5 mm ﬂ‘ DdB

| 42 dBIm Backwall Echo

Apply
—
Close 38 dB/m & de (dB/m) 2 dB [dB/m) + 1 dB (dB/m)

\

The following manipulations are \

applicable: \
\

e Mouse/ Touch Screen \

B Click or press and hold on the appropriate

e Keyboard

B |-l | o= |-oul | -
~

B Press <Alt>+<N> on external keyboard = Reference Attenuation fore color changes to white -

then use !J '_’J , :J , ij on front panel keyboard or , , , on external keyboard

e Combined

B Click on Reference Attenuation = Reference Attenuation fore color changes to white - then use

y, '_’J , !J , !J on front panel keyboard or , , , on external keyboard
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Step 4: Attenuation in the object under test

|
I
| 148 ¥ :
| Transior Loss I\ . -
hsem =\ 0dB Y ,' \ N
Moty Al ! Y
| \
Apply V42 dB/m }S6 AVg2 = 0dB, Backwall Echo
| Rofcronce Attonuation f ] et Stos
Close 38dB/m  ¥|v 5deim) 2 dB [dB/m] + 1 dB (dB/m)
— 1\
The following manipulations are \\
applicable: \
e Mouse/ Touch Screen \
B Click or press and hold on the appropriate
e Keyboard

B Press <Alt>+<M> on external keyboard = Material Attenuation fore color changes to white - then
use !J '_’J , _J !J on front panel keyboard or , , , on external keyboard
e Combined

B Click on Material Attenuation = Material Attenuation fore color changes to white - then use !J

'_’J , _J !J on front panel keyboard or , , , on external keyboard
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Step 5: Transfer loss

DGS Setup: MWB-60-4 7 1.5 mm

|MwB-60-4 |

|1.5 mm 'I

Modify M aterial Attenuation

Apply

Cloze

42 dB/m

Reference Attenuatlun

- 38dB/m

4 / ’
A
| \
| = -
3
| \ 8
\
I \
K2 avgp =048/ Backwall Echo
HE (dE /m] ¢ VdB (B /m) & 1 dB [dB/m)

The following manipulations are applicable:

e Mouse/ Touch Screen

\
\

B Click or press and hold on the appropriate

e Keyboard

B Press <Alt>+<T> on external keyboard = Transfer Loss fore color changes to white - then use

!J, '_’J , :J ij on front panel keyboard or , , , on external keyboard

e Combined

B Click on Transfer Loss = Transfer Loss fore color changes to white - then use !J '_’J !J
ij on front panel keyboard or , , , on external keyboard
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Step 6: Gain

Apply probe to the reference block to get the appropriate echo. There are two methods available:
B K1 or K2 reference block (reference block and reflector are defined in the probe data sheet and
reproduced automatically from the DGS data base upon probe selection)
\ B Inclined reference block (reference reflector — back surface)
UDS3-6 - T

\
s AN

‘! '1 ;3}-I.\ﬂnl;.E|:1 \

\

0.5 Gain ‘ o
' 1 dB 1
10 Range ‘ o
| 100 mm 2
50 US Yelocity o
| 3250 mjs 3
0.1 Display Delay o
| B13ps 4
.
5
e \
[MwB-60-4 [~ v1dB | \
f e ouivoion D | Trcntertore— YR \ .
1.5 mm bl I q Wl
1 El dB Y ™ NG
M odifp Material \Attenuation ‘
l P—
Apply 8& ﬂBIm 1 K2 A¥yp = 0dB Backwall Echo
Edesibnbolibion ettt __!_ Setup Step
Close ‘] 38 dB/m ¥ édB [dE /] ¢ 2 dB [dB./m) @ 1 dB [dB/m]
-
A A Lo \ Iaasaaaaa T i .
i Current Gain : |\ : Click on Setup Step option or press <Alt>+<1> or .
: dB t ! <Alt>+<2> or <Alt>+<6> on external keyboard to select
T P\ : required value for increment / decrement for increment /
\ : decrement for setting Gain. The last selected value of
\ : increment / decrement is checked: ©
\ ]

The goal of Gain setup is
: obtaining tip of maximized
: reference echo reaching back :
echo level (blue curve) E
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DS3-6 - ISONI

PTSp——

= Ty

Mo By

50 US Velocity

o By

32560 mfs

[ By

I By

lpGs Setup: MWB-60-4 / 1.5 mm

| G
(MwB-60-4 | 1 dB
| i
~[15mm 7 0 dB 8
ot Al
42 dB/m ¥
‘ ‘ Setup Step

Close 38 dB/m ¥ 5 B (dBim) 2 dB [dB/m] 1 dB [dB/m)

\

[ ]

Apply K2 AV¥gp=0dB Backwall Echo

The following manipulations are 1
applicable for Gain setup: \

\
e Mouse/ Touch Screen \

B Click or press and hold on the appropriate

e Keyboard

LN,

B Press <Alt>+<G> on external keyboard = Gain fore color changes to white - then use
.«. : '.' on front panel keyboard or T, , , on external keyboard

e Combined

LIACIRLINS .

B Click on Gain = Gain fore color changes to white - then use , ~/ on front panel

keyboard or T, , on external keyboard
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Step 7: Finalizing DGS curve and return to the main UDS 3-3/ UDS 3-4 window

Before finalizing the DGS curve:

Finalized back echo curve (blue) — depends on
: Probe and Reference Attenuation

| pGs Setup: MWB-60-4 / 1.5 mm

P = _
55:_.'95_‘*;.;2 B - ISOMNI

> Chﬂnlr{EI.1

&

: Finalized FBH echo curve (white) — depends on
Probe, Equivalent Dia, and Material Attenuation :

Ty

I By

I By

4 By

e By

| | Gan Y
]HwB-Eu-4 v} 1dB Y
| i -
T [15mm 7l 0dB vl g
b ;
/
Apply 42 dBim 1 K2 ,AVg2 = 0 dB Backwall Echo o
[etererice Attenuatin } |
Close 38 dB/m Y| 54B (dBim) ¢ 2 dB [dB/m) ~ 1dB (dB7m)
— 2
/ /
To finalize the DGS curve the following /7 /
manipulations are applicable: /7 /
/
Case 1 (K1 or K2 reference block) » Case 2 (Inclined reference block)//
/
e Mouse/ Touch Screen // e Mouse/Touch Screen //

e Keyboard

B Pressing <Alt>+<K> on external

click forl”

keyboard

m Click

e Keyboard

B Pressing <Alt>+<B> on external
keyboard
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The finalized DGS curve appears upon accompanied with Automatic Gain Correction:

Finalized back echo
curve (blue)

af |- |-l B |-

K2

Finalized FBH echo
curve (white)

0.5

245 dB
10 Range

103 mm

50
|

3250 mifs

TR aif

AVigo =0 dB E

U5 Yelocity

Backwall Echo

Finalized :
automatically :
corrected Gain :

| -t i |

" B dB [dE/m]

" 2 dB [dE/m]

i+ 1 dB [dB/m]

To accept finalized DGS curve and return to the main operating surface the following manipulations are

Apply

Close

applicable:

e Mouse/ Touch Screen
B Click on
then
B Click on

e Keyboard

ESC
B Press <Alt>+<A> on external keyboard, then or <Alt>+<C> or L‘\ on front panel keyboard
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To negate the finalized DGS curve and return to main UDS3-5 window the following manipulations are
applicable:

e Mouse/ Touch Screen
B Click on M odify

B Click on Cloze

_ May |
e |

e Keyboard

ESC

B Press <Alt>+<0O>on external keyboard, then or <Alt>+<C> or “X_J on front panel keyboard

To create new DGS curve the following manipulations are applicable:

e Mouse/ Touch Screen

B Click on Modify |

e Keyboard

B Press <Alt>+<0> on external keyboard
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Step 8: Work whilst DGS is active

A typical screenshot with active DGS is shown below

e E Probe and FBH Equivalent Diameter
DGS E : corresponding to active DGS are indicated in the
poocuve ; caption of UDS3-5 window

0.5 Gain
245 dB

= &y

10 Range
«
50 US Yelocity
3250 m/s ‘
0.1 play Delay
3 s ‘

Beject

Mo By

o By

4 By

Dis
b1
5

ln By

BASICS PULSER  RECEIVER  GATE A Menu m 3.‘
GATE B ALARM  DAC/TCG  MEASURE  Selection
|_ |_ Yalue: OFF ‘ﬁ ﬂ = =

Cloze Em | Freeze Save Print

ke
DGS

=
Open

Some parameters and modes may not be modified whilst DGS is active - corresponding messages appear if

attempting to modify:

tadification of thiz parameter is impozzible Changing aof thiz mode iz impozzible
while DGES curve iz active while DG5S curve is active

-
é ESC Em'e'r

To continue operation click on the after message appears or press - X__J or ' *=_J on front panel
keyboard or ESc| or Enter| on external keyboard

N
. . DG5S o |
To negate the active DGS or create a new one click on or press ' 265 J on front panel keyboard or

or <Alt>+<D> on external keyboard
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5.2.12. Sub Menu MEASURE

Current Measured 0.5 Gain ‘
Value ~ 24 5 dB
3
Meaz Mode
Flank *

0.1 Probe Delay h
b 13 ps
10 Angle I
4

[LARRI| I V\E
n YOS 3-6
To select Measured Value T
the following manipulations I
are applicable: 11
1/
e Mouse/Touch Screen T}

B Click or press and hold on the appropriate

e Keyboard
F
B Press _2 J on front panel keyboard or or <Alt>+<V> on external keyboard = Meas Value fore

color changes to white - then use !_ ?/ « , !' on front panel keyboard or , , , on

external keyboard

e Combined

LIACIAIINS

B Click on Meas Value = Meas Value fore color changes to white - then use =/,

on front panel keyboard or , , , on external keyboard

®

Refer to paragraph 5.2.13 of this Operating Manual for information about values available for automatic
measurement and indication in the Value Box (Digital Readout)
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Currently Active

Gain

Measurement Mode \ 24 5 dB

. <«
Meaz Yalue
N -

=ty

I By

e By | 1o By
e dh an dh A5 2

0.1 Probe Delay §
b 13 ps ‘
10 I

Angle o
. /
60 | 3
Laaaal E J 4
5| UDS 3-6
To select Measurement Mode I /
the following manipulations are /
applicable: I 4
Iy
e Mouse/ Touch Screen 17
B Click or press and hold on the appropriate
e Keyboard

-
B Press 3 on front panel keyboard or or <Alt>+<E> on external keyboard => Meas Mode fore

color changes to white - then use ?_ ? . , " on front panel keyboard or , , , on

external keyboard

e Combined

=JALIHG &

B Click on Meas Mode = Meas Mode fore color changes to white - then use ?_

on front panel keyboard or , , , on external keyboard

®

There are four Measurement Modes possible:

¢ Flank

¢ Top

¢ Flank-First
¢ Top-First

Refer to paragraph 5.2.13 of this Operating Manual for further information
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To control Probe Delay the following

manipulations are applicable: " /
e Mouse/ Touch Screen l/l

B Click or press and hold on the appropriate
e Keyboard

>
m Press _*4 J on front panel keyboard or or <Alt>+<R> on external keyboard = Probe Delay

fore color changes to white - then use !J '_’J _J ﬂ on front panel keyboard or , , ,

on external keyboard

e Combined

B Click on Probe Delay = Probe Delay fore color changes to white - then use !J '_’J !J !J
on front panel keyboard or , , , on external keyboard

@ Refer to paragraph 5.2.13 of this Operating Manual for some hints on determining Probe Delay
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05 Gain
245 dB

Meas Yalue

OFF

Meas Mode

Flank
0.1 Probe Delay

To control Incident Angle the following I /
manipulations are applicable: | /
Iy

e Mouse/ Touch Screen

B Click or press and hold on the appropriate

e Keyboard

-
B Press' _5 J on front panel keyboard or or <Alt>+<N> on external keyboard = Angle fore color

changes to white - then use !J '_’J _J !J on front panel keyboard or , , , on

external keyboard

e Combined

B Click on Angle = Angle fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or , , , on external keyboard

®

Refer to paragraph 5.2.13 of this Operating Manual for some hints on determining and / or checking Probe
Angle
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Advanced Measurements Settings Menu

£
. . b . .
Advanced measurement settings are available through button El_l appearing on the UDS 3-6 main
operating surface upon activating submenu MEASURE. Clicking on that button activates Advanced
Measurements Settings Menu:

[1] <=
[2] AUTOCAL
AS
4] X

- o
Press ' on front panel keyboard or on external keyboard or click on III |to
activate Advanced Scheme for Reflectors Depth Measurement Whilst Using Angle Beam Probe —

Thickness / Skip / Curved Scanning Surface Correction

F
Press 2 on front panel keyboard or on external keyboard or click on
activate Automatic Calibration Procedure

2] autocaL |

i
Press 2 J on front panel keyboard or on external keyboard or click on EI AS Ito
activate Dual Ultrasound Velocity Measurement Mode

> ESC
Press % Jor _)‘(\ on front panel keyboard or on external keyboard or click on

EI o |to return to main operating surface

®

Refer to paragraph 5.2.13.3 of this Operating Manual to get instructed on:
¢ Advanced Scheme for Reflectors Depth Measurement Whilst Using Angle Beam Probe —
Thickness / Skip / Curved Scanning Surface Correction
¢ Automatic Calibration Procedure
¢ Dual Ultrasound Velocity Measurement Mode
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5.2.13. Time Domain Signal Evaluation - Measurements Guide
5.2.13.1. Values available for Automatic Measurements and Digital Readout

Time of Flight - us of an echo matching
&-Scan with Gate A measured with respect to
Probe Delay:

T(A) = Absolute Delay A - Probe Delay

Value 2: T(B)

Time of Flight - us of an echo matching
with Gate B measured with respect to
Probe Delay:

T(B) = Absolute Delay B - Probe Delay
Value 3: S(A)

Material Travel Distance - mm or in of an
echo matching with Gate A:

s(A) =% - T(A) - US Velocity

n|r.'rtia| Pulse Value 1: T(A)

Display Delay Value_4: s(B) _ _
Material Travel Distance - mm or in of an
Abzolute Delay & - Flank echo matching with Gate B:
Abzolute Delay B - Flank s(B) =% - T(B) - US Velocity
Value 5: a(A)
Projection Distance - mm or in of reflector
Straight Beam Probe Angle Beam Probe returning an echo matching with Gate A,

measured with respect to Beam Incident
Point:

a(A) =s(A) -sin (Angle)

I_l Value 6: a(B)

a Projection Distance - mm or in of reflector
returning an echo matching with Gate B,
measured with respect to Beam Incident
Point:

Angle

€@ 0
nn
o W
o

a(B) =s(B) - sin (Angle)

Value 7: t(A)
Depth - mm or in of reflector returning an
echo matching with Gate A:

t(A) =s(A) - cos (Angle)

Value 8: t(B)
Depth - mm or in of reflector returning an echo matching with Gate B:

t(B) =s(B) - cos (Angle)

Value 9: AT - ps:

AT =T(B) - T(A)
Value 10: As - mm orin:

As =s(B) —s(A)
Value 11: Aa - mm orin:

Aa=a(B) —a(A)
Value 12: At - mm orin:

At =t(B) —t(A)
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C&bsolute Delay B- Top)  Value 13: H(A)
Clabsolute Delay & - Top) Azsean Amplitude - % of A-Scan height of an echo
matching with Gate A

Value 14: H(B)
Amplitude - % of A-Scan height of an echo
matching with Gate B
Value 15: V(A)
Amplitude - dB of an echo matching with
Gate A with respect to aThreshold:

V(A) =20 - logyp (H(A) / aThreshold )
Value 16: V(B)
Amplitude - dB of an echo matching with
Gate B with respect to bThreshold:

V(B) = 20 - log1o (H(B) / bThreshold )

a-Threshold b-Threshaold

Value 17: AV - dB:
AV =V(B) - V(A)
Value 18: AVC(A) (dB to DAC)-dB:
AVC(A) = 20 - logyo (H(A) / C (Absolute Delay A_Top) )
Value 19: AVC(B) (dB to DAC)-dB:
AVC(B) =20 - logip (H(B) / C (Absolute Delay B_Top) )

¢ To proceed corresponding Gate or both Gates to be active
¢ AVC(A) (dB to DAC) measurements require active DAC/DGS

+ Amplitude measurements of echoes may be performed provided their heights don't exceed 200% of A-
Scan height

+ For 2 and more echoes matching with a Gate - refer to paragraph 5.2.13.2 of this Operating Manual
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5.2.13.2. Flank, Top, Flank-First, and Top-First Modes of Measurement

The table below represents distinguishing points on an A-Scan, which will be taken for automatic

measurements depending on Meas Mode setting

Meas Mode setting

A-Scan

Meaz Mode

Flank

- T(A)1 T(B)7 S(A)1 S(B)1 t(A), t(B), a(A)v
a(B), AT, As, At, Aa
#® - V(A), V(B), H(A), H(B), AV, AVC(A),
AVC(B)

1

| I T
Ly Fl ] ~|" l.'J'l
|r| [*)

Meaz Mode
- T(A), T(B)! S(A), S(B)! t(A)! t(B), a(A)v
a(B), AT, As, At, Aa

® - V(A), V(B), H(A), H(B), AV, AVC(A),
AVC(B)

%

B |
bl 1
g I"# " b w A
¢ I'rJ‘L.‘|| ]J f | '-Irl.lt'rl I|u.||| il

Meaz Mode

Flank-First

- T(A)1 T(B)7 S(A)1 S(B)1 t(A), t(B), a(A)v
a(B), AT, As, At, Aa
#® - V(A), V(B), H(A), H(B), AV, AVC(A),
AVC(B)

lru"l-,ﬁ.‘J ]ll ¥

¥

|+ i
M, I" I'| -ﬁ'l 1| lfu.,l,.L

I
|I J|

Meaz Mode

Top-First

- T(A), T(B)! S(A), S(B)! t(A)! t(B), a(A)v
a(B), AT, As, At, Aa
# - V(A), V(B), H(A), H(B), AV, AVC(A),
AVC(B)

+ 1|| +I
[PRLNAY"

¥+
0 I-,,'L‘II | J f
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5.2.13.3. Advanced Scheme for Reflectors Depth Measurement Whilst Using Angle
Beam Probe — Thickness / Skip / Curved Scanning Surface Correction

[1] <=

Button

submenu MEASURE. The window as below appears after clicking on

-
_1_J on front panel keyboard or on external keyboard

Object under test may be designated as either

1] <=

or

£
| becomes available upon clicking on M if Angle setting differs from 0%in

pressing

* Flat - [click here

Or

>

e Curved -

While scanning above plates, tube wall, and the like the finite
thickness of object under test may be either

>

P

pr

o
1

»

¥ Ignore Thickness

e Ignored — |c|ick here_l
Or

e Entered —

Case 1 represents simplest scheme supposing that scanning
is performed above hemi-space whereas coordinates t(A),
t(B) are determined in accordance with appropriate sketches,
equations, and A-Scans shown in paragraphs 5.2.13.1 and
5.2.13.2 of this Operating Manual

Case 2 represents scanning above plate, or scanning above
tubular object longitudinally. Reflectors depth for half skip, full
skip, and multi skip insonification will be determined with
respect to actual Thickness value — t(A), t(B) readings will be
in accordance with sketches below:

wﬂh}’ uby Thickness
w—;}:t{h} Thickness

\ vﬂh}’ e f Thickness
Thickness

EVAN%i

> .

a
2

»

Apply

Cancel

Casel

* Flat Object

o~

pr

1 |p

" lgnore Thickness

@ 1 Thickness ‘ o .
25 mm =
Apply Cancel

Case 2
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Case 3 represents scanning above curved wall surface
circumferentionally. Reflectors depth for half skip, full skip,
and multi skip insonification will be determined with respect to
actual Thickness and Diameter values — t(A), t(B) readings
will be in accordance with sketch below:

Thickness

HA). tib)

0.5xDiameter

Thickness

t{ﬂ}: )

0.5xDiameter

Case 4 represents scanning above solid cylindrical object
cirmuferentionally or above spherical object. If this is a case
Thickness setting to be: Thickness = 0.5xDiameter and
reflectors depth will be determined with respect tio actual
Diameter value — t(A), t(B) readings will be in accordance
with sketch below:

t{ﬁ}.’:{h}

Diameter

™ Flat Object

10 Diameter

400 mm

pr

L
1

»

" Ignore Thickness

'S

pr

AL 4

Apply

Cancel

Case 3

™ Flat Object

2 Diameter

=
254 mm

pr

il 4

" Ignore Thickness

'S

pr

AL 4

Apply

Cancel

Case 4
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/

J

7
" Flat viect

10 Diameter

=
400 mm

" Ignore Thickness

Apply / Cancel
v A

To control Diameter the following
manipulations are applicable:

e Mouse / Touch Screen

B Click or press and hold on the appropriate

e Keyboard

-
B Press ! J on front panel keyboard or -1 on external keyboard = Diameter fore color changes to

white - then use !J '_’J :J !J on front panel keyboard or , , , on external

keyboard

e Combined

Click on Diameter = Diameter fore color changes to white - then use !J -' '_’J :J !J on front panel

keyboard or , , , on external keyboard
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To control Thickness the following
manipulations are applicable:

e Mouse / Touch Screen

l

" Flat ObjecV

2 Diameter

254 mm

" lgn IIE Thickness

I

[ o

B Click or press and hold on the appropriate

e Keyboard

'l
B Press LJ on front panel keyboard or on external keyboard = Thickness fore color changes

to white - then use !J _J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Thickness = Thickness fore color changes to white - then use !J '_’J :J !J on
front panel keyboard or , , , on external keyboard

Apply
¢ Clickon

activate new settings

Cancel
¢ Clickon

negate new settings

| Erlte.r
or press i,] on front panel keyboard or [Enter| on external keyboard to

| esc
or press \L] on front panel keyboard or on external keyboard to
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5.2.13.4. Dual Ultrasound Velocity Measurement Mode — Typical Example

For some practical applications it is necessary to measure sound path distances in dissimilar materials,
multi-layer structures, and the like. Also it may occur a need in measuring sound path distances for signals
representing various kinds of ultrasonic waves in the same object. Such cases are characterized by variety
of US Velocity values to be used while measuring intervals between signals on the same A-Scan. To
simplify measurement procedure and avoid operator's computations it may be activated Dual Ultrasound
Velocity Measurements Mode, which's use is illustrated by the example below

Supposing it's necessary to measure thickness of each layer of
bi-metallic part made through by means of explosion welding
between regular carbon steel ( US Velocity = 5920 m/s ) and
brass alloy (US Velocity = 4720 m/s ) plates while probe to be
placed on low carbon steel plate. While placed on the steel side
5 MHz dual element probe with Probe Delay = 9.32 us provides
receiving of two clear echoes 1 and 2 form the steel-to-brass
boundary and from the back surface of the brass layer
correspondingly:

Steel
Braz=

UDS3-6 - ISONIC Pulser /Receiver
‘ ' Channel 1

= Ty

Mo By

1 Range ‘
15 mm
10 US Yelocity ‘
5920 mjs
0.01 Display Delay ‘
932 s
L] Beject ‘
0 %
BASICS PULSER  RECEIVER  GATE A Menu m 3.‘
GATE B ALARM DAC/TCG  MEASURE  Selection

AR AR

Save Print DG5S
I

o By

4 By

ln By

[ T

=
Open

Cloze Em I Freeze
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US Velocity setting is suitable for steel and thickness of steel layer may be found through direct reading
upon placing Gate A above signal 1:

UDS3-6 - ISONIC Pulser/Receiver
" Channel 1

= Ty

Bt +

Meas Mode ‘

Flank
Probe Delay ‘

9 32 s
Angle ‘

+ +. 0l |+
S | 0°
BASICS  PULSER  RECEVER _ GATEA _  Menu [ ,| ”‘ 3-‘
GATEB  ALARM _ DAC/TCG TN Selection

4= By

I By

00 @ B|=|s w
Close EM| 3_55 mm Freeze Save | Open | Print DGES

If placing now Gate B above signal 2 and selecting As as Meas Value then interval between signals 1 and 2
will be measured. To obtain proper As readout value of US Velocity valid for brass alloy layer (second
material) must be keyed in

UDS3-6 - ISONIC Pulser /Receiver

‘ Channel 1

= Ty

Meas Yalue
AS ‘
as Mode

-4-

Flank
Probe Delay
9 32 ps ‘
Angle
«

BASICS  PULSER  RECEIVER _ GATE A Menu E|*| ”‘ 3-
GATEB  ALARM  DAC/TCG JIZXILIEN Selection

[ By

In by

00 “l Bz
Close EM| 23? mm '\EIEEZE Save | Open | Pnnt DGS
Ty

This digital readout was obtained through use of steel
- US Velocity setting (first material) and may not be r
_ recognized as a thickness of brass alloy layer (second _
material)
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To obtain proper reading for the thickness of brass layer activate Dual Ultrasound Velocity Measurements
£

M if:

Mode - Button AS becomes available upon clicking on

+ Both Gate A and Gate B are active (refer to paragraphs 5.2.5 and 5.2.6 of this Operating Manual)

¢ Meas Value setting is As (refer to paragraph 5.2.12 of this Operating Manual)

" " Channel 1

=y

Il < »
Meas Yalue
Rlle »
Meaz Mod
B5lle »
E [2] AUTOCAL E
0

[3] As

BASICS PULSER RECEIVER GATE A Menu El N E >
GATE B ALARM DAC/TCG MEASURE Selection

| & = = "
Cloze Em | 2.37 mm Freeze Save | Open | Print DGES
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The screen as below appears after clicking on
keyboard or on external keyboard:

-‘ Channel 1

BASICS
GATE B

PULSER

ALARM

RECEIYER
DAC/TCG

[3] As -

or pressing = on front panel

Meaz Yalue
|- <«
Meaz Mode
‘ .
Probe Dela
.
10 US Velocit
oo KL

GATE A Menu
MEASURE Selectio

2_3? mm

[ [ &

Close EM| 2_3? mm Freeze Ok Frint |

: -
: Click on this button or press '  on front panel

. - keyboard or F1 or <Alt>+<1> on external keyboard
- : to select value of increment/decrement for second
[ i r : US Velocity setting
- ' 1_ llllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllll
237 mn
()% (gl |

v -

Click on appropriate Ibuttonl or press '. , .o , ‘ , .' on front panel keyboard or , H H,on

external keyboard to setup value of second US Velocity valid for brass alloy layer (second material)
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UDS3-
‘l | Channel 1

+

1 Gain
b0 dB ‘
Meas Yalue
e
Meas Mode
b «
1 Piobe Delay
4.
10 U5 Yelocity
4720 mfs

S S S e

BASICS PULSER RECEIVER GATE A Menu
GATE B ALARM PEIwa Nty MEASURE Selectic

BIE
Close MI 23? mm Freeze

=

[Digital readout for actual thickness of the brass alloy layer (second material)] is obtained upon completing
setting for second US Velocity

To return to the main ISONIC Pulser Receiver window click on Dk |0r press *=_ or on
front panel keyboard or <Alt>+<K> or Enter|or on external keyboard

To printout A-Scan accompanied with setup list, measured value of As, and second US Velocity value click

on Brint | or press <Alt>+<P> on external keyboard (printer to be accessible through either USB or
LAN port and defined as default in the ISONIC 2008)
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5.2.13.5. Determining Probe Delay - Miniature Angle Beam Probes (contact face
width 12.5 mm /0.5 in or less) - Shear or Longitudinal Waves — Typical Example

Activate submenu PULSER then set:

O Pulser Mode to Single or Dual depending
on probe

O Pulse Width to 50 ns for probe having
resonant frequency of 10 MHz and higher
orto PW ns, were PW = 0.5/ F (F is the
probe resonant frequency) for probes
having resonant frequency below 10 MHz

Q Firing Level to 12

Activate submenu RECEIVER then set:

Q Display to Full or RF

O Filter to OFF or ON

Q Low Cut and High Cut to completely
cover probe's effective bandwidth on case
if Filter setting is ON

Activate submenu BASICS topic then set:

a US Velocity to 5920 m/s (233.1 in/ms) for
longitudinal wave probes or 3255 m/s
(128.1 in/ms) for shear wave probes

O Rangeto50.0 mm (2in)

O Display Delay to O ps

O Reject to 0%

Stage 1. Manipulate probe over main working
surface of V-2 reference standard and maximize
echo from 25 mm (1 in) radius concave reflector

Stage 2: Fix probe in found position - the center of
25 mm (1 in) radius concave reflector will indicate
incident point while the distance between probe's
frontal edge and incident point is equal to X-
Value

Stage 3: Tune Display Delay while probe is still
fixed in found position until rising edge of
maximized echo will match with 50%-grid of the A-
Scan width. Upon completing the obtained value
of Display Delay will be equal to actual Probe
Delay

®

It's necessary to setup Gain bringing height of maximized echo to 75-80% of A-Scan height
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5.2.13.6. Determining Probe Delay - Large and Medium Size Angle Beam Probes
(contact face width more than 12.5 mm /0.5 in) - Shear or Longitudinal Waves —

Typical Example

+ +
maving probe

v

f
!

!

+

®

Activate submenu PULSER then set:

Q Pulser Mode to Single or Dual depending
on probe

Q Pulse Width to 50 ns for probe having
resonant frequency of 10 MHz and higher
or to PW ns, were PW = 0.5/ F (F is the
probe resonant frequency) for probes
having resonant frequency below 10 MHz

Q Firing Level to 12

Activate submenu RECEIVER then set:

o Display to Full or RF

a Filter to OFF or ON

O Low Cut and High Cut to completely
cover probe's effective bandwidth on case
if Filter setting is ON

Activate submenu BASICS topic then set:

Q US Velocity to 5920 m/s (233.1 in/ms) for
longitudinal wave probes or 3255 m/s
(128.1 in/ms) for shear wave probes

Q Range to 200.0 mm (8in)

a Display Delay to 0 ps

QO Reject to 0%

Stage 1: Manipulate probe over main working
surface of V-1 reference standard and maximize
echo from 100 mm (4 in) radius concave reflector

Stage 2: Fix probe in found position - the center of
100 mm (4 in) radius concave reflector will indicate
incident point while the distance between probe's
frontal edge and incident point is equal to X-
Value

Stage 3: Tune Display Delay while probe is still
fixed in found position until rising edge of
maximized echo will match with 50%-grid of the A-
Scan width. Upon completing the obtained value
of Display Delay will be equal to actual Probe
Delay

It's necessary to setup Gain bringing height of maximized echo to 75-80% of A-Scan height
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5.2.13.7. Determining Probe Delay - Straight Beam (Normal) Single Element and Dual

(TR) Probes — Typical Example

Activate submenu PULSER then set:

a

1 US Velocity
b920 m/s

set:
Q
Q

1 U5 Velocity o

5920 mfs

+ o+ o+ o+

Reject

Pulser Mode to Single or
Dual depending on probe
Pulse Width to 50 ns for
probe having resonant
frequency of 10 MHz and
higher or to PW ns, were PW
=0.5/F (F is the probe
resonant frequency) for
probes having resonant
frequency below 10 MHz
Firing Level to 12

Activate submenu RECEIVER then

Display to Full or RF

Filter to OFF or ON

Low Cut and High Cut to
completely cover probe's
effective bandwidth on case if
Filter setting is ON

0% Activate submenu BASICS topic then

set:
[}

[}
[}
[}

US Velocity to 5920 m/s
(233.1 in/ms) for longitudinal
wave probes or 3255 m/s
(128.1 in/ms) for shear wave
probes

Range to 25.0 mm (1 in)
Display Delay to O us
Reject to 0%

Stage 1: Apply probe to a side surface of V-2 reference standard to receive back echo

Stage 2: Tune Display Delay until rising edge of the back echo will match with the 50%-grid of the A-Scan
width: in such case the obtained value of the Display Delay is equal to the actual Probe Delay

®

It's necessary to setup Gain bringing height of maximized echo to 75-80% of A-Scan height
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5.2.13.8. Automatic Calibration (AUTOCAL) of Probe Delay and US Velocity - Angle
Beam Probes - Shear or Longitudinal Waves — Typical Example

There are 2 maximized reference
echoes from 2 concave reflectors
with different radius 25 mm (1 in)
and 50 mm (2 in) in use for
performing automatic calibration
of Probe Delay and US Velocity.
A-Scan settings (Range, Display
Delay, US Velocity — refer to
paragraph 5.2.2 of this Operating
Manual) must allow observing of
both signals. Gate A to match
with first reference echo received
from concave reflector with
smaller radius (shorter material
travel distance) — refer to
paragraph 5.2.5 of this Operating
Manual. Gate B to match with
second reference echo received
from concave reflector with larger
radius (longer material travel
distance) — refer to paragraph
5.2.6 of this Operating Manual

®

It's necessary to setup Gain
bringing height of far reflector
echo to 75-95% of A-Scan
height

ISONIC 2008 from Sonotron NDT - Operating Manual — Revision 1.06 - Page 103 of 316



i

£ »

Obtain first reference echo, activate submenu MEASURE then click on

05 Gain
125 dB

‘ Channel 1

= Ty

Meas Yalue
OFF
Meas Mode

pr
p™
P

E AUTOCAL

BASICS PULSER  RECEIVER _ GATE A Menu iyl [ X
GATE B ALARM DAC/TCG MEASURE Selection
| Value: DFF ﬁ ﬂ = | & o
Close Em | Freeze Save | Open | Pnnt DGS
Fa
To activate AUTOCAL procedure click on E‘ AUTOCAL | or press 2 on front panel keyboard or

on external keyboard - the |AUTOCAL Control Surfacel appears

\
-‘ Channel 1 \\
05 Gain
125 dB ‘
1 MTD-s[A)
-
TIA)
2058 ps
2 MTD-s[B)
1015 mm

_. T®)
e —

BASICS PULSER RECEIYER GATE A Henu Cancel
GATE B ALARM priwgn gy MEASURE Selection = %

B value:oFF | ﬁ{ﬂm'«

Close | PN | Freeze | Tk
—

Click on this button or press press on front

panel keyboard or or <Alt>+<C> on external
keyboard to interrupt AUTOCAL Procedure and
return to main UDS 3-6 control surface

= By

o By

»
>

\-H- |
I -1 S N .
ESC .

'S

If necessary Gain may be re-adjusted in the AUTOCAL Control Surface by the same way as it is explained
in paragraph 5.2.2 of this Operating Manual
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: Click on this button or press 3
o 7 :
3 _2_lon frontpanel :
: keyboard oror :
i <Alt>+<2> on external :

: keyboard to select value of :
~ increment/decrement for 1

- .

: Current value of :
: increment/decrement for  :
: keying in Material Travel ;

Distance MTD-s(A),
mm or in
Material Travel Distance
MTD-s(A) in mm or in for the
first reference echo to be
entered here while the said

echo matches with Gate A N 1 MTD-s[A]
--------------------------------------- 25 mm ,

: keying in Material Travel
: Distance MTD-s(A)

TiA) gF () R
: Digital readout box indicating 2058 ps .,
: automatically determined delay : .~ )
i of the first reference echo 4 1
: relatively firing pulse excitation : [l
: ks iy
........................................ .
—
Cancel I d ‘ Y .:
Ly S & Click on this buttonto  :
To key in Material Travel Distance MTD-s(A) 1/ confirm ehtered Material :
the following manipulations are applicable: I : Travel Distance MTD- :
e Mouse /Touch Screen : S(A) :
B Click or press and hold on the appropriate
e Keyboard
Fa
m Press _2 J on front panel keyboard or E or <Alt>+<A> on external keyboard = MTD-s(A) fore
t » @« 3

color changes to white - then use on front panel keyboard or m Q ; J«\ on

external keyboard
e Combined
B Click on MTD-s(A) = MTD-s(A) fore color changes to white - then use '. , - , c = , " on
front panel keyboard or ﬂ b ﬂ @ on external keyboard

Upon confirming keying in Material Travel Distance MTD-s(A) obtain second reference echo

05 Gain
125 dB ‘
1 MTD-s[A)
25 mm
TiA]

2058 ps
10 MTD-s(B)

b0 mm

T(B)
36.12 ps

‘ Channel 1

»

= &y

4= By

p

»
!

BASICS PULSER RECEIVER GATE A Menu Cancel ‘
GATE B ALARM DAC/TCG MEASURE Selection =

[ | Value: OFF ﬁ ﬂ g = & - =
Closze EM| Ereeze Save | Open | Print DES
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1 MTD-z(A)

25 tim
TiA)
20 b8 ps
10 MTD-s(B)
B0 mim
T(B]
3612 ps

Click on this button to
N~ confirm entered Material
Travel Distance MTD-
s(B) :
To key in Material Travel Distance MTD-s(B) 1/ ]
the following manipulations are applicable: I

Click on this button if it is

necessary to return backto  :_.
keying in Material Travel

Distance MTD-s(A)

e Mouse /Touch Screen
B Click or press and hold on the appropriate
e Keyboard

-
B Press _4 j on front panel keyboard or or <Alt>+<B> on external keyboard = MTD-s(B) fore

color changes to white - then use !J '_’J :J !J on front panel keyboard or (T, , , on

external keyboard
e Combined

B Click on MTD-s(B) = MTD-s(B) fore color changes to white - then use !J '_’J :J !J on
front panel keyboard or , , , on external keyboard

ISONIC 2008 from Sonotron NDT - Operating Manual — Revision 1.06 - Page 106 of 316



Material Travel Distance MTD-s(B) The screen as below appears upon confirming keying in

UDS3-¢
‘l’l Channel 1

1 MTD-s[A]
25 mm

TIB]

36.12 ps

T, . P . S .
BASICS PULSER RECEIVER  GATE A Menu S .
GATE B ALARM pAc/TCe PTTXIGIEE Selection | U

I_ I_ Walue: OFF ] = =
Cloze MI Freeze

¢ Clickon ﬂ if it is necessary to return back to keying in Material Travel Distance MTD-s(A)

Autocal =
¢ Clickon or press + J on front panel keyboard or Enter or <Alt>+<U> on external keyboard

to initialize automatic determining of US Velocity and Probe Delay based on above described keying
and echoes delays automatic measurements. As a result the screen as below appears:

ISONIC 2008 from Sonotron NDT - Operating Manual — Revision 1.06 - Page 107 of 316



i - ™ Meas Yalue
Frobe Delay OFF

Meas Mode
US Yelocity Flank
3218 mfs 101 Piobe Delay

1 —r-'.—.—u—|='=‘|='=—|‘—|—=|—||——|— ST .T.i|—.—'."—'+7.—'|= T

BASICS PULSER dECEIVER GATE A Mehu
GATE B ALARM ANt MEASURE Selection

Yalue: OFF

Close Alasin Freeze

-~ /

ESC
Click onj or press L) on front panel keyboard or  [Click onj or press ‘.". on front panel keyboard or
Esc|or <Alt>+<C> on external keyboard to negate Enter|or <Alt>+<A> on external keyboard to

AUTOCAL results and return to main operating accept AUTOCAL results and return to main
surface without modifying Probe Delay and US operating surface with appropriate modifying Probe
Velocity settings Delay and US Velocity settings

ISONIC 2008 from Sonotron NDT - Operating Manual — Revision 1.06 - Page 108 of 316



5.2.13.9. Automatic Calibration of Probe Delay and US Velocity - Straight Beam
(Normal) Single Element and Dual (TR) Probes — Typical Example

UDS3-6 - ISONIC Pulser /Receiver
‘ ' Channel 1

0.5 Gain
42 5 dB ‘

Measz Yalue
.

Meaz Mode ‘
Flank

0.01 Probe Delay
h 04 s ‘
10 Angle ‘

BASICS PULSER RECEIVER GATE A
GATE B ALARM DAC/TCG

|_ |_ Walue: OFF ‘ﬁ ﬂ [ = &k e
Cloze Em | Freeze Save | Open | Print DG5S

There are two received back echoes following each other (normally — first and second) required for
performing automatic calibration of Probe Delay and US Velocity. A-Scan settings (Range, Display Delay,
US Velocity — refer to paragraph 5.2.2 of this Operating Manual) must allow observing of both signals.

Gate A to match with first back echo (shorter material travel distance) — refer to paragraph 5.2.5 of this
Operating Manual. Gate B to match with second back echo(longer material travel distance) — refer to
paragraph 5.2.6 of this Operating Manual

®

It's necessary to setup Gain bringing height of third back echo to 75-100% of A-Scan height
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All further operations to be performed identically to described in paragraph 5.2.13.8 of this Operating Manual

0.5 Gain
43 dB

Meaz Yalue

OFF

Meaz Mode

Flank

01  Probe Delay

Mi

..."Ll 'h

| )
PULSEH HEEEI‘U’EH
ALARM DAC/TCG

i Ve orr |
[‘Alarm |

BASICS
GATE B

GATE A

Cloze Ereeze

Menu
Selection

5.04 ps

10 Angle
ﬂ (1]
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5.2.13.10. Determining Incidence Angle (Probe Angle)

Caze Iltll

Case 3

L=

CF

Cazeh

-

o

Determining of incidence angle is
based on maximizing echo from
side-drilled hole in reference block
and reading the value of angle from
corresponding scale. Depending on
probe dimensions and angles there
are various reference blocks and
scales applicable:

Case 1. Miniature angle beam

probe, incidence angle 35° to 65°,
V-2 reference block

Case 2: Miniature angle beam

probe, incidence angle 65° to 75°,
V-2 reference block

Case 3: Medium or large size angle
beam probe, incidence angle 40° to
66°, V-1 reference block

Case 4: Medium or large size angle
beam probe, incidence angle 60° to
76°, V-1 reference block

Case 5: Medium or large size angle
beam probe, incidence angle 74° to
80°, V-1 reference block
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5.2.14. Frequency Domain Signal Presentation and Evaluation

Using Range and Delay parameters select a portion of A-Scan for frequency domain (FFT) presentation
then do activate submenu RECEIVER and switch Display to FFT (refer to paragraph 5.2.4 of this Operating
Manual). The screen as below appears:

i FFT Graph rveeeoorce Sanal
i FFT Measurements |
: Controls 3 : ' -
S e CIHLS
~ T — - -
. THE
\ D - -
N\ 4
L Reject -~
M« »
)
] x| A 2| UDS 3-6
a \
L H = | & —
Closze Al Freeze * | ﬁ Save | Open| Print I\ DG5S
- ! %
-~ \

Displayed Frequency
Range Controls

FFT Measurements
Indicator 1

@ Display may not be switched into the FFT if the Range value is too long or DAC/TCG/DGS is active
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Lower frequency bound (LowerFreq)

To control LowerFreq the following
manipulations are applicable:

I
Mouse / Touch Screen ’//
B Click or press and hold on appropriate

Keyboard

-
B Press 2 J on front panel keyboard or or <Alt>+<W> on external keyboard = LowerFreq fore

color changes to white - then use !J ZJ _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on LowerFreq = LowerFreq fore color changes to white - then use !J ZJ :J !J
on front panel keyboard or , , , on external keyboard
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Upper frequency bound (UpperFreq)

To control UpperFreq the following
manipulations are applicable:

0.1 LowerFreq

0.1 UpperFreq

I

1
I

Mouse / Touch Screen /1,

B Click or press and hold on the appropriate Ibuttonl

Keyboard

Fd
B Press 3 jon front panel keyboard or or <Alt>+<U> on external keyboard = UpperFreq fore

color changes to white - then use !J ZJ _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on UpperFreq = UpperFreq fore color changes to white - then use !J 2J :J !J on
front panel keyboard or , , , on external keyboard

ISONIC 2008 from Sonotron NDT - Operating Manual — Revision 1.06 - Page 114 of 316



Find maximum

Click on J — mouse pointer may be guided then just over FFT graph. FFT Readout Box displays
frequency corresponding to pointer position whilst guiding the cursor. Select first point of interest by mouse

click or through release of touch screen stylus. The appropriate mark 0 appears. Select the second point
of interest by the same way

Selection of Second
point FFT Mark and
corresponding
frequency value

Maximum’s frequency mark @appears and FFT Readout Box displays the found value automatically
upon mouse click or releasing of touch screen stylus:

Maximum’s
frequency mark and
digital readout

n
oo a o n s sy
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Find the —3db / —20db level bounds:

Maximum’s

frequency mark

- 3 dB bounds —
marks and digital
readout

Return to FFT Measurements toolbar:

=
Click on

Find frequency corresponding to selected single point on FFT graph:

Click on J — mouse pointer may be guided then just over FFT graph. FFT Readout Box displays
frequency corresponding to pointer position whilst guiding the cursor. Select first point of interest by mouse

click or through release of touch screen stylus. The appropriate mark n appears and FFT Readout Box
displays corresponding frequency:

Selected point
and
corresponding
freauency

+ + + 0+ + +, + + +

[+~ T
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Frequency difference (deviation) between two points:

Click on _I — mouse pointer may be guided then just over FFT graph. FFT Readout Box displays
frequency corresponding to pointer position whilst guiding the cursor. Select first point of interest by mouse

click or through release of touch screen stylus. The appropriate mark n appears. Select second point of

interest by the same way - the appropriate mark e appears and the FFT Readout Box displays difference
(deviation) between corresponding frequencies:

1 Selected points and
:  difference (deviation)
! between corresponding
: frequencies

f2 -1 = 0.85 MHz

Clear FFT Marks:

]
Click on

Exit FEFT Mode:

Change Display mode
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5.2.15. Freeze A-Scan / FFT Graph

UDS3-6 - ISONIC Pulser/Receiver
" Channel 1

=y

05 Gain
42 b dB ‘

Measz Yalue

H{ag
Meas H&e
Flank

Probe Delay
8 b8 ps ‘
A_qle
~ p
R N ) W L SL | T
BASICS ~ PULSER  RECEIVER _ GATE A Menu i ”‘ 3.‘
GATE B ALARM  DAC/TCG [JITFXHIG[E Selection

= By

hdh dh 4h 4h 4

len By

i B =|a L
Cloze EM| 94.3 %% ErzPe* Save | Open | Print DGES
L |

To freeze / freeze peak / unfreeze the A-Scan click or press :*;J on front panel keyboard or or
<Alt>+<F> on external keyboard

®

¢ Freeze Peak mode allows representing of Hilbert envelop for sequence of echoes obtained while
manipulating probe over some reflector. This function may be useful for localization of echo maximum
when working in A-Scan mode:

+ e, +
P
‘I‘u“ i f‘-,‘. .

¢ Freeze Peak mode may not be activated for RF and FFT signal presentation
¢ Appearing of at the upper left corner of A-Scan indicates that it is frozen (Freeze)

Appearing of at the upper left corner of A-Scan indicates that Freeze Peak mode is active
The following operations are available when time domain A-Scan is frozen:
0 =6 dB Gain varying according to paragraph 5.2.2 of this Operating Manual
0 Manipulating Gates A and B according to paragraphs 5.2.5, 5.2.6, 5.2.7 of this Operating Manual
o Varying Alarm mode according to paragraph 5.2.8 of this Operating Manual
0 Selecting parameter (Meas Value) for automatic measurements and varying settings Probe
Delay and Angle as per paragraph 5.2.12 of this Operating Manual and obtaining corresponding
measurements results in the digital readout box (Value)
¢ The following operations are available while frequency domain FFT Graph is frozen:
0 =6 dB Gain varying according to paragraph 5.2.2 of this Operating Manual
o0 All FFT evaluation / measurements as per paragraph 5.2.14 of this Operating Manual
+ Caption of appropriate button changes in the UDS 3-6 Pulser/Receiver window when freeze / freeze
peak / unfreeze A-Scan / FFT Graph

Freeze FrzPeak
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5.2.16. Zoom A-Scan / FFT Graph

Double click on A-Scan / FFT Graph to get it enlarged. Enlarged A-Scan / FFT Graph occupies screen
completely

In upright corner of A-Scan there is a digital readout box indicating current Gain value and digital readout of
automatic measurements provided that corresponding Gate is active

L ¥

To control Gain while A-Scan is enlarged use —~ and =/ on front panel keyboard or , on external
keyboard

To freeze / freeze peak / unfreeze enlarged A-Scan press &J on front panel keyboard or on external
keyboard
If Gate A and / or Gate B is active then:

Parameters V(A), s(A), t(A), a(A) , V(B), s(B), t(B), and Parameters V(A), s(A), V(B), and s(B) are measured and
a(B) are measured and indicated automatically — refer to indicated automatically — refer to paragraph 5.2.13.1 of this
paragraph 5.2.13.1 of this Operating Manual Operating Manual

Parameters V(A), s(A), t(A), and a(A) are measured and Parameters V(A), and s(A) are measured and indicated
indicated automatically — refer to paragraph 5.2.13.1 of automatically — refer to paragraph 5.2.13.1 of this Operating
this Operating Manual Manual

Parameters V(B), s(B), t(B), and a(B) are measured and Parameters V(B), and s(B) are measured and indicated
indicated automatically — refer to paragraph 5.2.13.1 of automatically — refer to paragraph 5.2.13.1 of this Operating
this Operating Manual Manual

To select an additional parameter for automatic measurement and large character indication while A-Scan is

enlarged (Meas Value - refer taragraphs 5.2.12 and 5.2.13 of this Operating Manual) use ‘ and ‘

on front panel keyboard or , on external keyboard. Gate A and Gate B if active may be drag and drop
manipulated on the enlarged A-Scan according to paragraph 5.2.7 of this Operating Manual. To return to
main operating surface window double click on enlarged A-Scan / FFT Graph
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5.2.17. Save an A-Scan and its Calibration Dump into afile
To save the current channel A-Scan / FFT Graph and Calibration Dump or file including Calibration

=
Dumps for 8 channels into a file click on ﬁ' or press 2‘_) on front panel keyboard or or

<Alt>+<S> on external keyboard — the dialogue prompting to select type of file appears:

UDS3-6 - ISON

«1| p] Chﬂnnel 1€ .

+ +

(=R

" IPlease select File Type:

Ino By

Save Current Channel Only

oo By

Sawve All Channels

4= By

Cancel

len By

I|""'|-. P,
TSI FULSER M e m 3-‘
GATEB  ALARM  DAC/TCG  MEASURE  Selection

== @l Bz g
Cloze M| 869 % Freeze Save | Open | Print DES
To store the current channel A-Scan / FFT Graph and Calibration Dump click on
Save Current Channel Only
To store Calibration Dumps for 8 channels click on
Sawve All Channels
Cancel
To return to UDS 3-6 Pulse Receiver screen click on or press

ESC
L‘\ on front panel keyboard or on external keyboard
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Depending on selection made ISONIC 2008 Save/Open window becomes active providing automatically
created name for a new file in the File name: box:

ISONIC 2008 Save,/Open 2=l

Save in: I ) UDS 36 Pulzer Receiver j = ¢ Ef-

UD53-6 - ISONIC
‘l | Chan

Mew PUOOOO0S.par B3] PLUOOOO1Z, par
PUODDOO1.par B8] PUOODOO7. par |55 PLUDOOO1 3. par
PUODDOOZ.par B8] PUOOOO0S. par |55 PLUDOOO1 4. par
PUOD0OOZ.par B8] PUOOOO0S.par |55 PLUDOOO1S, par

= Ty

PUODOOO4.par | PUODO0LO.par [ PUDOOD1E. par
PUOONO0S. par ] PUOOOO1 1. par 5] PUIDDOO1 7, par

Iro By

File name: PUODN01 3. p: Save I

= By

len By

~r @l # s hwelf~ &=l ol |

T Y Y
joa By
v

GATE B
- allsl{alfflfallnllillcfill;:l: J I | xx
Llose mm zllxllclivliiblnlimll,.l| .l DGS

Del BS
S
ISONIC 2008 Save/Open 2] x|
Save in; I I UDS 36 Pulzer Receiver j = % Ef-
UDS3-6 - ISONIC

‘l b ch Mew PUOOOO0Z. prmm
. aa.prm PUOOOO0S. prm
BOEING 787 Stringer Corner S Channels.prm |55 PUOO00O, prmn

jitQ. prrn PUIOOOOOS. prm

|

1T, prn PLIOOOO0G, prm
PLIONNGO1  prm TOFDZ. prm

Ino By

o2 By
v AhAh Ah dh 4

pr
p™
L« | oy
p™
p™
'3

File name: 5 I
ave o
Save astype: [LDS 36 Muliicharnel Settings (“prm) ¥ Cancel | 1
-

+ + 5
-l l@ll# s e~ (W&l el _fl=]! 5
BASICS allwlfel[rifTlylullrlfolfrlfll; -‘
GATE B

- Allsfio||Fljacnffallwffr]:|f" |-
E'"*EmmszVBum-za-? DES
Del BS
&
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To save a file:

keyboard or press or

select disk drive and directory for placing a file using mouse or touch screen

approve automatically created new file name

OR
mark a file to be replaced from the list appearing in the destination directory

OR
type a new file name using either virtual keyboard generated in ISONIC 2008 Save/Open window or
external keyboard — standard Windows rules for file naming are applicable, long names (up to 64
characters) are supported

&=

double click on file to be replaced or click on ﬂl or press ‘22 Jor
i

Il or <Alt>+<S> on external keyboard

L
Enter |

== J on front panel

ISONIC 2008 Save/Open window disappears automatically upon completing saving a file

ESC
To quit ISONIC 2008 Save/Open window without saving a file click on ﬂl or press Lj on front
panel keyboard or on external keyboard
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5.2.18. Load an A-Scan and its Calibration Dump from afile

= | =
To load A-Scan/FFT Graph and Calibration Dump from a file click on "8P&R| or press ' &) on front panel
keyboard or or <Alt>+<0> on external keyboard — <Alt>+<0O> on the keyboard — ISONIC 2008
Save/Open window becomes active

|| Channat 1

o
Laak in: I 3 UD5 36 Pulser Receiver j 4= = Eo- ‘ 1 »
iNew = PUOOOOO1 . prm ‘ r 3 »
) aa.prm = Puoon0nz2. par Z
= BOEING 787 Stringer Corner 5 Channels.prm |5 PU0000O0Z, prm -
i) jik. prm =) PUODD0O0S, par ‘ 3 »
] 717 prm =] PuDOODGS, prm
= PUDO0OD1. par [ PUODOO0. par ‘ ':. »
N -
CHD
RSP WL W8 | ame; I Dpen

BASICS , : » 3
GATE B Files of type: |41 UDS 36 Files | Cancel | "

2

[ —re— @ == & | 1| -
Cloze M| Freeze Save _gpen Print DES
To open a file:
e select disk drive and directory containing a file required
E"; Ente.r |

e select then file then double click on its name or click on ﬂ or press 22 ) or  *=_J on front

panel keyboard or or or <Alt>+<0O> on external keyboard

ISONIC 2008 Save/Open window disappears automatically upon completing loading a file

ESC
To quit ISONIC 2008 Save/Open window without opening a file click on ﬂl or press < Jon
front panel keyboard or on external keyboard

®

¢ PAR file uploads calibration dump and freeze A-Scan onto currently active channel
¢ PRM file uploads 8 calibration dumps into all UDS 3-6 channels of ISONIC 2008 instrument
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5.2.19. Print A-Scan/FFT Graph and Settings List

Ensure the printer connection is in order (printer to be accessible through either USB or LAN port and

ﬁ I é
defined as default in the ISONIC 2008) then click on Erint or press m) on front panel keyboard or m
or <Alt>+<P> on external keyboard

5.2.20. Activate Main Recording Menu

I
Click on or press LJ on front panel keyboard or on external keyboard. The Main Recording
Menu appears

[ 1 ]1sonic 2008

[2]1sonic 2005

| 3|Back

. . . . . [1|isoNic 2008 * )
To go ahead with multi-channel scanning and recording click on orpress _1 Jon front

panel keyboard or @ on external keyboard, the follow instructions of Chapter 7 of this Operating Manual for
further instructions

To go ahead with multi-channel scanning and recording (ISONIC 2005 modes of imaging and recording)
F

click on ‘ Jor press _2_J on front panel keyboard or on external keyboard, the follow
instructions of Chapter 6 of this Operating Manual for further instructions

[2]IsONIC 2005

J ESC F
orpress \X_Jor 3 Jonfront

EBack

To return to UDS 3-6 Pulse Receiver screen click on
panel keyboard or or @ on external keyboard

5.2.21. Switch OFF UDS 3-6

ESC
To switch OFF UDS 3-6 and to return to ISONIC 2008 Start Screen click on __El0s& | or press Lj on
front panel keyboard or or <Alt>+<C> on external keyboard
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6. Recording and Imaging — Single
Channel (CH 1)
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6.1. Main Recording Menu — Single Channel (CH 1)

Main Recording Menu — Single Channel (CH 1) is shown below:

IfTime Based Recording

[2|True to Location Recording

@Back

There are 2 recording submenus available:

¢

*

Time Based Recording submenu relates to line scanning procedures where probe is

manipulated over object under test with constant speed and defects images are formed from

sequence of A-Scans captured at equal time intervals (real time clock). To open Time Based
| s

. . | [1]Time Based Recordi |
Recording submenu click on |- "B o nress 1 on front panel keyboard or

on external keyboard

True to Location Recording submenu relates to line scanning procedures where coordinate of
probe manipulated over object under test is transferred to ISONIC 2008 instrument by means of
position encoder while defects images are formed from sequence of A-Scans captured at equal

. . . . . | [2]True to Location Record
distance intervals. To open True to Location Recording submenu click on | 2™ '@ tection Recerdina
.

or press _2_ on front panel keyboard or on external keyboard

. . i |3 |Back J E{s\c C
To return to UDS 3-6 Pulse Receiver screen click on | or press _j or 3 Jonfront
panel keyboard or or @ on external keyboard
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6.2. Time Based and True to Location Recording Submenus

Both Time Based Recording and True to Location Recording submenus allow activating 4 protocols of
data recording:

[1]t-BScan (Th) [1]BScan (Th)

[2]t-ABiscan [2]ABIScan
[8]t-ToFD [8]ToFD
IZ]t—Floarmap 1= z‘ Floormap L
J B &
|?] Back |?] Back

+ Thickness Profile imaging and recording —t-BScan(Th) or BScan(Th) — click on ‘MJ or
"

or press LJJ on front panel keyboard or on external keyboard — illustrative video
is available at http://www.sonotronndt.com/video.asp?VideolD=1

[1]BScan (Th)

¢ B-Scan cross-sectional imaging and recording of defects for longitudinal and shear wave

F
t-ABIScan 2 |ABIScan |
2] ‘orl 2] ‘or press —2_Jon

inspection — t-ABIScan or ABIScan — click onl
front panel keyboard or on external keyboard — illustrative video is available at
http://www.sonotronndt.com/video.asp?VideolD=2

¢ TOFD Inspection — RF B-Scan and D-Scan Imaging — t-TOFD or TOFD - click on ‘&J or

Fd
3 TOFD |
B or press _3 Jon front panel keyboard or on external keyboard — illustrative video

is available at http://www.sonotronndt.com/video.asp?VideolD=4

¢ CB-Scan horizontal plane-view imaging and recording of defects for shear, surface, and guided

l E‘t-Floormap L ‘ l leloormap L
or

wave inspection — t-FLOORMAP L or FLOORMAP L click on
-

_4_Jon front panel keyboard or on external keyboard — illustrative video is available at
http://www.sonotronndt.com/video.asp?VideolD=3

press

To return to Main Recording Menu — Single Channel (CH 1) screen click on ‘lJ or press
ESC r

X Jor 5 _Jonfront panel keyboard or or on external keyboard
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6.3. Thickness Profile Imaging and Recording — t-BScan(Th)

and BScan(Th)

6.3.1. Setup Pulser Receiver for Thickness Profile Imaging and
Recording

UDS 3-6 Pulser Receiver screen appears upon clicking on

following settings to be provided:

1 |t-BScan (Th) ‘ l [1]|Bscan (Th)
0 oL O

. The

# | Parameter or Submenu Required Settings Note
Mode
1 aSwitch GATE A ON
2 Gain BASICS Gain and aThreshold settings to
aThreshold GATE A provide receiving an echo from the
minimal area of thickness degradation to
be detected; height of the said echo to
exceed aThreshold; signals from other
reflectors less then defined one not to
exceed aThreshold
3 DAC/TCG DAC/TCG DAC/TCG settings to meet requirements
of the Inspection Procedure
4 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
5 Pulse Width, Firing PULSER Pulse Width and Firing Level settings To synchronize with Gain
Level to optimize signal to noise ratio and aThreshold setting
procedure
6 Filter, Low Cut, and RECEIVER Filter and Low Cut and High Cut To synchronize with Gain
High Cut settings to match with probe's frequency | and aThreshold setting
Frequencies to optimize signal to noise ratio procedure
7 Display RECEIVER Display mode may be either Full, RF, The same Display mode to
PosHalf, or NegHalf be used for both Probe
Delay determining and
Thickness Profile Imaging
8 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
9 Probe Delay MEASURE Probe Delay setting to be equal to Probe delay may be
actual probe delay determined according to
paragraph 5.2.13.7 or
5.2.13.9 of this Operating
Manual or similarly
10 | Angle MEASURE Angle = 0°
11 | Meas Mode MEASURE Flank
12 | Range, Display BASIC Range, Display Delay, AStart, and
Delay, AStart, GATE A aWidth settings to be performed with
aWidth reference to the Region of Interest for
t-BScan(Th) and BScan(Th) table
below
13 | Settings for other

parameters and
modes have no
significance

I
Upon completing click on J or press LJ on front panel keyboard or on external keyboard
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Region of Interest for t-BScan(Th) and BScan(Th)

. Scanning Surface

Surface to ROI Distance = SRD

ROl = Region of Interest

ROl Width = R
E;Ek Wall Profile
Initial
Pulze
SRD = aStart
Case 1
—_— RW = aWidth
0
Display Range
" Delay
Initial DisplavDel
ISplaybela .
Pulse SRD = %xUSVelocny
Case 2
-1 RW = aStart + awidth — SRD
0
Dizplay Range
" Delay
Initial
Pulse SRD = aSta.rt
DisplayDelay .
Case 3 L RW = — 5, xUSVelocity +
0 —
| Display Range + Range — aStart
" Delay
Initial
Pulze
DisplayDela .
SRD = 2iplayoelay USVelocity
Case 4 2
0 RW = Range
Display Range
" Delay
Preferred Initial ¢ aStart and aWidth setting to provide
embodimen Pulse 1t back echo appearance of whole Gate A on the A-Scan
t ¢ aWidth =(0.75...0.95) x Range
¢ First Back Echo at the thickest area of object
under test to be fully matching with Gate A
0 — ¢ First Back Echo at the thickest area of object
Display Range under test to "occupy” 5-10% of the Gate A
" Delay width on the A-Scan
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6.3.2. Thickness Profile Imaging — Implementation

6.3.2.1. t-BScan(Th) — Prior to Scanning

t-BScan(Th) control panel is shown below

Time, sec

Current A-Scan

Start

10
Time-0Out, sec
3
4 =]

e

= By

BT &

p

Save

2y,

2

upDS3-6

L

l

Text

Close

D=12.5 mm

Dm = H

163mm

3

Empty t-BScan(Th) record field

Gate

End 50

Scan Length / Scan Time

®

100

Display Delay and Range settings for current A-Scan to be used for the recording are equivalent to the

same setting of UDS 3-6 Pulser Receiver predcessing entering into t-BScan(Th) mode
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Scan Length and Scan Time

Scan Length — L represents length of section of test object to be displayed, over which probe will be
scanning during recording period. Time (Scan Time) is the duration of recording period

To control Scan Length — L the following ,
manipulations are applicable: /7 7

VR
yd
e Mouse /Touch Screen /s

—t
B Click on corresponding |button|

e Keyboard
-
m Press 1! J on front panel keyboard or on external keyboard = L fore color changes to white -
then use !J '_’J , _J !J on front panel keyboard or , , , on external keyboard

e Combined

B Click on L = L fore color changes to white - then use !J '_’J :J !J on front panel
keyboard or , , , on external keyboard

®

The value of Scan Length — L is adjustable between 50 and 1000 mm or 2 and 40 in
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: Current value of
: Scan Time —Time

|r.ul|.\ i By | 1= By

To control Scan Time — Time

the following manipulations are applicable:/ /, “
7
e Mouse /Touch Screen ,//
/4
B Click on corresponding
e Keyboard
F
m  Press _2 J on front panel keyboard or on external keyboard = Time fore color changes to
white - then use !» !/ « ! on front panel keyboard or [T} , , on external
keyboard

e Combined

B Click on Time = Time fore color changes to white - then use !» » « !

—J _/ on front panel
keyboard or , , on external keyboard

®

The value of Scan Time — Time is adjustable between 5 and 60 sec in 1 sec increment/decrement
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Time-out

Time-Out is waiting time for intermissions predcessing t-BScan(Th) recording, which starts unconditionally
upon Time-Out period is over

lllllllllllllllllllllllllll 1 L' mm
: Currentvalue of : 100 ‘
: Time-Out 3 Time, sec
1 sec :
b ’ 10 ‘
Time-Out, sec
3
7
. 7
To control Time-out 7 _ -

the following manipulations are applicable: P /’ -

z -
Mouse / Touch Screen P

B Click on corresponding Jbutton

Keyboard

?
B Press 3 J on front panel keyboard or on external keyboard = Time-out fore color changes

to white - then use !_ 2/, « ! on front panel keyboard or , , , on external
keyboard

Combined

LIRS NG I P

B Click on Time-Out = Time-Out fore color changes to white - then use —/,

front panel keyboard or , , , on external keyboard

®

The value of Time-Out is adjustable between 0 and 15 sec in 1 sec increment/decrements
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Insert Text Note

A text note may be entered to accompany t-BScan(Th) record. To proceed click on il or press
<Alt>+<X> on external keyboard

5 L. mm o
100 ‘ 1 »
Time, sec o
0 SJEL 2
. -
a D
=
| e Open
-t | -t Cloze
PITLI | Dm = ##
f Enter
Del BS
Save Cancel \
T' 50 100

Type notes and comments to accompany scanning files: use either virtual keyboard appeared (touch screen
or mouse) or external keyboard

Save
Click on to store typed note and to return to t-BScan(Th) control panel
Cancel g
Click on or press L) on front panel keyboard or on external keyboard to

negate typed note and to return to t-BScan(Th) control panel
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Preview UDS 3-6 Settings

UDS 3-6 Pulser Receiver settings for the t-BScan(Th) record may be previewed through clicking on

UD536 | or pressing <Alt>+<D> on external keyboard . The corresponding window appears:

= 5 L. mm
IIII-IIIII-—l n ‘

UDS3-6: Setup Daka

o,
4

TUDS3-6: Setup Data

BASIC: PULSER
Gain= 47 dB Fange = 23 mm Pulser Mode = DIJAL
Reject=0 % Display Delay = 795 ps PREF = 230 Hz
113 Velocity = 6127 mfs Firing Lewvel =2
GATE A: RECEIVER:
afwitch = OH a-Jtart = 2.4 mm Filter = 3-6 MHz Digplay = Full
a-Threshold = 21 % a-Width= 132 nun
GATE B: ALARM:
bwitch = OFF b-Start = 177 tmm adwritch = ON al.ogic = Hegative
b-Threshold = 20 % b-Width = 3.1 mm blwitch = O bLogic = Negative
DAC/TCGDGS: MEASTRE:
Mode: Update Fee=10 Probe Delay= 2535 ps Angle=0°
Curve = O hleasuring hode = Flank
N %
0K
1] o I B 100

| //
ESC
or press L) on front panel keyboard or <Alt>+<K> or on external keyboard to return to

return to t-BScan(Th) control panel
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Start/Stop t-BScan(Th) recording

4
Click on ﬂl or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard to

start t-BScan(Th) recording

4 | H |
stait | putton becomes invisible since t-BScan(Th) recording starts. __28P | putton occupies its

position. Click on stop | or press LJ on front panel keyboard or or <Alt>+<S> on external
keyboard to terminate t-BScan(Th) recording prior to automatic completion

= EA
stop | putton becomes invisible after completion / termination of t-BScan(Th) record. __ 3%t | putton

returns to its position

Save record into afile

Click on _38¥8 |or press ﬂ) on front panel keyboard or or <Alt>+<A> on external keyboard to
save captured t-BScan(Th) record accompanied with instrument calibration dump and text notes /
comments into a file. Refer to paragraph 5.2.17 of this Operating Manual to proceed with file saving

Open record from a file and starting postprocessing session

= | =
| &
Click on _Open | or press &) on front panel keyboard or or <Alt>+<0O> on external keyboard t-B-

Scan(Th) record accompanied with instrument calibration dump and text notes / comments from a file. Refer
to paragraph 5.2.18 of this Operating Manual to proceed with file opening. Refer to paragraph 6.3.2.5 of this
Operating Manual to proceed with postprocessing

Return to UDS 3-6 main operating surface

ESC
Click on __Elose |or press L) on front panel keyboard or <Alt>+<C> or on external keyboard
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6.3.2.2. t-BScan(Th) — Scanning
Q Apply probe to test object in the start point of selected scanning line

4

o Click on 3%t |or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard
O Guide probe over the scanning line synchronously with Recording Progress Bar — typical scanning

progress display during is shown and explained below
5 L. mm
100

Time, sec

34

Current A-Scan .

+ + +

Time-Out, zec
3

D=1324 mm

t-BScan(Th) record
Back Wall Profile

100

Recording Currently
Progress Bar measured wall
thickness
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6.3.2.3. BScan(Th) — Prior to Scanning
BScan(Th) control panel is shown below

5 L. mm r
100 ‘ 1 .
Encoder:
4 = =
Start Open Save Cloze
Text UDS53-6
14.2 mm Dm = ##

Empty BScan(Th) record field

| 50
Total Scan Length for L 1000 mm /40 in

¢ P
)41 L ]
g
=

BScan(Th) scrolling controls
20 L. mm ‘ - . %
2270 1
E Empty BScan(Th) record field
500 200 200 a0 1000 1100 1200 1300 1400 1500
1000 mm / 40 in Segment of Scrolled Total Scan Length exceeding 1000 mm /40 in

®

Display Delay and Range settings for current A-Scan to be used for the recording are equivalent to the
same setting of UDS 3-6 Pulser Receiver predcessing entering into BScan(Th) mode
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Scan Length

Scan Length — L represents length of section of test object to be displayed, over which probe will be
scanning during recording period

To control Scan Length — L the following P 7 i
manipulations are applicable: , -

s .-
e Mouse /Touch Screen 44 -

B Click on corresponding
e Keyboard

-
m Press 1 J on front panel keyboard or on external keyboard = L fore color changes to white -

then use !J '_’J , _J !J on front panel keyboard or , , , on external keyboard

e Combined

B Click on L = L fore color changes to white - then use !J '_’J :J !J on front panel
keyboard or , , , on external keyboard

®

The value of Scan Length — L is adjustable between 50 and 20000 mm or 2 and 800 in

Encoder
Select encoder to be used through appropriate box

Encoder:

Drefauilt j

Clamp probe into encoder — refer to Chapter 7 of this Operating Manual

Connect encoder to its input on the rear panel of ISONIC 2008 instrument

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-6 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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Start/Stop BScan(Th) recording

4
Click on ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard to

start BScan(Th) recording

4 | u |
stait | hutton becomes invisible since BScan(Th) recording starts. _ 3B | button occupies its position.

-5
Click on _3%P_ | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate BScan(Th) recording

H 4

stop | putton becomes invisible after termination of BScan(Th) record. __2tamt | putton returns to its
position

Save record into afile

= |
Click on _38¥€ |or press ﬂ) on front panel keyboard or or <Alt>+<A> on external keyboard to

save captured BScan(Th) record accompanied with instrument calibration dump and text notes / comments
into a file. Refer to paragraph 5.2.17 of this Operating Manual to proceed with file saving

Open record from a file and starting postprocessing session

= | =
| &
Click on _Open | or press &j on front panel keyboard or or <Alt>+<0O> on external keyboard B-

Scan(Th) record accompanied with instrument calibration dump and text notes / comments from a file. Refer
to paragraph 5.2.18 of this Operating Manual to proceed with file opening. Refer to paragraph 6.3.2.5 of this
Operating Manual to proceed with postprocessing

Return to UDS 3-6 main operating surface

ESC
Click on __Elose |or press L) on front panel keyboard or <Alt>+<C> or on external keyboard
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6.3.2.4. BScan(Th) — Scanning

a Apply probe equipped with an encoder to test object in the start point of selected scanning line

4
O Click on 3%t |or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard

O Guide probe over the scanning line — typical scanning progress display is shown and explained below

5 L. mm r
b10 ‘ 1 .
.
+ Encoder:

+ + + |

+ + + i ‘

D=1254mm | L=333.0mm

|

BScan(Th) record
Back Wall Profile Currently
measured wall

thickness

0 100 200 300 400 500

Current Probe
Position
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6.3.2.5. t-BScan(Th) / BScan(Th) — Postprocessing
Postprocessing of t-BScan(Th) / BScan(Th) records is featured with:

Q Sizing thickness damages at any location along stored images (remaining thickness, thickness loss,

and length of damage)

Q Play-back and evaluation of A-Scans obtained and captured during thickness profile recording
@ Reconstruction of thickness profile image for various Gain and / or Gate A settings

The screen as below appears upon opening file. All postprocessing procedures are performed through
— touch screen stylus or front panel or external mouse to be used

~

| File: v|| Instrument || E dit v|| Measurements v|| A-Scan Recovery v|

£

18 3 mm

30 100 150 200

=

~Inspection Data— [ Thickness Measurements —

5Scan Length: 210 mm |
Encoder Mame: Default I I

Inspector’s Coments: ~Length Measurements

A
ol |

—A-5can Recovery

BScan (Th) |
POSTPROCESSING | |

Menu Bar Functions

File=>Open — opens new t-BScan(Th) / BScan(Th) file

File>Snapshots>Add Snapshot — stores current postprocessing screen snapshot accompanied with
appropriate settings and measurements into postprocessing session memory stack

File>Snapshots>Restore Snapshot — recalls earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

File>Snapshots>Delete Snapshot — deletes earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

File=>Print — prints out postprocessing screen snapshot(s) accompanied with appropriate settings and
measurements

File>EXit — returns to t-BScan(Th) / BScan(Th) control panel

Instrument — indicates setup of UDS 3-6 Pulser Receiver used for scanning when file was created
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A-Scan Recovery>ON — generates cursor representing sound path of probe's central beam in the
object under test that may be guided over t-BScan(Th) / BScan(Th) image using either touch screen

-»

stylus or mouse or ' _—/, ‘ on front panel keyboard or , on external keyboard — corresponding
A-Scan is recovered synchronously according to sound path cursor position. In the A-Scan Recovery

field there are indicated coordinate (L) of sound path cursor along t-BScan(Th) / BScan(Th) record and
corresponding remaining thickness value (D)

| File: v|| Instrurment || Edit v|| Meazurements v|| A-Scan Recoverny v|

d

12 Jnm

=

0 110 150 200

~Inspection Data—— [ Thickness Measurements —

Scan Length: 210 mm I
Encoder Name: Default | |

| o+ o+ o 4+ 4+

Inspector’s Coments: ~Length Measurements
iy
ol |
—A-Scan Recovery
BScan (Th) | L-99.9mm
POSTPROCESSING | D =85 mm

To fix position of sound path cursor with corresponding recovered A-Scan and remaining thickness

Ente'r
value left mouse click or release touch screen stylus or press *=_/ on front panel keyboard or [Enter
on external keyboard

ESC
To interrupt recovery of A-Scans and empty A-Scan Recovery field right mouse click or press L‘\
on front panel keyboard or on external keyboard

A-Scan Recovery=>OFF — erases sound path cursor, switches off recovered A-Scan, and empties A-
Scan Recovery field
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e Edit>Change Gain>0N — generates cursor representing sound path of probe's central beam in the
object under test that may be guided over t-BScan(Th) / BScan(Th) image using either touch screen

stylus or mouse or !/ f on front panel keyboard or , on external keyboard — corresponding

A-Scan is recovered synchronously according to cursor position. To select reference A-Scan release
Ente.r |

touch screen stylus or left mouse click or press ' *=_ on front panel keyboard or [Enter| on external

keyboard — this generates subwindow allowing off-line re-adjusting of Gain for all A-Scans captured

during t-BScan(Th) / BScan(Th) recording in £6dB range with £0.1 dB increments through clicking or

A
pressing and holding on ' or pressing .!/ !. on front panel keyboard or , on external
keyboard

ISONIC 2008

Select Gain Change:

+1.8 dB ﬂ

] 4 Cancel

During Gain re-adjusting reference A-Scan is modified accordingly. Upon completing re-adjusting Gain click

DK Ente.! |
on or press *=_ on front panel keyboard or [Enter| on external keyboard — this applies new

Gain value to all captured A-Scans and redraws t-BScan(Th) / BScan(Th) image accordingly

Cancel Eas
To interrupt re-adjusting of Gain click on 4| or press L) on front panel keyboard or on

external keyboard

Edit>Change Gain>OFF — negates Gain re-adjustment and returns to originally recorded t-BScan(Th) /
BScan(Th) image and original Gain setting
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Edit>ROI=>0ON - generates cursor representing sound path of probe's central beam in the object under

test that may be guided over t-BScan(Th) / BScan(Th) image using either touch screen stylus or mouse
r ? ‘ on front panel keyboard or , on external keyboard — corresponding A-Scan is

recovered synchronously according to cursor position. To select reference A-Scan release touch screen

FnTEr

stylus or left mouse click or press ' *=_/ on front panel keyboard or [Enter|on external keyboard — this

generates off-line Gate A controls n n n u m m allowing to redefine Region Of

Interest for t-BScan(Th) / BScan(Th) imaging

| File v|| Instrument || Edit v|| Measurements v|| A-Scan Recovery =

£

1% 3 mm

cinspectionData——— | - hickness Measurements —

Scan Length: 210 mm I
Encoder Name: Default I I

Inspector’s Coments: rLength Measurements

A
iRl |

=h-Scan Becoveny

BScan (Th) |
POSTPROCESSING | |

+ o+
+ o+
+ o+
+ o+
+ o+
+ o+
+ o+
+ o+
+ o+

Upon completing redefining of Region Of Interest click on — this applies new Gate A to all
captured A-Scans and updates t-BScan(Th) / BScan(Th) image accordingly

ESC
To interrupt selection of reference of A-Scan right mouse click or press L‘\ on front panel keyboard

or on external keyboard

To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on

Edit2>ROI=>0OFF — negates Gate A re-adjustment and returns to originally recorded t-BScan(Th) /
BScan(Th) image and original Gate A setting
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Edit>Flip Horizontal — reorders A-Scans captured during t-BScan(Th) / BScan(Th) recording in
reverse succession and redraws t-BScan(Th) / BScan(Th) image accordingly. This service function
may be useful for merging scans of neighboring sections of an object, which were scanned in opposite

direction due to access conditions, etc

| File v|| Instrument || Edit v|| Measurements v|| A-Scan Recovery v|

ROI 4
Change Gain ¥

~Inspection Data
Scan Length: 100 mm
Scan Time: 10 sec
Time-Out: 3 sec
Inspector's Coments:

B

|

t-BScan (Th)
POSTPROCESSING

~ Thickness Measurements —

~Length Measurements

—A-5can Recovery

®

| File v|| Instrument || Edit v|| Measurements v|| A-Scan Recovery -

E

Stimm

=

~Inspection Data
Scan Length: 100 mm
Scan Time: 10 sec
Time-Out: 3 sec
Ingpector's Coments:

[ |
||

t-BScan (Th)
POSTPROCESSING

~ Thickness Measurements —

~Length Measurements

—A-5can Recovery

100

Applying of Flip Horizontal function empties postprocessing session memory stack

ISONIC 2008 from Sonotron NDT - Operating Manual — Revision 1.06 - Page 146 of 316




Measurements=>Length->ON — generates first vertical cursor that may be guided over t-BScan(Th) /

BScan(Th) image using either touch screen stylus or mouse or ?/ « on front panel keyboard or
, on external keyboard . Coordinate of the first vertical cursor along t-BScan(Th) / BScan(Th)
image (Lg) is indicated in the Length Measurements field. To fix position of the first vertical cursor left

Ente'r
mouse click or release touch screen stylus or press + J on front panel keyboard or [Enter|on
external keyboard . To interrupt vertical cursor manipulations and empty Length Measurements field

ESC
right mouse click or press L) on front panel keyboard or on external keyboard
Second vertical cursor appears upon fixing first one, it may be manipulated by the same way. Coordinate
of the second vertical cursor along t-BScan(Th) / BScan(Th) image (Lr) is indicated in the Length
Measurements field along with parameter W = Lr — Lg. Parameter W represents length of defect
provided that vertical cursors are placed appropriately
Measurements=>Length->OFF — erases vertical cursors and empties Length Measurements field
Measurements=>Thickness=>ON — generates first horizontal cursor that may be guided over t-

Y |

BScan(Th) / BScan(Th) image using either touch screen or mouse or =, _—_ / on front panel
keyboard or , on external keyboard . Coordinate of the first horizontal cursor along t-BScan(Th) /

BScan(Th) image (Dg) is indicated in the Thickness Measurements field. To fix position of the first
Ente'r

horizontal cursor left mouse click or release touch screen stylus or press ' -*=_/ on front panel keyboard
or [Enter| on external keyboard . To interrupt horizontal cursor manipulations and empty Thickness

ESC
Measurements field right mouse click or press L) on front panel keyboard or on external
keyboard
Second horizontal cursor appears upon fixing first one, it may be manipulated by the same way.
Coordinate of the second horizontal cursor along t-BScan(Th) / BScan(Th) image (Dr) is indicated in
the Thickness Measurements field along with parameter H = Dr — Dg. Parameter H represents
thickness loss provided that horizontal cursors are placed appropriately

Measurements=>Thickness=>OFF — erases horizontal cursors and empties Thickness
Measurements field

| File v|| Instrurment || Edit v|| Meazurements v|| A-Scan Recavery v|

2

a0 100 150 200

-

123 nm

=

~Inspection Data—— [ Thickness Measurements —

Scan Length: 210 mm I H=53mm
Encoder Name: Default

| Dg=86mm | Dr=13.9mm

Inspector's Coments: ~Length Measurements

B

| W =57.1mm
|Lg=859mm | Lr=143 mm

H
—A-Scan Recovery

BScan (Th) |
POSTPROCESSING | ||
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6.4. B-Scan cross-sectional imaging and recording of defects
for longitudinal and shear wave inspection — t-ABIScan or

ABIScan
6.4.1. Setup Pulser Receiver for t-ABIScan or ABIScan Imaging and
Recording
. o l [2]t-ABIscan ‘ l [2]|ABIScan
UDS 3-6 Pulser Receiver screen appears upon clicking on or . The
following settings to be provided:
6.4.1.1. Straight Beam Probes
# | Parameter or Submenu Required Settings Note
Mode
1 Gain BASICS Gain setting to be performed according
to inspection procedure providing
required echo heights from defects to be
detected
2 DAC/TCG DAC/TCG DAC/TCG settings to meet requirements
of inspection procedure
3 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
4 Pulse Width, Firing PULSER Pulse Width and Firing Level settings To synchronize with Gain
Level to optimize signal to noise ratio setting procedure
5 Filter, Low Cut, and RECEIVER Filter and Low Cut and High Cut To synchronize with Gain
High Cut settings to match with probe's frequency | setting procedure
Frequencies to optimize signal to noise ratio
6 Display RECEIVER Display setting may be either Full, RF, The same Display mode to
PosHalf, or NegHalf be used for both Probe
Delay determining and t-
ABIScan / ABIScan
Recording
7 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
8 Probe Delay MEASURE Probe Delay setting to be equal to Probe delay may be
actual probe delay determined according to
paragraph 5.2.13.7 or
5.2.13.9 of this Operating
Manual or similarly
9 | Angle MEASURE Angle = 0°
10 | Settings for other
parameters and
modes have no
significance

I
Click on _| or press LJ on front panel keyboard or on external keyboard upon completing
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6.4.1.2. Angle Beam Probes

# | Parameter or Submenu Required Settings Note
Mode
1 Gain BASICS Gain setting to be performed according
to inspection procedure providing
required echo heights from defects to be
detected
2 DACI/TCG DAC/TCG DAC/TCG settings to meet requirements
of inspection procedure
3 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
4 Pulse Width, Firing PULSER Pulse Width and Firing Level settings To synchronize with Gain
Level to optimize signal to noise ratio setting procedure
5 Filter, Low Cut, and RECEIVER Filter and Low Cut and High Cut To synchronize with Gain
High Cut settings to match with probe's frequency | setting procedure
Frequencies to optimize signal to noise ratio
6 Display RECEIVER Display setting may be either Full, RF, The same Display mode to
PosHalf, or NegHalf be used for both Probe
Delay determining and t-
ABIScan / ABIScan
Recording
7 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
8 Probe Delay MEASURE Probe Delay setting to be equal to Probe delay may be
actual probe delay determined according to
paragraph 5.2.13.5 or
5.2.13.6 or 5.2.13.9 of this
Operating Manual or
similarly
9 Angle MEASURE Angle setting to be equal to actual
probe angle
10 | Settings for other
parameters and
modes have no
significance

I
Click on _| or press LJ on front panel keyboard or on external keyboard upon completing
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6.4.2. B-Scan Cross Sectional Imaging — Implementation

6.4.2.1. t-ABIScan — Prior to Scanning (Straight Beam Probes)

t-ABIScan control panel for straight beam probe is shown below

1 Thickness o Coloring
16 mm ‘ 1 » I Pseudo
v DRSS
0.5 2 Grayscale |
5 Length o | -
110 mm ‘ 3 » Thermal UDS3-6
1 Time o 3 = =
10 s ‘ 4 » Start | Open| Save Cloze
tABIScan || | 8-Apr-2008
] -50 -100
Empty t-ABIScan record field
< Scan Length not exceeding 600 mm or 24 in / Scan Time
20 Length o
1000 mm ‘ 3 »
0 -100 -Z00 -300 -400 -500 -600
Empty t-ABIScan record field
t-ABIScan scrolling controls -
4 I
Segment of Scrolled Total Scan Length exceeding 600 mm or 24 in / Scan Time
. g

®

Display Delay for current A-Scan to be used for the recording is equal to Probe Delay setting in

submenu MEASURE of UDS 3-6 Pulser Receiver predcessing entering into t-ABIScan mode
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Thickness

Thickness setting defines the region of interest starting from the scanning surface and automatic Range
setting for current A-Scan to be used for the recording: Range = Thickness. For objects whereas back echo
is feasible it may be useful to key in Thickness value slightly exceeding actual thickness of the object under
test — this will allow to record simultaneously defects signals and back echo itself. For the screenshot as
above the actual thickness of the test piece is 40 mm while the Thickness setting is 43 mm thanks to such
setting back echo is clearly resolved at the end of A-Scan

1 Thickness
43 mm

5 Length
200 mm

1 Fime

To control Thickness the following y;
manipulations are applicable: ///
e Mouse / Touch Screen ///

B Click on corresponding
e Keyboard

+
m Press 1! J on front panel keyboard or on external keyboard = Thickness fore color changes

to white - then use !J 2) :J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Thickness = Thickness fore color changes to white - then use !J '_’J !J !J on
front panel keyboard or , , , on external keyboard

®

The value of Thickness is adjustable between 5 and 300 mm or 0.2 and 12 in (expandable on special
inquire)

Skip #

This setting is ignored while using straight beam probes
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Scan Length and Scan Time

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period. Time (Scan Time) is the duration of recording period

1 Thickness

43 inm

=y

I By

3b ‘
oo K

-\

3
r
4
To control Length the following , . 7
manipulations are applicable: P
,.7
7
e Mouse /Touch Screen 4

B Click on corresponding
e Keyboard

Fd
B Press 3 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J '_’J _J 4 on front panel keyboard or , =, k=, U on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J '_’J !J ij on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 1000 mm or 2 and 40 in
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1 Thickrdess
43 mim

5 Length
209 mm

To control Time
: . . _ -,
the following manipulations are applicable: 7 -

e Mouse /Touch Screen ¢ -’
B Click on corresponding
e Keyboard

-
m Press _4 j on front panel keyboard or on external keyboard = Time fore color changes to

white - then use !J '_’J _J 4 on front panel keyboard or , =, k=, U on external

keyboard

e Combined

B Click on Time = Time fore color changes to white - then use !J '_’J !J ij on front panel
keyboard or , , on external keyboard

®

The value of Time is adjustable between 5 and 60 sec

Time-out

Time-Out is waiting time for intermissions predcessing ABIScan recording, which starts unconditionally
upon Time-Out period is over. Time-Out has fixed duration of 3 sec for t-ABIScan

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-6 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual

ISONIC 2008 from Sonotron NDT - Operating Manual — Revision 1.06 - Page 153 of 316



t-ABIScan Record Palette

There are four palettes available through click on appropriate button:

— Coloring

Pseudo

Pzeudo? I

Grayscale I

Thermal I

Start/Stop t-ABIScan recording

4
Click on ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard to

start t-ABIScan recording

4 |
ﬂ' button becomes invisible since t-ABIScan recording starts. ﬂ' button occupies its position.

-3 e
Click on _3%p | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate t-ABIScan recording prior to automatic completion

= | 2.
stop | putton becomes invisible after completion / termination of t-ABIScan record. __ 3%’ | putton

returns to its position

Save record into afile

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-6 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.4.2.2. t-ABIScan — Scanning (Straight Beam Probes)

a Apply probe to test object in the start point of selected scanning line

4
a Clickon ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe over the scanning line synchronously with Probe Icon moving with constant speed above t-

ABIScan record field — typical scanning progress display during is shown and explained below

+

o BT
+ +H o+ o+ o+ o+

L A

o, ay ro

1 Thickness ar r Coluriy
16 mm ‘ 1 » | Fseudo
i
* 0.5 2 Grayzcale |
* 5 Length o | o
d 110 mm ‘ 3 » Thermal _UDS36 |
T 1 Time ar [ a H
+__ y 10 s ‘ 4 » Stop | Dpen| Save| Cloze
tABIScan | Scanning... L=49.47 mm | 8-Apr-2008

t-ABIScan record

A

Current Probe
Position
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6.4.2.3. ABIScan — Prior to Scanning (Straight Beam Probes)
ABIScan control panel for straight beam probe is shown below

1 Thickness o ~Coloring—————

16 mm ‘ 1 I Pseudo
5 o |
. 0.5 Grayscale |
* 5 Length - : | >
+ ermal

-kt Encoder: } = =
IDefauIt j [% Start | Open| Save | Cloze
| 8-Apr-2008
i e 100

Empty ABIScan record field

Scan Length not exceeding 600 mm or 12 in

R

u] -2I|:II:I 400 -EIIIII:I -BIIIII:I -1E=EII:I

Empty ABIScan record field

p] ABIScan scrolling controls field Y

< Segment of Scrolled Total Scan Length exceeding 600 mm or 12 in q

®

Display Delay for current A-Scan to be used for the recording is equal to Probe Delay setting in
submenu MEASURE of UDS 3-6 Pulser Receiver predcessing entering into ABIScan mode
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Thickness

Thickness setting defines the region of interest starting from the scanning surface and automatic Range
setting for current A-Scan to be used for the recording: Range = Thickness. For objects whereas back echo
is feasible it may be useful to key in Thickness value slightly exceeding actual thickness of the object under
test — this will allow to record simultaneously defects signals and back echo itself. For the screenshot as
above the actual thickness of the test piece is 40 mm while the Thickness setting is 43 mm thanks to such
setting back echo is clearly resolved at the end of A-Scan

1 Thickness
43 mm

5 Length ~
e
To control Thickness the following /7 7
manipulations are applicable: //
e Mouse / Touch Screen &

B Click on corresponding
e Keyboard

-
B Press 1 J on front panel keyboard or on external keyboard = Thickness fore color changes

to white - then use !J _J _J !J on front panel keyboard or , , , on external

keyboard
e Combined

,!J, !JOI’]

B Click on Thickness = Thickness fore color changes to white - then use !J '_’J
front panel keyboard or , , , on external keyboard

®

The value of Thickness is adjustable between 5 and 300 mm or 0.2 and 12 in (expandable on special
inquire)

Skip #

This setting is ignored while using straight beam probes
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Scan Length

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period

1 Thickness

=y

43 inm

3b
~ -~ 5 Length
200 mm
V4
4 s

LR

P

g
To control Length the following
manipulations are applicable: 7
// -
e Mouse /Touch Screen P %
&
B Click on corresponding
e Keyboard

-
B Press 3 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J '_’J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J '_’J :J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 20000 mm or 2 and 800 in

Encoder
Select encoder to be used through appropriate box

Encoder:

I Drefauilt j

Clamp probe into encoder — refer to Chapter 7 of this Operating Manual
Connect encoder to its input on the rear panel of ISONIC 2008 instrument

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-6 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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ABIScan Record Palette

There are four palettes available through click on appropriate button:

— Coloring

Pseudo

Pzeudo? I

Grayscale I

Thermal I

Start/Stop ABIScan recording

4
Click on ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard to

start ABIScan recording

4 |
ﬂ' button becomes invisible since ABIScan recording starts. ﬂ' button occupies its position.

- S
Click on _3%p | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate ABIScan recording

- KA
stop | putton becomes invisible after termination of ABIScan record. _ 3tait | putton returns to its

position

Save record into afile

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-6 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.4.2.4. ABIScan — Scanning (Straight Beam Probes)

a Apply probe equipped with an encoder to test object in the start point of selected scanning line

..o
O Click on 3t |or press _J on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe over the scanning line — typical scanning progress display during is shown and explained

below
1 Thickness ~ Coloring
Current A-Scan
o+ 16 mm I Pzeudo
+ + o+ _
et 0.5 Grayscale |
S 5 Length = : | -
Fod o+ erma
o 125 mm ‘ UDS3-6
+ o+ o+ Encoder: a E
+ N IDefauIt Open| Save| Close
ABIScan | Scanning... L=104.00 mm | 8-Apr-2008
50 100

- —— -_ ﬁi—-—ﬂil I

Current Probe

ABIScan record Position
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6.4.2.5. t-ABIScan — Prior to Scanning (Angle Beam Probes)
t-ABIScan control panel for angle beam probe is shown below

1 Thickness ) Coloring
40 mm ‘ 1 | Pseudo
Skiplt Pseudo? | Tem
Y €

+

+ o+

+f+ + ¥+ o+

»
» o
»
»

+
+
+
+
+ —t
+ +
_t
+
+

5 Length o Th | | i
80 mm ‘ 3 emne UDS3-6
- 1 Time ar 3 = [
_ 105 ‘ 4 Start | Open| Save | Close
tABIScan 8-Apr-2008
50 0 -50
>
Full Scan Length / Scan Time
For Total Length of t-ABIScan Record
Not Exceeding 600 mm or 24 in
Empty ABIScan record field
< >
Total Length of t-ABIScan Record
[} Not Exceeding 600 mm or 24 in
5 Length o
640 mm ‘ 3 »

-1I|:IIII -2I|:II:I -SIIIIIII -400 -5I|:II:I -EIIZII:I

Empty ABIScan record

ABIScan scrolling controls field

Segment of Scrolled Total Scan Length / Scan Time and t-ABIScan Record For Total
Length of ABIScan Record Exceeding 600 mm or 24 in

®

O Display Delay for current A-Scan to be used for the recording is equal to Probe Delay setting in submenu
MEASURE of UDS 3-6 Pulser Receiver predcessing entering into t-ABIScan mode

O Total Length of t-ABIScan Record is determined automatically according to:
Total Length of t-ABIScan Record = Total Scan Length + 2 * Skip # * Thickness * Tan (Angle)
whereas
¢ Thickness, Skip #, and Total Scan Length = Length are the settings of t-ABIScan control panel

¢ Angle is setting in submenu MEASURE of UDS 3-6 Pulser Receiver predcessing entering into t-
ABIScan mode
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Thickness and Skip #

Thickness and Skip # settings define the region of interest starting from the scanning surface and automatic
Range setting for current A-Scan to be used for the recording:

Range =2 x Skip # x Thickness x Cos (Angle)
whereas
¢ Thickness and Skip # are the settings of t-ABIScan control panel
¢ Angle is setting in submenu MEASURE of UDS 3-6 Pulser Receiver predcessing entering into
t-ABIScan mode

For objects with parallel surfaces the actual Thickness value to be entered for full skip inspection (Skip # =
1)

5 Thickness
40 mm

5 Length
80 mm

To control Thickness the following /7
manipulations are applicable: ///
e Mouse /Touch Screen /,/

B Click on corresponding
e Keyboard

-
m Press 1 J on front panel keyboard or on external keyboard = Thickness fore color changes

to white - then use !J '_’J _J ¥ on front panel keyboard or [f, 53}, [, U on external

keyboard

e Combined

B Click on Thickness = Thickness fore color changes to white - then use !J '_’J :J ij on
front panel keyboard or , , , on external keyboard

®

The value of Thickness is adjustable between 5 and 300 mm or 0.2 and 12 in (expandable on special
inquire)
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To control Skip # the following
manipulations are applicable:

Skip # 3

oy 1o B[ |1y

Mouse / Touch Screen

B Click on corresponding Jjbutton

Keyboard

-
m Press _2 J on front panel keyboard or on external keyboard = Skip # fore color changes to

white - then use !_ ?/ . ! on front panel keyboard or , , , on external
keyboard

Combined

LY

B Click on Skip # = Skip # fore color changes to white - then use =/,

panel keyboard or , , , on external keyboard

2 & &

®

The Skip # setting may be 0.5 — half skip insonification or 1 — full skip insonification
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Scan Length and Scan Time

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period. Time (Scan Time) is the duration of recording period

5 Thickness
40 mm

=y

I By

3b ‘
J oo &

-\

3
r
4
To control Length the following , . 7
manipulations are applicable: P
,.7
7
e Mouse /Touch Screen 4

B Click on corresponding
e Keyboard

Fd
B Press 3 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J '_’J _J 4 on front panel keyboard or , =, k=, U on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J '_’J !J ij on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 1000 mm or 2 and 40 in
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1 Thickrdess
43 mim

5 Length
209 mm

To control Time
: . . _ -,
the following manipulations are applicable: 7 -

e Mouse /Touch Screen ¢ -’
B Click on corresponding
e Keyboard

-
m Press _4 j on front panel keyboard or on external keyboard = Time fore color changes to

white - then use !J '_’J _J 4 on front panel keyboard or , =, k=, U on external

keyboard

e Combined

B Click on Time = Time fore color changes to white - then use !J '_’J !J ij on front panel
keyboard or , , on external keyboard

®

The value of Time is adjustable between 5 and 60 sec

Time-out

Time-Out is waiting time for intermissions predcessing ABIScan recording, which starts unconditionally
upon Time-Out period is over. Time-Out has fixed duration of 3 sec for t-ABIScan

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-6 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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t-ABIScan Record Palette

There are four palettes available through click on appropriate button:

— Coloring

Pseudo

Pzeudo? I

Grayscale I

Thermal I

Start/Stop t-ABIScan recording

4
Click on ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard to

start t-ABIScan recording

4 |
ﬂ' button becomes invisible since t-ABIScan recording starts. ﬂ' button occupies its position.

-3 e
Click on _3%p | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate t-ABIScan recording prior to automatic completion

= | 2.
stop | putton becomes invisible after completion / termination of t-ABIScan record. __ 3%’ | putton

returns to its position

Save record into afile

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-6 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.4.2.6. t-ABIScan — Scanning (Angle Beam Probes)

a Apply probe to test object in the start point of selected scanning line

4
a Clickon ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe over the scanning line synchronously with Probe Icon moving with constant speed above t-

ABIScan record field — typical scanning progress display during is shown and explained below

Current A-Scan

o

+
+
+
+
+
+

+
+
+

o+ o+ +0F o T+

I I T

1 Thickness o  Loloring

+ A0 mm ‘ 1 » I Pzeudo

+ -

L S

N 0.5 ‘ Grayscale |

* 5 Length ) | o

— 80 mm ‘ 3 » Thermal UDS3-6

+ 1 Time ) - E

. —— 10s ‘ 1 » Open| Save Cloze
tABIScan | Scanning... L=31.08 mm | 8-Apr-2008

Current Probe
Position

t-ABIScan record
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6.4.2.7. ABIScan — Prior to Scanning (Angle Beam Probes)
ABIScan control panel for angle beam probe is shown below

1 Thickness i Coloring
30 mm ‘ 1 » | Pseudo

+
: B « —— [
* Grayzcale |
¥ 5 Length o = : | b
+ 4
Vi 160 mm ‘ 3 » ermna UDS3-6
+ Encoder: ’ = E
__ _ | J Start | Open| Save Cloze
ABlScan g-Apr-2008
Full Scan Length
For Total Length of ABIScan Record

’4 Not Exceeding 600 mm or 24 in »‘

100 &0 0 -50 100 150

Empty ABIScan record field

Total Length of ABIScan Record
Not Exceeding 600 mm or 24 in

5 Length -
640 mm ‘ 3
-1I|:IEI -2I|:II:I -SIIIIEI -0 -EIIIIEI -BIIZII:I

»

Empty ABIScan record
ABIScan scrolling controls field

>

Segment of Scrolled Total Scan Length and ABIScan Record For Total Length of ABIScan
Record Exceeding 600 mm or 24 in

®

O Display Delay for current A-Scan to be used for the recording is equal to Probe Delay setting in submenu
MEASURE of UDS 3-6 Pulser Receiver predcessing entering into ABIScan mode

O Total Length of ABIScan Record is determined automatically according to:
Total Length of ABIScan Record = Total Scan Length + 2 * Skip # * Thickness * Tan (Angle)
where
¢ Thickness, Skip #, and Total Scan Length = Length are the settings of ABIScan control panel

¢ Angle is setting in submenu MEASURE of UDS 3-6 Pulser Receiver predcessing entering into
ABIScan mode
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Thickness and Skip #

Thickness and Skip # settings define the region of interest starting from the scanning surface and automatic
Range setting for current A-Scan to be used for the recording:

Range =2 x Skip # x Thickness x Cos (Angle)
whereas

¢ Thickness and Skip # are the settings of ABIScan control panel

¢ Angle is setting in submenu MEASURE of UDS 3-6 Pulser Receiver predcessing entering into
ABIScan mode

For objects with parallel surfaces the actual Thickness value to be entered for full skip inspection (Skip # =
1)

1 Thickness

40 mm

5 Length
160 mm

To control Thickness the following /7 7
manipulations are applicable:

e Mouse / Touch Screen 4

B Click on corresponding
e Keyboard

-
B Press 1 J on front panel keyboard or on external keyboard = Thickness fore color changes

to white - then use !J '_’J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Thickness = Thickness fore color changes to white - then use !J '_’J !J !J on
front panel keyboard or , , , on external keyboard

®

The value of Thickness is adjustable between 5 and 300 mm or 0.2 and 12 in (expandable on special
inquire)
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Skip # o~

1 Thickness
40 mm ‘

5 Length
R «

To control Skip # the following
manipulations are applicable:

e Mouse / Touch Screen

B Click on corresponding

e Keyboard
F
B Press _2 J on front panel keyboard or on external keyboard = Skip # fore color changes to

white - then use !_ =, « ! on front panel keyboard or [T} , , on external
keyboard

e Combined
B Click on Skip # = Skip # fore color changes to white - then use !_
panel keyboard or , , , on external keyboard

2 = =

~/ on front

®

The Skip # setting may be 0.5 — half skip insonification or 1 — full skip insonification
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Scan Length

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period

1 Thickness

=y

40 inm

1
~ -~ 5 Length
160 mm
V4
4 s

LR

P

g
To control Length the following
manipulations are applicable: 7
// -
e Mouse /Touch Screen P %
&
B Click on corresponding
e Keyboard

-
B Press 3 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J '_’J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 1000 mm or 2 and 40 in

Encoder
Select encoder to be used through appropriate box

Encoder:

Drefault j

Clamp probe into encoder — refer to Chapter 7 of this Operating Manual
Connect encoder to its input on the rear panel of ISONIC 2008 instrument

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-6 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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ABIScan Record Palette

There are four palettes available through click on appropriate button:

— Coloring

Pseudo

Pzeudo? I

Grayscale I

Thermal I

Start/Stop t-ABIScan recording

4
Click on ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard to

start ABIScan recording

4 |
ﬂ' button becomes invisible since ABIScan recording starts. ﬂ' button occupies its position.

-3 e
Click on _3%p | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate ABIScan recording prior to automatic completion

- KA
stop | putton becomes invisible after termination of ABIScan record. _ 3tait | putton returns to its

position

Save record into afile

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-6 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.4.2.8. ABIScan — Scanning (Angle Beam Probes)

a

m Current A-Scan

Apply probe equipped with an encoder to test object in the start point of selected scanning line

..o
Click on __Start | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard

Guide probe over the scanning line — typical scanning progress display during is shown and explained
below

— Coloring

» I Pzeudo
» Pzeudo? | Text
Grayscale |

somm

Bl <
5L h

BT ¢

I~ By

+k 4 et +

Iz

o
S 3 Thermal UDS3-6
+ Encoder: o E
b L bimiams asbiatetstes i I RS [~ open| Save| Close
S M M|
ABlScan | Scanning... L=46.00 mm | 8-Apr-2008
Current Probe
Position
100 EFI I:II 100 150
e
s

ABIScan record
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6.4.2.9. t-ABIScan / ABIScan — Postprocessing
Versatile postprocessing of t-ABIScan / ABIScan records is featured with:

Q Sizing defects at any location along stored images (coordinates, projection size, amplitude-based
evaluation)

Q Play-back and evaluation of A-Scans obtained and captured during t-ABIScan / ABIScan defects
imaging and recording

a Defects outlining and pattern recognition based on A-Scan sequence analysis — Echo Dynamic
Pattern Analysis

O Reconstruction of B-Scan defects images for various Gain, Reject, and off-line Gate level settings

o DAC/DGSt-ABIScan / ABIScan normalization

The screen as below appears upon opening file. All postprocessing procedures are performed through
— touch screen stylus or front panel or external mouse to be used

—_—
*File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

— Length Measurements

t-ABIScan |
POSTPROCESSING | | | |

—Depth Measurements

|' Filtering: I
|
| |
IVA-Scan Recovery
|

Menu Bar Functions

e File>Open - opens new t-ABIScan / ABIScan file
e File>Snapshots>Add Snapshot — stores current postprocessing screen snapshot accompanied with
appropriate settings and measurements into postprocessing session memory stack

e File>Snapshots>Restore Snapshot — recalls earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

e File>Snapshots>Delete Snapshot — deletes earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

e File=>Print — prints out postprocessing screen snapshot(s) accompanied with appropriate settings and
measurements
e File=>Exit — returns to t-ABIScan / ABIScan control panel

e View-—2>Instrument — indicates setup of UDS 3-6 Pulser Receiver used for scanning when file was
created

e View-=2Inspection Data — indicates operator's comments entered prior to scanning
e View—>Coloring — selects palette for t-ABIScan / ABIScan image
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A-Scan Recovery 20N (straight beam inspection record) — generates cursor representing sound path
of straight beam probe's central beam in the object under test that may be guided over t-ABIScan /

ABIScan image using either touch screen stylus or mouse or ?/ « on front panel keyboard or ,
on external keyboard — corresponding A-Scan is recovered synchronously according to sound path
cursor position. Starting position of cursor (L) corresponding to probe's center is indicated in the A-Scan
Recovery field. On the recovered A-Scan there is red Off-line Gate presented. Initially Off-line Gate
covers whole A-Scan range

| File v|| Wiew v|| E dit v|| I easurements v|| A-Scan Recovery v|

— Length Measurements

t-ABIScan |
POSTPROCESSING | ||

— Depth Measurements
" Filtering: I
|
| |

"A—S can Recovery

I I I I
E S e
I I I I

L =262 mm b 00%

-_—

|Automatic Measurements Display| accompanies recovered A-Scan and indicates (refer to
paragraphs 5.1.12, 5.2.13.1 and 5.2.13.2 of this Operating Manual):

o deptht of reflector (measurement mode - Flank)
o amplitude H of the maximal signal in the Off-line Gate expressed in % of full A-Scan height

o AVC (dB to DAC) of the maximal signal in the Off-line Gate provided that DAC was active
whilst recording t-ABIScan / ABIScan data

To fix position of sound path cursor with corresponding recovered A-Scan and Automatic

"
Enter

Measurements Display data left mouse click or release touch screen stylus or press ' *=_ on front
panel keyboard or [Enter| on external keyboard

ESC
To interrupt recovery of A-Scans and empty A-Scan Recovery field right mouse click or press L)
on front panel keyboard or on external keyboard

A-Scan Recovery>OFF (straight beam inspection record) — erases sound path cursor with recovered
A-Scan and Automatic Measurements Display and empties A-Scan Recovery field
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A-Scan Recovery 20N (angle beam inspection record) — generates cursor representing sound path of
angle beam probe's central beam in the object under test that may be guided over t-ABIScan / ABIScan

image using either touch screen stylus or mouse or 2/, « on front panel keyboard or , on
external keyboard — corresponding A-Scan is recovered synchronously according to sound path cursor
position. Starting position of cursor (L) corresponding to probe's incidence point is indicated in the A-

Scan Recovery field. On the recovered A-Scan there is red Off-line Gate presented. Initially Off-line
Gate covers whole A-Scan range

| File v|| Wiew v|| E dit v|| I easurements v|| A-Scan Recovery v|

— Length Measurements

ABIScan l
POSTPROCESSING | ||

— Depth Measurements
" Filtering: I
|
| |

A-5can Recovery
ﬁ L=-244mm

=

T T I
R e

t=0.2mm a=03mm
H=200% AVC=92dB

|Automatic Measurements Display| accompanies recovered A-Scan and indicates (refer to
paragraphs 5.1.12, 5.2.13.1 and 5.2.13.2 of this Operating Manual):

o deptht of reflector (measurement mode - Flank)

o0 distance a between probe incidence point and reflector taken along scanning surface
(measurement mode - Flank)

o amplitude H of the maximal signal in the Off-line Gate expressed in % of full A-Scan height

o AVC (dB to DAC) of the maximal signal in the Off-line Gate provided that DAC was active
whilst recording t-ABIScan / ABIScan data

To fix position of sound path cursor with corresponding recovered A-Scan and Automatic

"
Enter

Measurements Display data left mouse click or release touch screen stylus or press ' *=_/ on front
panel keyboard or [Enter| on external keyboard

ESC
To interrupt recovery of A-Scans and empty A-Scan Recovery field right mouse click or press L‘\
on front panel keyboard or on external keyboard

A-Scan Recovery=>OFF (angle beam inspection record) — erases sound path cursor with recovered A-
Scan and Automatic Measurements Display and empties A-Scan Recovery field
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Edit>Change Gain>0ON — (straight beam and angle beam inspection records) generates cursor
representing sound path of probe's central beam in the object under test that may be guided over t-

ABIScan / ABIScan image using either touch screen stylus or mouse or !/ f on front panel
keyboard or , on external keyboard — corresponding A-Scan is recovered synchronously
according to sound path cursor position. To select reference A-Scan release touch screen stylus or left

[
Enter

mouse click or press + J on front panel keyboard or on external keyboard - this generates
subwindow allowing off-line re-adjusting of Gain for all A-Scans captured during t-ABIScan / ABIScan

recording in £6dB range with £0.1 dB increments through clicking or pressing and holding on ﬁ or

r §

pressing —~, _~_/ on front panel keyboard or , on external keyboard

ISONIC 2008

Select Gain Change:

+1.8 dB ﬂ

0K Cancel

During Gain re-adjusting reference A-Scan is modified accordingly. Upon completing re-adjusting Gain

DK Ente.! |
click on or press *=_J on front panel keyboard or on external keyboard — this

applies new Gain value to all captured A-Scans and redraws t-ABIScan / ABIScan image accordingly

Cancel | eae
To interrupt re-adjusting of Gain click on or press LJ on front panel keyboard or

on external keyboard

Edit>Change Gain=>OFF — negates Gain re-adjustment and returns to originally recorded t-ABIScan /
ABIScan image and original Gain setting
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Edit>ROI=>ON (straight beam inspection record) — generates cursor representing sound path of
straight beam probe's central beam in the object under test that may be guided over t-ABIScan /

ABIScan image using either touch screen stylus or mouse or 2/, « on front panel keyboard or ,
on external keyboard — corresponding A-Scan is recovered synchronously according to sound path
cursor position. To select reference A-Scan release touch screen stylus or left mouse click or press

Enter
_/ on front panel keyboard or [Enter|on external keyboard — this generates Off-line Gate controls

n n n n H n allowing to redefine Region Of Interest for t-ABIScan / ABIScan

imaging

| File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery -

— Length Measurements

ABIScan |
POSTPROCESSING | |

— Depth Measurements

Filtering: I
| |
IVA-Scan Recovery

|

To interrupt selection of reference of A-Scan right mouse click or press L) on front panel keyboard

or on external keyboard

To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on
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Upon completing redefining of Region Of Interest click on — this applies new Off-line Gate to all
captured A-Scans and updates t-ABIScan / ABIScan image accordingly — only segment of t-ABIScan /
ABIScan image covered by newly adjusted Off-line Gate remains visible

| File v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|

— Length Measurements

ABIScan l
POSTPROCESSING | | /

— Depth Measurements

Filtering: I
’—A—S can Recovery
|

It is possible then to perform A-Scan signals evaluation using newly adjusted Off-Line Gate through A-
Scan Recovery >ON

| File: v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|
a -50 100
== e e e s I |
- e e — e e n
- pr—— e —
—Length Measurements
ABIScan | .
POSTPROCESSING | N
— Depth Measurements +
Filtering: *
’7| I +
| | N
4
A-S5can Recovery N - +N
ﬁ L = E0.8 mm t=16.2mm H=76% i

o Edit>ROI>OFF (straight beam inspection record) — negates Off-line Gate re-adjustment and returns
to originally recorded t-ABIScan / ABIScan image and initial Off-line Gate setting

ISONIC 2008 from Sonotron NDT - Operating Manual — Revision 1.06 - Page 179 of 316



Edit2>ROI=>0ON (angle beam inspection record) — generates cursor representing sound path of angle
beam probe's central beam in the object under test that may be guided over t-ABIScan / ABIScan

image using either touch screen stylus or mouse or ?/ « on front panel keyboard or , on
external keyboard — corresponding A-Scan is recovered synchronously according to sound path cursor

"
Enter

position. To select reference A-Scan release touch screen stylus or left mouse click or press ' *=_ on

front panel keyboard or Enter on external keyboard - this generates Off-line Gate controls

n n u u n allowing to redefine Region Of Interest for t-ABIScan / ABIScan

imaging

| File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery -

— Length Measurements

t-ABIScan |
POSTPROCESSING | ||

— Depth Measurements

Filtering: I
| |
IVA-Scan Recovery

|

ESC
To interrupt selection of reference of A-Scan right mouse click or press L) on front panel keyboard

or on external keyboard

. . . . . >
To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on .
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Upon completing redefining of Region Of Interest click on — this applies new Off-line Gate to all
A-Scans captured during t-ABIScan / ABIScan recording and updates t-ABIScan / ABIScan image
accordingly — only segment of t-ABIScan / ABIScan image covered by newly adjusted Off-line Gate
remains visible: in the present example there was under surface crack detected using full skip
insonification and Off-line Gate was readjusted by such a way that only full skip segment of t-ABIScan /
ABIScan image remained visible — this allowed to eliminate disturbing presence of initial pulse
reverberations on the t-ABIScan / ABIScan image

| File v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|
g o
=
R T . il =
— Length Measurements
t-ABIScan |
POSTPROCESSING | |
— Depth Measurements
Filtering: I
| |
’—A—Scan Recovery [%
|

It is possible then to perform A-Scan signals evaluation using newly adjusted Off-Line Gate through A-
Scan Recovery >ON

| File: v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|

—Length Measurements

t-ABIScan |
POSTPROCESSING | ||

— Depth Measurements

" Filtering: —‘ I
A-Scan Recovery t=3.8mm a = 36.2mm
ﬁ L =-55.2 mm

H=126% AVC=6.0dB
e Edit=>ROI2>OFF (angle beam inspection record) — negates Off-line Gate re-adjustment and returns to
originally recorded t-ABIScan / ABIScan image and initial Off-line Gate setting

N

I S et S I
!
)

SR R R T
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Edit>Filtering>ON — (straight beam and angle beam inspection records) generates amplitude palette
bar with sliding cursor, which may be controlled using either touch screen stylus or mouse or ' -/, f

on front panel keyboard or , on external keyboard . Position of the sliding cursor on the amplitude
palette bar determines filtering level, which is indicated in the Filtering field. All elements of t-ABIScan /
ABIScan image representing signal amplitude below filtering level are suppressed:

| File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

-50
|

— Length Measurements E

t-ABIScan |
POSTPROCESSING | | | |

—Depth Measurements

Filtering: I
ﬁ 6.6dB
| |
IVA-Scan Recovery
|

Edit>Filtering>OFF (straight beam and angle beam inspection records) — returns to originally
recorded t-ABIScan / ABIScan image and empties Filtering field
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e Edit>Normalize to DAC->ON (straight beam and angle beam inspection records) — applies DAC/DGS
normalized color palette to t-ABIScan / ABIScan image, which was recorded with active DAC/DGS and
redraws t-ABIScan / ABIScan image correspondingly (dB to DAC/DGS normalization)

| File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|
Change Gain 4
ROI 4
Filtering 4

Momalize to DAC M
= [F|

t-ABIScan
POSTPROCESSING

— Length Measurements

+

|' Filtering: —‘
A-S5can Recoverp
ﬁ L="57.2mm

—Depth Measurements

t=4.5mm
b6

H=

a=355mm

AVC=856dB

3,
T+ o+ N+t + 4
i \
++I+++4.
i + o+ o+ 4+
+ +f+ + + A+ o+
!

| File v|| Wigw v|| Edit v|| Measurements v|| A-Scan Recavery v|

Lo

— Length Measzurements

t-ABIScan |
POSTPROCESSING | | | |

— Depth Meazurements

Filtering:
[ '
| |
A-S5can Recoverp
|_| L=-57.2mm

e Edit=>Normalize to DAC->OFF (straight beam and angle beam inspection records) — negates dB to
DAC/DGS normalization and returns to originally recorded t-ABIScan / ABIScan image

®

Applying of Edit->Normalize to DAC->ON or Edit->Normalize to DAC->OFF negates Filtering
(Edit>Filtering>OFF)

N,
T+ + W+ o+ o+ o+
15 \
',

',

t=4.5mm a=355mm

H=166% AVC=38.6 dB
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Measurements=>Length->ON — generates first vertical cursor that may be guided over t-ABIScan /

ABIScan image using either touch screen stylus or mouse or ?/ « on front panel keyboard or ,

on external keyboard . Coordinate of the first vertical cursor along t-ABIScan / ABIScan image (Lr)

is indicated in the Length Measurements field. To fix position of the first vertical cursor left mouse click
Ente‘r

or release touch screen stylus or press + J on front panel keyboard or [Enter|on external keyboard .

To interrupt vertical cursor manipulations and empty Length Measurements field right mouse click or

ESC
press L) on front panel keyboard or on external keyboard
Second vertical cursor appears upon fixing first one, it may be manipulated by the same way. Coordinate
of the second vertical cursor along t-ABIScan / ABIScan image (Lg) is indicated in the Length
Measurements field along with parameter W = Lg — Lr. Parameter W represents projection length of
defect provided that vertical cursors are placed appropriately
Measurements=2>Length->OFF — erases vertical cursors and empties Length Measurements field
Measurements>Depth>ON — generates first horizontal cursor that may be guided over t-ABIScan /

Y |

ABIScan image using either touch screen or mouse or =/, _T_ / on front panel keyboard or , on

external keyboard . Coordinate of the first horizontal cursor along t-ABIScan / ABIScan image (Dr) is
indicated in the Depth Measurements field. To fix position of the first horizontal cursor left mouse click

"
Enter

or release touch screen stylus or press *=_/ on front panel keyboard or [Enter| on external keyboard .
To interrupt horizontal cursor manipulations and empty Depth Measurements field right mouse click or

ESC
press L) on front panel keyboard or on external keyboard
Second horizontal cursor appears upon fixing first one, it may be manipulated by the same way.
Coordinate of the second horizontal cursor along t-ABIScan / ABIScan image (Dg) is indicated in the

Depth Measurements field along with parameter H = Dg — Dr. Parameter H represents thickness
loss provided that horizontal cursors are placed appropriately

Measurements>Depth->OFF — erases horizontal cursors and empties Depth Measurements field

| File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

o
n
[=]

— Length Measurements

t-ABIScan [ w-z25mm
POSTPROCESSING | | [Li=-173mm [Lg=206mm

—Depth Measurements

|'Fi|lering: —‘ I H=4mm

I | Dr=0mm | Dg=4mm
A-Scan Recovery t=45mm a=355mm
{I L = 57.2 mm H=166% AVC-=8.6dB
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6.5. TOFD Inspection — RF B-Scan and D-Scan
Recording —t-TOFD or TOFD

6.5.1. Setup Pulser Receiver for t-TOFD and TOFD

[3]t-ToFD

Imaging and

UDS 3-6 Pulser Receiver screen appears upon clicking on l

following settings to be provided:
# | Parameter or Submenu Required Settings Note
Mode
1 Pulser Mode PULSER Dual
2 Pulse Width, Firing PULSER Pulse Width and Firing Level settings To synchronize with Gain
Level to optimize signal to noise ratio setting procedure
3 Filter, Low Cut, and RECEIVER Filter and Low Cut and High Cut To synchronize with Gain
High Cut settings to match with probe's frequency | setting procedure
Frequencies to optimize signal to noise ratio
4 Display RECEIVER RF
5 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
6 Probe Delay MEASURE Probe Delay setting to be equal to Accumulated Probe Pair
actual Accumulated Probe Pair Delay may be determined
Delay according to paragraph
6.5.1.1 of this Operating
Manual
7 Display Delay BASICS Display Delay and Range to provide Display Delay and Range
Range clear A-Scan representing: will be determined

o0 Lateral Wave and Longitudinal
Wave Back Echo Signals at the
beginning and at the and of A-Scan
correspondingly

OR

o Lateral Wave, Longitudinal Wave
Back Echo, and Mode Conversion
Back Echo at the beginning, middle,
and at the end of A-Scan
correspondingly

OR

o0 Other combination of signals

required by Inspection procedure

according to paragraph
6.5.1.2 of this Operating
Manual

8 Gain BASICS Gain setting to be performed according
to inspection procedure providing
required amplitude of signals from
defects to be detected

Refer to paragraph 6.5.1.3
of this Operating Manual

9 | Settings for other
parameters and
modes have no
significance

I

Click on or press LJ on front panel keyboard or on external keyboard upon completing
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6.5.1.1. Accumulated Probe Pair Delay

Two probes to be used in order to capture the TOFD Map. The Probe Delay to be precisely measured for
each of them.

Measuring Probe Delay - Miniature Probes (contact face width 12.5 mm / 0.5 in or less) — Pulse Echo
Technique

" Longitudinal Wave Echo Activate submenu PULSER then set:
+ + + + +

Q Pulser Mode to Single

O Pulse Width to 50 ns for probe having
resonant frequency of 10 MHz and higher
orto PW ns, were PW = 0.5/ F (F is the
probe resonant frequency) for probes
having resonant frequency below 10 MHz

Q Firing Level to 12

Activate submenu RECEIVER then set:

o Display to Full or RF

a Filter to OFF or ON

O Low Cut and High Cut to completely
cover probe's effective bandwidth on case
if Filter setting is ON

Activate submenu BASICS topic then set:

Q US Velocity to 5920 m/s (233.1 in/ms)

@ Rangeto50.0 mm (2in)

a Display Delay to 0 ps

QO Reject to 0%

Stage 1: Manipulate probe over main working
surface of V-2 reference standard and maximize
echo from 25 mm (1 in) radius concave reflector

Stage 2: Fix probe in found position - the center of
25 mm (1 in) radius concave reflector will indicate
incident point while the distance between probe's
frontal edge and incident point is equal to X-
Value

Stage 3: Tune Display Delay while probe is still
fixed in found position until rising edge of
maximized echo will match with 50%-grid of the A-
Scan width. Upon completing the obtained value
of Display Delay will be equal to actual Probe
Delay

Incidence
Foint

It's necessary to setup Gain bringing height of maximized echo to 75-80% of A-Scan height

Supposing that Probe Delay values found for probes of the pair are PD1 and PD»

Accumulated Probe Pair Delay = 0.5¢(PD; + PD5)
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Measuring Probe Delay - Large and Medium Size Probes (contact face width more than 12.5 mm /0.5
in) — Pulse Echo Technique

N N N N N Activate submenu PULSER then set:
Longitudinal Wawve Echo Q Pulser Mode

O Pulse Width to 50 ns for probe having
resonant frequency of 10 MHz and higher
or to PW ns, were PW = 0.5/ F (F is the
probe resonant frequency) for probes
having resonant frequency below 10 MHz

Q Firing Level to 12

Activate submenu RECEIVER then set:

a Display to Full or RF

O Filter to OFF or ON

O Low Cut and High Cut to completely
cover probe's effective bandwidth on case
if Filter setting is ON

Activate submenu BASICS topic then set:

O US Velocity to 5920 m/s (233.1 in/ms)

O Rangeto200.0 mm (8in)

O Display Delay to 0 ps

O Rejectto 0%

Stagel
— Incidence

o1t

Stage 1: Manipulate probe over main working
surface of V-1 reference standard and maximize
echo from 100 mm (4 in) radius concave reflector

Stage 2: Fix probe in found position - the center
of 100 mm (4 in) radius concave reflector will
indicate incident point while the distance
between probe's frontal edge and incident point
is equal to X-Value

B Stage 3: Tune Display Delay while probe is still

fixed in found position until rising edge of
maximized echo will match with 50%-grid of the
A-Scan width. Upon completing the obtained
value of Display Delay will be equal to actual
Probe Delay

Incidence
Foint

®

It's necessary to setup Gain bringing height of maximized echo to 75-80% of A-Scan height

Supposing that Probe Delay values found for probes of the pair are PD1 and PD»

Accumulated Probe Pair Delay = 0.5¢(PD; + PD>)
—
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Direct Measurement of Accumulated Probe Pair Delay - All Sizes of Probes — Through Transmission

Technique

Prake 1

Prohe 2

Proke 1

Probe 2

Activate submenu PULSER then set:

a Pulser Mode

Q Pulse Width to 50 ns for probe having
resonant frequency of 10 MHz and higher
orto PW ns, were PW = 0.5/ F (F is the
probe resonant frequency) for probes
having resonant frequency below 10 MHz

Q Firing Level to 12

Activate submenu RECEIVER then set:

0 Display to Full or RF

O Filter to OFF or ON

O Low Cut and High Cut to completely
cover probe's effective bandwidth on case
if Filter setting is ON

Activate submenu BASICS topic then set:
o Display Delay to 0 ps

Stage 1. Manipulate probes over each other and
setup of Gain, Range, and USVelocity providing
firm indication of the signal propagating in the
probes wedges from emitting to receiving crystal
then maximize said signal

Stage 2: Fix the probe in the found position
corresponding to highest signal amplitude

®

It's necessary to setup Gain bringing
height of maximized echo to 75-80% of
A-Scan height
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I Probe 1

Probe 2

Probe 2

UDS3-6 - ISONIC Pulser /Receiver

‘ , Channel 1

BASICS
GATE B

PULSER RECEIVER
ALARM DAC/TCG

B Volue: OFF |
Close EEH|

GATE A
MEASURE

Freeze

Stage 3: Increase Gain to provide height of first
half wave of received signal reaching 20 % of total
A-Scan height

Stage 4: Decrease Range to provide ~ 50% of
the A-Scan width occupied by the signal

Stage 5: Start increasing of Display Delay aiming
displacement of signal's start point to beginning of
A-Scan horizontal base

Stage 6: Stop Display Delay manipulation upon
reaching the target — at this moment value of
Display Delay will represent Accumulated Delay
of the Probes Pair

0.5 Gain

22 dB ‘
5 Ral
o K

5 US Velocity
h320 mils

0.01 Display Delay|
8.44 s
a neesL ‘

= Ty

o By

e By

= By

len By

0 %

N VDS 3-6

Selection

I AR
Save | Open | Print DES
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6.5.1.2. Display Delay and Range

Display Delay depends on Accumulated Probe Pair Delay, Probe Separation, and USVelocity:

Display Delay = Probe Delay + Probe Separation / USVelocity

whereas:

Q USVelocity is the actual value of longitudinal wave velocity in the material, of which the object

under test is made

Q Probe Separation is the distance between incidence points of the emitting and receiving TOFD probes

measured along the lateral wave trace:

Probe Separation

Emitting Receiving
Probe Frobe

Probe Separation should be optimized according to Inspection procedure and probes positions in the TOFD

-Lateral Wave

%————- Longitudinal Wave Back Echo

fixture to be fixed upon. Display Delay and Range to be adjusted then to provide representing of signals
according to Inspection procedure — the typical examples are given below for 40 mm thickness welded

plates.

UDS3-6 - ISONIC Pulser /Receiver

"l |Chﬂnnel 1

PULSER RECEIYER GATE & Henu

0.5

i b
p

645 dB

0.2

Range
13.4 mm

10 US Velocity
5920 mjs ‘
l] 01 Display Delay
26 94 ps ‘
FIE|et:t
«
3-‘

=y

LER 8

e By

= By

len By

hdh dh 4h 4h 4

AlLARM DAC/TCG MEASURE Selection
|_ Value: OFF g = & I
ﬁnarm Save | Open | Print QES
\ /
Lateral Wave Longitudinal Wave
Signal Back Echo
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UDS3-6 - ISONIC Pulser /Receiver
‘l'l Channel 1

Gain

64_5 dB

+

= Ty

Range

368mm ‘

Ino By

I by

et ) i 4 b “ 10 US Velocity
I"'“Hu”l |IIIIIII I.'I'||III e a"'l| ',,1| ‘
| ' ‘ 5920 m/s
0.01 Display Delay '

26.94 ps

[ By

L] Beject
0%

In by

p

ISl FPULSER RECEIMER  GATE A Menu
GATE H ALARM DAC/TOG  MEASURE  Selection

vUos 3-6

I_ Yalue: OFF & * = = Eh .
Close fularm I \ Freeze Save \Open | Pnnt DGS
\ \
\ \ \
Lateral Wave Longitudinal Wave Mode Conversion
Signal Back Echo Wave Back Echo
6.5.1.3. Gain

Depending on Inspection procedure (Inspection specs) Gain may be setup with the reference to:

Representative flaw sample

Artificial diffractors in the form of EDM notches or V-shaped notches
Side drilled holes

Grain noise

Lateral wave signhal amplitude

0O000oOo

For both examples above the typical procedure of Gain setting was provided through bringing height of
lateral wave signal to 30% of A-Scan height
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-~

—

6.5.1.4. Probe Separation

Probe Separation must be properly defined and ente
posprocessing stage. Most widely used way of Probe
distance between TOFD probes excitation points by u

red to have the ability of precise defects sizing at
Separation determining is mechanical measuring of
sing a scaled ruler. However mechanical

measurements are not accurate and their implementation becomes quite complicate for objects with curved

surfaces:
Emitting Receiving
Frobe Frobe

Receiving

Emitting cen
robe

Probe

| ateral Wave Trace

Lateral Wave ]"1".;7«::«3=

Probe Separation

Emitting
Probe

Lateral Wave Trace

Probe Separation

Probe Separation

Reaceaiving
Probe

Probe Separation may be defined more precisely through the way as below:

<| | Channel 1

BASICS PULSER
GATE B ALARM

;ll_l_

RECEIVER
DAC/TCG

[p 63 42 mm

Freeze

UDS3-6 - ISONIC Pulser/Receiyer

GATE A
MEASURE

Gain

i 7748 laa
et +
Bl «
i«

p

= &y

Mo By

It By

= By

Angle

Itn by

=M 2| VDS 3-6

Selection

A AR
Save | Open | Pnnt DGES

O

Scan height

Provide rising edge of first half wave of lateral
Define Probe Separation as Probe Separati

from [Value] box

7
e

OoDOo

r
-

-

ISONIC 2008 from Sonotron NDT - Operating Manual

Increase Gain to provide height of first half wave of lateral wave signal reaching 10-20 % of total A-

Activate Gate A, setup aThreshold to 5%(submenu GATE A)
Select s(A) as Meas Value and set Meas Mode as Flank (submenu MEASURE)

wave will cross Gate A
on = 2 x s(A) whereas s(A) is the digital readout taken
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6.5.2. t-TOFD and TOFD — Implementation
6.5.2.1. t-TOFD — Prior to Scanning

t-TOFD control panel is shown below

+
+

=

Current A Scan

+ o+

2129 4

F|+ + + + + o+
| #"—"af‘*'v"-qf"a‘--wrﬂ-il |

||||
+ o+

| 'I.|J

+
+

+

+ o+ +
+ o+ +
+ o+ +

20 Length
Bl «
1 Time

s K

10s
Time-'% ait

el +
i -
Rl +

Start

<

26,19 u

Scan Length not exceeding 400 mm or 16 in / Scan Time

Empty t-TOFD record field

o

@)

UD53-6

150 200

FoF o+ o+ £+ o+ o+
++++1E++++
++++-€++++

++++-|?-++++

++++4F_:++++
H

4
++++‘ﬁ'++++

20 Length rF
Eifle »
1 Time a
Bl «
Time-w ait rF
Belle »
1 Base g
Bires « {|»
Averaging a
EEdle »

= (=]
Slart Open Save
UD53-6 Text Close

519y

<

Segment of Scrolled Total Scan Length
exceeding 400 mm or 16 in / Scan Time >

t-TOFD scrolling controls field

Empty t-TOFD record field

(=]

T T T T T T
100 150 200 250 200 250

400
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Scan Length and Scan Time

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period. Time (Scan Time) is the duration of recording period

o

|Lu?. SRS

I+~ gy

len By

To control Length the following
manipulations are applicable:

e Mouse /Touch Screen
B Click on corresponding
o Keyboard

-
B Press 1 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J '_’J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 1000 mm or 2 and 40 in

ISONIC 2008 from Sonotron NDT - Operating Manual — Revision 1.06 - Page 194 of 316



5 Lerigth
220 mm

Averaging

OFF

To control Time
the following manipulations are applicabIE}://

/4
e Mouse / Touch Screen V/4

B Click on corresponding
e Keyboard

'l
s Press LJ on front panel keyboard or on external keyboard = Time fore color changes to

white - then use !J _J _J ij on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Time = Time fore color changes to white - then use !J '_’J !J !J on front panel
keyboard or , , on external keyboard

®

The value of Time is adjustable between 5 and 60 sec
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Time-Wait

Time-Wait is waiting time for intermissions predcessing t-TOFD recording, which starts unconditionally upon
Time-Wait period is over

5 Length ar
220 mm ‘ 1 »
1 Time o
10s ‘ 2 »
A AR AR AR . Time-W ait o
: Currentvalueof i 3s 3
] Time-Out - ~ 7
] sec : 1 »
tsssssssssEssssEEEEEEEEEEEE - =
Averaging ar
OFF 5 »
/7 7/
To control Time-Wait the following ’, 7
manipulations are applicable: //
/
e Mouse /Touch Screen /,/

— -
B Click on corresponding |button|

e Keyboard

?
B Press 3 on front panel keyboard or on external keyboard = Time-Wait fore color changes

to white - then use !_ ?/ « !' on front panel keyboard or , , , on external
keyboard

e Combined

LINCIAIINS

B Click on Time-Wait = Time-Wait fore color changes to white - then use =/,

front panel keyboard or , , , on external keyboard

®

The value of Time-Wait is adjustable between 0 and 15 sec
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Base

Base represents Probe Separation

5 Length
220 mm

Time-' ait
35

b db 4

Averaging

|r.h},\|-ﬁ-l|. oo By f e By | (= By

A 4

To control Base the following
manipulations are applicable:

e Mouse /Touch Screen
B Click on corresponding
o Keyboard

-
B Press _4 J on front panel keyboard or on external keyboard — Base fore color changes to

white - then use !J '_’J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Base = Base fore color changes to white - then use !J '_’J !J !J on front panel
keyboard or , , , on external keyboard

®

The value of Base is adjustable between 25 and 500 mm or 1 and 20 in
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Averaging
Averaging of sequential A-Scans is required sometimes to improve signal to noise ratio of the t-TOFD

record
5 Length
220 mm ‘
1 Time
10s ‘
B . _ _
:  Current setting of Time-¥ ait ‘
: Averaging i 35
] mm or in ] 5 Base
T rireresserrrrrserees P
‘ <

Averaging

OFF

To control Averaging the following
manipulations are applicable:

e Mouse / Touch Screen

B Click on corresponding

e Keyboard
F
B Press _3 _ on front panel keyboard or on external keyboard = Averaging fore color changes

to white - then use !_ ?/ « !' on front panel keyboard or , , , on external
keyboard

e Combined

LINCIAAIARS

B Click on Averaging = Averaging fore color changes to white - then use =/,
front panel keyboard or , , , on external keyboard

®

Averaging may be either inactive (OFF) or setup for factor 2 or 4 or 8

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-6 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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Start/Stop t-TOFD recording

4
Click on ﬂl or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard to

start t-TOFD recording

4 | u |
stait | putton becomes invisible since t-TOFD recording starts. __ 2P | putton occupies its position.

-
Click on 3P | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate t-TOFD recording prior to automatic completion

= A
stop | button becomes invisible after completion / termination of t-TOFD record. __ 3%t | putton returns

to its position

Save record into afile

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-6 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.5.2.2. t-TOFD — Scanning

a Apply probes pair to test object in the start point of selected scanning line

4 | |
O Click on 3%t |or press LLJ on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe pair over the scanning line synchronously with Position Icon moving with constant speed
above t-TOFD record field — typical scanning progress display during is shown and explained below

20 Length o
L
1 Time o
LR
Time-W ait o
LR
1 Baze o
L
Averaging o
o
| = | @
..... Open Save
Text Cloze

150
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6.5.2.3. TOFD — Prior to Scanning
TOFD control panel is shown below

1 4
g
+ + 4+ by
+ il- + o+
1“".@""”}'!\'@“1".&‘]
+ o+
+ o+
+ 4+
+ 4+
20 Length o
220 mm ‘ 1
° Base = Scan Length not exceeding 400 mm or 16 in
100 mm ‘ 2 I g
A - <
veraging o
€
Encoder:
IDefauIt j ]
Empty TOFD record field
4 = =] 1
Start Open Save .
) ;
’ 0 50 100 150 200
UD53-6 Text Close
o

++++-\T++++
H
LR S
+ + +_+ o+ + + +
LR — s
+ o+ o+ A+ o+ o+
44+ T o+ 4+

20 Length
.

o+ o+ o+ 4+

+ o+ + o+
+ o+ o+ o+

5 Base
1oonm K

Averaging
.

oty |y
adh A 4

Encoder:

I Drefauilt j
[ 2 = =
Start Open Save

UDS53-6 Text Close

<

Segment of Scrolled Total Scan Length

TOFD scrolling controls field

Empty TOFD record field

exceeding 400 mm or 16.in

>

T T T T T
100 150 200 250 300

T
3450

400
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Scan Length

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period

20" Length
1540 mm

Averaging

OFF

To control Length the following
manipulations are applicable:

e Mouse /Touch Screen
B Click on corresponding

o Keyboard

-
B Press' 1 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J _J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J 2J :J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 20000 mm or 2 and 800 in
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Base

Base represents Probe Separation

20 Léngth
1540 mm

= By

=

[ l|“

To control Base the following
manipulations are applicable:

e Mouse /Touch Screen
B Click on corresponding

o Keyboard

-
B Press 2 J on front panel keyboard or on external keyboard = Base fore color changes to

white - then use !J 2J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Base = Base fore color changes to white - then use !J 2J :J !J on front panel
keyboard or , , , on external keyboard

®

The value of Base is adjustable between 25 and 500 mm or 1 and 20 in
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Averaging
Averaging of sequential A-Scans is required sometimes to improve signal to noise ratio of the TOFD record

AR AR A A A A A A A A anans . 20 Length
:  Current setting of & 1540 mm ‘ »
: :

Averaging
mm or in

Averaging

OFF

To control Averaging the following
manipulations are applicable:

e Mouse / Touch Screen

B Click on corresponding
e Keyboard
-

B Press 3 Jon front panel keyboard or on external keyboard = Averaging fore color changes
to white - then use !_ 2/, « ! on front panel keyboard or , , , on external
keyboard

e Combined
B Click on Averaging = Averaging fore color changes to white - then use !_ 2/, « , ! on

front panel keyboard or , , , on external keyboard

®

Averaging may be either inactive (OFF) or setup for factor 2 or 4 or 8

Encoder
Select encoder to be used through appropriate box

Encoder:

Drefault j

Clamp fixture holding TOFD probe pair into encoder — refer to Chapter 7 of this Operating Manual

Connect encoder to its input on the rear panel of ISONIC 2008 instrument

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-6 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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Start/Stop TOFD recording

4
Click on ﬂl or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard to

start TOFD recording

4 | H |
stait | hutton becomes invisible since TOFD recording starts. __ 3B | putton occupies its position. Click

-
on _ 3P | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate TOFD recording

N EA
atep | button becomes invisible after termination of TOFD record. __2tait | button returns to its position

Save record into afile

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-6 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.5.2.4. TOFD — Scanning

a Apply probes pair to test object in the start point of selected scanning line

4 | |
O Click on 3%t |or press [L on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe pair over the scanning line — typical scanning progress display during is shown and
explained below

20 Length o
220 mm ‘ 1
1 Base o
127 mm ‘ 2
Averaging o
OFF ‘ 3
Encoder:
IDefauIt
[ =
Open Save
15II:I ZEIIEI
Text Close
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6.5.2.5. t-TOFD / TOFD — Postprocessing
Versatile postprocessing of t-TOFD / TOFD records is featured with:

O Improvement of near to surface resolution through removal of lateral wave and back echo records
from t-TOFD / TOFD Map, zooming t-TOFD / TOFD Map accompanied with appropriate A-Scan
expanding

O Linearization and straightening of t-TOFD / TOFD Map

O Increasing contrast of t-TOFD / TOFD images through varying Gain and rectification

O Defects pattern recognition and sizing

The screen as below appears upon opening file. All postprocessing procedures are performed through
Imenu baFl — touch screen stylus or front panel or external mouse to be used

—
*File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-5can Recavery v|

t-TOFD
POSTPROCESSING

Menu Bar Functions

e File>Open — opens new t-TOFD / TOFD file

e File>Snapshots=>Add Snapshot — stores current postprocessing screen snapshot accompanied with
appropriate settings and measurements into postprocessing session memory stack

e File>Snapshots>Restore Snapshot — recalls earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

¢ File>Snapshots>Delete Snapshot — deletes earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

¢ File=>Print — prints out postprocessing screen snapshot(s) accompanied with appropriate settings and
measurements

e File>Exit — returns to t-TOFD / TOFD control panel

e View=2>Instrument — indicates setup of UDS 3-6 Pulser Receiver used for scanning when file was
created

e View—2>Inspection Data — indicates operator's comments entered prior to scanning

e View>TOFD Display=>Logic>Positive/View>TOFD Display=>Logic>Positive — defines which
polarity half wave is represented by white / black levels on the t-TOFD / TOFD image

e View>TOFD->Logic>Negative / View>TOFD->Logic2>Positive — selects black / white tones for
representation of positive/negative half waves components of RF A-Scan on the TOFD Map — refer also
to paragraph 9.2.4 of this Operating Manual

e View>TOFD—>Contrast->Natural / View>TOFD->Contrast->Soft / View>TOFD->Contrast->Sharp
— selects contrast of the TOFD Map - refer also to paragraph 9.2.4 of this Operating Manual
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A-Scan Recovery=>ON - generates cursor corresponding to A-Scan base line that may be guided over

t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J !J on front panel keyboard
or , on external keyboard — corresponding A-Scan is recovered synchronously according to A-

Scan base line cursor position. Indication of starting position of cursor (L) corresponding to the position
of TOFD probes pair accompanies recovered A-Scan

File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|

L=73.7 mm

t-TOFD
POSTPROCESSING

To fix position of A-Scan base line cursor with corresponding recovered A-Scan left mouse click or
Erlte.r
release touch screen stylus or press .“ij on front panel keyboard or Enter|on external keyboard

ESC
To interrupt recovery of A-Scans right mouse click or press \L) on front panel keyboard or on
external keyboard

A-Scan Recovery=>OFF - erases A-Scan base line cursor, indicator of its position, and recovered A-
Scan
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View—>Coloring2>Rectified — switches between rectified and RF presentation of t-TOFD / TOFD image

File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|

Colaring m Grayzcale

Zoam ¥ Themnal

Inspection Data
R

Instrument

oL _——

POSTPROCESSING 50 100 150 200 280

File v|| Wig v|| Farameters v|| Edit v|| Measurements v|| A-Scan Recovery

L=737 mm

22.09 ps

t-TOFD
POSTPROCESSING
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e View>Zoom->Zoom Factor% — expands t-TOFD / TOFD image along time line (vertically)

File v|| Wigw v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recoverny v|

Calaring » |
Zoom =100%
Inspection Data 200%
Instrumnent

t-TOFD
POSTPROCESSING 0 50 100 150 200 250 300 350
File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery -
L=2781 mm

t-TOFD
POSTPROCESSING

Expanded t-TOFD / TOFD image may be scrolled it vertically using appropriate
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Green background highlights segment of recovered A-Scan corresponding to visible part of t-TOFD /
TOFD image. Said segment moves over recovered A-Scan background while scrolling t-TOFD / TOFD

image vertically

File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|
L=2781 mm
Start of visible
part of t-TOFD /
TOFD image

F — — — — —
End of visible part
of t-TOFD / TOFD

I image |

t-TOFD .
POSTPROCESSING | ° s a0 e

P —
200 250 200 250

Segment of recovered A-Scan corresponding to visible part of t-TOFD / TOFD image may be expanded
through double click on it — whole A-Scan background is green for the expanded segment. Vertical
scrolling of t-TOFD / TOFD image causes appropriate varying of Display Delay for recovered A-Scan
File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|

L=2781 mm

Start of visible :
part of t-TOFD /

I TOFD image |

e S U —

F — — — — —
End of visible part
of t-TOFD / TOFD

I image |

t-TOFD
POSTPROCESSING | ° s

150

To return to complete recovered A-Scan visibility double click on A-Scan area

®

¢ Zoom function is available for t-TOFD / TOFD image composed of A-Scans longer

than 5 us
¢ Possible zoom factors are defined by ISONIC 2008 software automatically

¢ Maximal possible Zoom factor is 400%
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e Parameters>Change... — allows re-adjusting of basic parameters (USVelocity, Base, Probe Delay)
for computation of defects depth and linearization of t-TOFD / TOFD image

File v|| Wigw v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recoverny v|

L = 23| Change..
Mark Zero

t-TOFD
POSTPROCESSING

File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery -
L=2781 mm

US Yelocity, mis

1
5020 Ol

Base, mm

1
131 Ol

Probe Delay, ps 0.01

r—
592 ﬂ
ok |

t-TOFD
POSTPROCESSING

| Erlte.r
On completing click LI or press :J on front panel keyboard or [Enter| on external

keyboard

To negate re-adjustments click on ﬂl or press \L) on front panel keyboard or on

external keyboard
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Parameters>Mark Zero Line — allows re-adjusting of Probe Delay for computation of defects depth
and linearization of t-TOFD / TOFD image through mark of start point of lateral wave signal on the
recorded t-TOFD / TOFD image with reference to recovered A-Scan. Initially this function generates
cursor corresponding to A-Scan base line that may be guided over t-TOFD / TOFD image using either

touch screen stylus or mouse or '_’J , !J on front panel keyboard or , on external keyboard —
corresponding A-Scan is recovered synchronously according to A-Scan base line cursor position

File =|| “iew =[| Parameters «|| Edit = | Measurements v|| A-Scan Recovery v|

Upon selecting reference A-
Scan with clear lateral wave
left mouse click or press
| Erlte.r

= J on front panel
keyboard or on
external keyboard — this
generates horizontal cursor,
which may be be guided over

t-TOFD / TOFD image using
either touch screen stylus or

mouse or !J !Jon front

panel keyboard or , on
external keyboard

t-TOFD
POSTPROCESSING

o

a0 100 180 200 2480 =00 260

File =|| “iew =[| Parameters «|| Edit = | Measurements v|| A-Scan Recovery -

To mark the beginning of

lateral wave signal

corresponding to zero depth

left mouse click or press
Erlte.r

- *==4 J on front panel

keyboard or on

external keyboard

22.04 ps

To interrupt function at any
moment right mouse click or

ESC
press \Q on front panel

keyboard or on
external keyboard

t-TOFD
POSTPROCESSING

2515 ps

=1

S0 100 150 200 250 200 250
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o Edit>Linearization=>0ON - recalculates depth for each point of t-TOFD / TOFD image and redraws it
as Longitudinal Coordinate — Depth map

| File v|| Wiga v|| Farameters v|| E dit v|| I easurements v|| A-Scan Recovery v|

Linearization OW
= 0F|

Femove Lateral Wave »

Straightening 4
Change Gain 4

Flip Honzontal

2447 ps

t-TOFD

| File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recoverny v|

280 300 350

t-TOFD
POSTPROCESSING

o Edit>Linearization>OFF — returns to original t-TOFD / TOFD image - Longitudinal Coordinate —
Time map
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Edit>Remove Lateral Wave>ON — removes rectangle segment designated by an operator from t-
TOFD / TOFD image. Most frequently this function is applied to lateral wave record, which is recorded
continuously during line scanning and allows to better resolve defects located closely to scanning
surface. Also this function may be applied to other signals continuously recorded during line scanning for
example, backwall echo, mode conversion backwall echo, etc. - this allows to better resolve defects
located closely to bottom surface. In addition to modifying of rectangle segment selected by an operator
this function automatically straightens t-TOFD / TOFD image in order to compensate deviations caused
by various factors during recording, for example, coupling instability, unevenness of scanning or bottom
surface, etc. The described function is based on selecting reference signal and defining a rectangle
segment on the t-TOFD / TOFD image. All signals corresponding to selected rectangle segment of t-
TOFD / TOFD image are equalized by straightening function and then removed; appropriate changes do
occur on t-TOFD / TOFD image above and under selected rectangle segment after its removal. Initially
cursor corresponding to A-Scan base line is generated; it may be guided over t-TOFD / TOFD image

using either touch screen stylus or mouse or '_’J :J on front panel keyboard or , on external
keyboard — corresponding A-Scan is recovered synchronously according to A-Scan base line cursor

E rlte.r

position. To select reference A-Scan left mouse click or release touch screen stylus or press - *=_ on
front panel keyboard or [Enter| on external keyboard

| File: v|| Wiew v|| Parameters v|| E dit v|| Measurements v| A-Scan Recovery v|

Linearization L4

| Remove Lateral Wave | 0N
Straightening F mOFF
Change G ain L4

Flip Horizontal

File =|| “iew =|| Parameters «|| Edit - | Measurements v|| A-Scan Recovery -

2204 ps

t-TOFD
POSTPROCESSII

2515 ps

t-TOFD
posTPn ocessl " G o a0 100 150 200 280 300 350
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First horizontal cursor appears on the t-TOFD / TOFD image upon selecting reference A-Scan. It may

be guided over t-TOFD / TOFD image using either touch screen stylus or mouse or !J !J on front
panel keyboard or , on external keyboard . To fix position of the first horizontal cursor and designate

L
Enter
start of reference signal left mouse click or release touch screen stylus or press _‘ij on front panel
keyboard or [Enter|on external keyboard . Second horizontal cursor appears upon fixing first one; it may
be manipulated by the same way and allows designating end of reference signal
View «|| Parameters - | Measurements 'H &-Scan Recovery v‘

View ~|| Parameters ~ | Measurements ][ A-5can Recovery ~

t-TOFD
POSTPROCESSIN

t-TOFD
POSTPROCESSING

®

Horizontal cursors are accompanied with appropriate time cursors moving over reference A-
Scan
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First vertical cursor appears upon designating end of reference signal. Its length corresponds to duration
of reference signal and it is located between first and second horizontal cursors. First vertical cursor may

be manipulated over t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J - on
front panel keyboard or , on external keyboard . To designate first border of rectangle segment

| Erlte.r
left mouse click or release touch screen stylus or press ij on front panel keyboard or [Enter|on
external keyboard . Second vertical cursor completing defining a rectangle appears upon fixing first one;
it may be manipulated by the same way and allows to designate second border of rectangle segment

View «|| Parameters - | Measurements 'H &-Scan Recovery v‘

Wiew =[] Parameters - ‘ Measurements 'H A:5can Recovery -
u

t-TOFD
POSTPROCESSII

t-TOFD
POSTPROCESSING
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As a result:
0 Signs of reference signal and corresponding signals in the selected rectangle segment are
removed from t-TOFD / TOFD image
o t-TOFD /TOFD image is straightened above and under selected and modified rectangle
segment to compensate deviations caused by various factors during recording, for example,
coupling instability, unevenness of scanning or bottom surfaces, etc

| File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|

t-TOFD
POSTPROCESSING

—
To interrupt function at any moment right mouse click or press m on front panel keyboard or
on external keyboard

Edit>Remove Lateral Wave->OFF — negates madification of selected rectangle segment of t-TOFD /
TOFD image
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Edit->Straightening=>ON - straightens t-TOFD / TOFD image in order to compensate deviations
caused by various factors during recording, for example, coupling instability, unevenness of scanning or
bottom surfaces, etc. It is based on selecting reference signal (either lateral wave, or backwall echo, or
mode conversion backwall echo, etc) and defining a rectangle segment on the t-TOFD / TOFD image.
All signals corresponding to selected rectangle segment of t-TOFD / TOFD image are equalized by
straightening function and appropriate changes do occur on t-TOFD / TOFD image above and under
modified rectangle segment. Initially cursor corresponding to A-Scan base line is generated; it may be

guided over t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J !J on front

panel keyboard or , on external keyboard — corresponding A-Scan is recovered synchronously
according to A-Scan base line cursor position. To select reference A-Scan left mouse click or release

Erlte.r
touch screen stylus or press _‘ij on front panel keyboard or [Enter| on external keyboard

| File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v| A-Scan Recovery v|

Linearization L4

Remove Lateral Wave #

Straightening ]
Change Gain LA R
Flip Horizontal

File =|| “iew -|| Parameters =f| Edit = | M easurements Y|| A-Scan Recovery -

2204 ps

t-TOFD
POSTPROCESSII

t-TOFD
PosTP“o CESSING o a0 100 150 200 280 300 350

2515 ps
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First horizontal cursor appears on the t-TOFD / TOFD image upon selecting reference A-Scan. It may

be guided over t-TOFD / TOFD image using either touch screen stylus or mouse or y !J on front
panel keyboard or , on external keyboard . To fix position of the first horizontal cursor and designate

L
Enter
start of reference signal left mouse click or release touch screen stylus or press :J on front panel

keyboard or [Enter|on external keyboard . Second horizontal cursor appears upon fixing first one; it may
be manipulated by the same way and allows to desighate end of reference signal

| File: v|| Wiew v|| Farameters v|| Edit v|| Meazurements v|| A-Scan Recoverny v|

File =|| Yiew =|| Parameters =[| Edit = | Measurements v|| A-Scan Recovery -

2204 ps

t-TOFD
POSTPROCESSI!

2515 ps

t-TOFD
POSTPROCESSING

a0 100 150 200 280 300 350

o

ISONIC 2008 from Sonotron NDT - Operating Manual — Revision 1.06 - Page 220 of 316



First vertical cursor appears upon designating end of reference signal. Its length corresponds to duration
of reference signal and it is located between first and second horizontal cursors. First vertical cursor may
be manipulated over t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J - on
front panel keyboard or , on external keyboard . To designate first border of rectangle segment

| Erlte.r
left mouse click or release touch screen stylus or press ij on front panel keyboard or [Enter|on

external keyboard . Second vertical cursor completing defining a rectangle appears upon fixing first one;
it may be manipulated by the same way and allows to designate second border of rectangle segment

| File: v|| Wiew v|| Farameters v|| Edit v|| Meazurements v|| A-Scan Recoverny v|

File =|| “iew =[| Parameters =|| Edit - | Measurements v|| A-Scan Recovery -

22.09 ps

t-TOFD
POSTPROCESSIP

2515 ps

t-TOFD
POSTPROCESSING

50 luls} 150 200 250 00 FE0

=1
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As aresult t-TOFD / TOFD image is straightened in, above, and under selected rectangle segment to
compensate deviations caused by various factors during recording, for example, coupling instability,
unevenness of scanning or bottom surfaces, etc

| File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery -

t-TOFD
POSTPROCESSING

Esc
To interrupt function at any moment right mouse click or press m on front panel keyboard or
on external keyboard

Edit->Straightening>OFF — negates modification of selected rectangle segment of t-TOFD / TOFD
image
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Edit>Change Gain=>0ON — generates cursor corresponding to A-Scan base line that may be guided

over t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J !J on front panel

keyboard or , on external keyboard — corresponding A-Scan is recovered synchronously
according to A-Scan base line cursor position. To select reference A-Scan release touch screen stylus

| Erlte.r
or left mouse click or press ' *=1_ on front panel keyboard or on external keyboard — this
generates subwindow allowing off-line re-adjusting of Gain for all A-Scans captured during t-TOFD /

ﬂ
TOFD recording in £6dB range with £0.1 dB increments through clicking or pressing and holding on ‘
or pressing !J !J on front panel keyboard or , on external keyboard

Filz v|| Wigw v|| Parameters v|| E dit v|| M easurements v|| A-Scan Recovery v|
L=1272 mm

ISONIC 2005

Select Gain Change:

“ioswe

OK Cancel |
L&

File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery -

L=1272 mm

t-TOFD
POSTPROCESSII

s

t-TOFD
POSTPROCESSING o 50 100 150 200 250 300 350

During Gain re-adjusting reference A-Scan is modified accordingly. Upon completing re-adjusting Gain

DK | Erlte.r
click on or press ij on front panel keyboard or on external keyboard — this

applies new Gain value to all captured A-Scans and redraws t-TOFD / TOFD image accordingly
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Cancel ﬂ esc !
To interrupt re-adjusting of Gain click on 4' or press ¥ _J on front panel keyboard or

on external keyboard

Edit>Change Gain>OFF — negates Gain re-adjustment and returns to originally recorded t-TOFD /
TOFD image and original Gain setting

Edit=>Flip Horizontal — reorders A-Scans captured during t-TOFD / TOFD recording in reverse
succession and redraws t-TOFD / TOFD image accordingly. This service function may be useful for
merging scans of neighboring sections of an object, which were scanned in opposite direction due to
access conditions, etc

| File v|| Wiew v|| Parameters v|| E dit v|| Measurements v| A-Scan Recovery v|

Linearization L4
Remove Lateral Wave ¥
Straightening 4
Change Gain »
Flip Horizon

3447 ps

t-TOFD
posrpnocessl "G o S0 100 180 200 2560 200 280

| File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|

t-TOFD
POSTPROCESSING

®

Applying of Flip Horizontal function empties postprocessing session memory stack
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Measurements>Add Measure>Height — generates cursor corresponding to A-Scan base line that

may be guided over t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J :J on
front panel keyboard or , on external keyboard — corresponding A-Scan is recovered
synchronously according to A-Scan base line cursor position. Indication of starting position of cursor (L)
corresponding to the position of TOFD probes pair accompanies recovered A-Scan. A-Scan base line
cursor to be positioned over defect image to minimize displacement of defect's signal with regard to
starting point of A-Scan. To fix position of A-Scan base line cursor release touch screen stylus or left

| Erlte.r
mouse click or press ' *=_J on front panel keyboard or on external keyboard . Indication of
starting position of cursor (L) corresponding to probe's center accompanies recovered A-Scan

| File v|| Wiga v|| Farameters v|| E dit v|| M easurements v|| A-Scan Recovery v|
Add Measure Length

Clear Lazt Heig
Clear Al

22.09 ps

File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery -

L=119.3 mm

t-TOFD
POSTPROCESSII

t-TOFD
POSTPROCESSING

50 400 150 200 250 200 250

=]
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First horizontal cursor appears upon fixing A-Scan base line cursor, it may be guided over t-TOFD /

TOFD image using either touch screen stylus or mouse or y !J on front panel keyboard or , on
external keyboard . First horizontal cursor is accompanied with first time cursor synchronously moving

over reference A-Scan. Coordinate of the first horizontal cursor - depth (H) and corresponding time of
flight (t) are indicated synchronously. To fix position of the first horizontal cursor left mouse click or

Erlte.r
release touch screen stylus or press :J on front panel keyboard or on external keyboard .
Second horizontal cursor appears upon fixing first one, it may be manipulated by the same way. Second
horizontal cursor is accompanied with second time cursor synchronously moving over reference A-
Scan. Coordinate of the second horizontal cursor measured relatively to position of first horizontal cursor

(dH) and corresponding delay of second time cursor relatively to first time cursor (dt) are indicated
synchronously. Provided the horizontal cursors are placed properly:

o H represents defect depth

o t represents time of flight for first diffracted signal

o dH represents defect's height

o dt represents delay of second diffracted signal relatively first diffracted signal

Filz v|| Wigw v|| Parameters v|| E dit v|| M easurements v|| A-Scan Recovery v|
L=119.3 mm
H =199 mm

2204 ps

t- 23.0 |Is

| File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recavery -
L=119.3 mm

H=199 mm | dH=4.1 mm

t=23.0 s dt=0.4ps

22.04 ps

t-TOFD
POSTPROCESSIE

t-TOFD
POSTPROCESSING o 50 100 150 200 250 200 250

28.26 ps

ESC
To interrupt width measurement procedure at any moment right mouse click or press @ on front
panel keyboard or on external keyboard
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Vertical |[depth/height measurement mark| appears on the t-TOFD / TOFD image upon fixing position of

second horizontal cursor \
| File v|| Wig v|| Parameters v|| E dit v|| Mea&ements v|| A-Scan Recovery v|

File =|| “iew =|| Parameters «|| Edit = | Measurements v|| A-Scan Recovery -

Point 1:
L=119.3 mm
— =23.04 5, dt=0.44 is
t-TOFD H=19.9 mm, dH=4.1 mm

POSTPROCESSII

t-TOFD
POSTPROCESSING o Y 100 150 200 250 300 350

Depth measurement results may be recalled into accompanied with corresponding A-Scan
through double click on the depth measurement mark

In the subwindow appearing:
o L is coordinate of depth measurement mark along scanning line
o H represents defect depth
o 1 represents time of flight for first diffracted signal
o dH represents defect's height
o dt represents delay of second diffracted signal relatively first diffracted signal

Clicking on = will print current screen snapshot accompanied with depth measurement mark data

Clicking on v will hide subwindow with depth measurement mark data

Clicking on X will hide subwindow with depth measurement mark data and erase corresponding
depth measurement mark
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Measurements>Add Measure>Length — generates left parabolic cursor that may be guided over t-

e using either touch screen stylus or mouse or !J ij '_’J !J on front panel

TOFD / TOFD imag

keyboard or , , , on external keyboard . A-Scan, corresponding to coordinate (L) of tip of left
parabolic cursor along scanning line is recovered synchronously. Left parabolic cursor to be placed over
left defect's end providing shape matching. To fix position of left parabolic cursor left mouse click or

| Erlte.r
release touch screen stylus or press ij on front panel keyboard or [Enter| on external keyboard

| File v|| Wig v|| Parameters v|| E dit v|| M easurements v|| A-Scan Recovery v|

| Add Measure | Length
Height

Clear Last
i| Clear Al

File v|| Wiew v|| Parameters v|| Edit v|| Meazurements v|| A-Scan Recovery v|
L=106.1 mm |

t-TOFD
POSTPROCESSII

t-TOFD
POSTPROCESSING

50 400 150 200 250 200 250

=]
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Right parabolic cursor appears upon fixing left parabolic cursor. It may be manipulated by the same way
and must be placed over right defect's end providing shape matching. Coordinate of right parabolic
cursor along t-TOFD / TOFD image measured relatively to position of left parabolic cursor (dL) is
indicated synchronously, it represents length of defect area provided that both parabolic cursors are

placed properly

| File v|| Wigw v|| Parameters v|| Edit v|| Meazurements v|| A-Scan Fecovery v|

|[L=106.1 mm | dL=43.9 mm

22.04 p=

2826 p=

t-TOFD
POSTPROCESSING | © S

180 200 2a0 200 280

ESC
To interrupt length measurement procedure at any moment right mouse click or press m on front
panel keyboard or on external keyboard
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Horizontal {length measurement mark{ appears on t-TOFD / TOFD image upon fixing position of right
parabolic cursor
| File v|| Wi v|| Farameters v|| Edit v|| Measkments v|| A-Scan Recovery v|

22.04 ps

| File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-5can Recovery -

Point 2:
L=106.1 mm
dL=43.9 mm

t-TOFD
POSTPROCESSI!

S |

t-TOFD
POSTPROCESSING

Length measurement results may be recalled into through double click on the length
measurement mark
In the subwindow appearing:

o L is coordinate of left end of the length measurement mark

o dL is length of defect area covered by length measurement mark

o Hisdistance between scanning line and length measurement mark

Clicking on = will print current screen snapshot accompanied with length measurement mark data

Clicking on ¥ will hide subwindow with length measurement mark data

Clicking on x will hide subwindow with length measurement mark data and erase corresponding

length measurement mark

Measurements—=>Clear Last — erases last length or depth/height measurement mark placed on the t-t-
TOFD / TOFD image

Measurements—=>Clear All — erases all length and depth/height measurement marks placed on the t-
TOFD / TOFD image
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6.6. CB-Scan horizontal plane-view imaging and recording of
defects for shear, surface, and guided wave inspection — t-
FLOORMAP L or FLOORMAP L

6.6.1. Setup Pulser Receiver for t-FLOORMAP L and FLOORMAP L

UDS 3-6 Pulser Receiver screen appears upon clicking on

following settings to be provided:
6.6.1.1. Angle Beam Inspection — Shear and Longitudinal Waves

l EIt-Floorm apL

rl [4 |Floormap L ‘ The

# | Parameter or Submenu Required Settings Note
Mode
1 Gain BASICS Gain setting to be performed
according to inspection procedure
providing required echo heights
from defects to be detected
2 DAC/TCG DAC/TCG DAC/TCG settings to meet
requirements of inspection
procedure
3 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
4 Pulse Width, Firing PULSER Pulse Width and Firing Level To synchronize with Gain
Level settings to optimize signal to noise setting procedure
ratio
5 Filter, Low Cut, and RECEIVER Filter and Low Cut and High Cut To synchronize with Gain
High Cut settings to match with probe's setting procedure
Frequencies frequency to optimize signal to
noise ratio
6 Display RECEIVER Display setting may be either Full, | The same Display mode to be
RF, PosHalf, or NegHalf used for both Probe Delay
determining and t-FLOORMAP L
/ FLOORMAP L Recording
7 USVelocity BASICS USVelocity setting to be equal to
actual value of ultrasound velocity
in the object under test
8 Probe Delay MEASURE Probe Delay setting to be equal to | For shear wave / longitudinal
actual probe delay wave angle beam inspection
probe delay may be determined
according to paragraph 5.2.13.5,
5.2.13.6 or 5.2.13.8 of this
Operating Manual or similarly
9 Display Delay BASICS Display Delay setting to be equal Recommend
to actual probe delay Display Delay = Probe Delay
10 | Angle MEASURE Angle setting to be equal to actual
probe angle
11 | Settings for other

parameters and
modes have no
significance

I
Click on _| or press LJ on front panel keyboard or on external keyboard upon completing
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6.6.1.2. Guided, Surface, Creeping, and Head Wave Inspection

# | Parameter or Submenu Required Settings Note
Mode
1 Gain BASICS Gain setting to be performed For guided / surface / creeping /
according to inspection procedure head wave inspection Gain
providing required echo heights setting may be implemented
from defects to be detected according to paragraph 6.6.1.4
of this Operating Manual or
similarly
2 DAC/TCG DAC/TCG DAC/TCG settings to meet For guided / surface / creeping /
requirements of inspection head wave inspection DAC may
procedure be created according to
paragraph 6.6.1.4 of this
Operating Manual or similarly
3 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
4 Pulse Width, Firing PULSER Pulse Width and Firing Level To synchronize with Gain
Level settings to optimize signal to noise setting procedure
ratio
5 Filter, Low Cut, and RECEIVER Filter and Low Cut and High Cut To synchronize with Gain
High Cut settings to match with probe's setting procedure
Frequencies frequency to optimize signal to
noise ratio
6 Display RECEIVER Display setting may be either Full, | The same Display mode to be
RF, PosHalf, or NegHalf used for both Probe Delay
determining and t-FLOORMAP L
/ FLOORMAP L Recording
7 USVelocity BASICS USVelocity setting to be equal to For guided / surface / creeping /
actual value of ultrasound velocity head wave inspection
in the object under test ultrasound velocity may be
determined according to
paragraph 6.6.1.3 of this
Operating Manual or similarly
8 Probe Delay MEASURE Probe Delay setting to be equal to | For guided / surface / creeping /
actual probe delay head wave inspection probe
delay may be determined
according to paragraph 6.6.1.3
of this Operating Manual or
similarly
9 Display Delay BASICS Display Delay setting to be equal Recommend
to actual probe delay Display Delay = Probe Delay
10 | Angle MEASURE 90°
11 | Settings for other

parameters and
modes have no
significance

I
Click on _| or press LJ on front panel keyboard or on external keyboard upon completing

ISONIC 2008 from Sonotron NDT - Operating Manual — Revision 1.06 - Page 232 of 316




6.6.1.3. Determining Probe Delay and Ultrasound Velocity for Guided / Surface /
Creeping / Head Wave Inspection

The following procedure is recommended for finding Probe Delay and US Velocity settings necessary to
perform guided wave inspection:

(a)
(b)

(©

(d)
(e)

(®
(9)
(h)
(i)

)

==
= L)
I
L]
— Pos 2
300 mm
12in J—
600 mm
24in

In the UDS 3-6 Pulser Receiver window — submenu BASICS setup Range = 750 mm (or 30 in)

In the UDS 3-6 Pulser Receiver window — submenu BASICS setup US Velocity = 3000 m/s (or 120
in/ms)

Place guided wave probe into position Pos 1 on a reference plate providing 300 mm (or 12 in) distance
between probe's frontal surface and plate end

Tune Gain to provide plate end echo reaching 80-90% of A-Scan screen height

Tune Display Delay (submenu BASICS) to provide rising edge of plate end echo matching with 40%
grid on horizontal A-Scan screen scale

Place guided wave probe into position Pos 2 on a reference plate providing 600 mm (or 24 in) distance
between probe's frontal surface and plate end

Tune the US Velocity (submenu BASICS) to provide rising edge of plate end echo matching with 80%
grid on horizontal A-Scan screen scale

Place again guided wave probe into position Pos 1 on a reference plate providing 300 mm (or 12 in)
distance between probe's frontal surface and plate end

Repeat steps (e) through (h) as above until further tuning will not be necessary, i.e. placement of guided
wave probe into positions Pos 1 and Pos 2 causes rising edge of plate end echo appearing at 40% and
80% on horizontal A-Scan screen scale correspondingly. Since that Display Delay and US Velocity
settings are proper

In the submenu MEASURE provide Probe Delay = Display Delay whereas Display Delay value to be
found according to above steps (a) through (i)

®

O Probe Delay and US Velocity for surface / creeping / head wave inspection may be found similarly
O Automatic Calibration (AUTOCAL) procedure according to paragraph 5.2.13.8 of this Operating Manual

is also applicable
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6.6.1.4. Setting Gain and DAC for Guided / Surface / Creeping / Head Wave
Inspection
For setting up Gain and DAC a reference plate containing artificial defects is required; said reference plate

must have acoustical properties (longitudinal and shear wave propagation velocity, attenuation) thickness
and curvature differing from the same properties of the plate to be inspected in not more than +10%.

Gain setting to be performed through providing sure detection of artificial defect from selected distances
according to required inspection range
Optional DAC setting for guided wave inspection to be performed as below:

Place guided wave probe into position on reference plate providing receiving of an echo from a reflector

(a) Place guided wave probe into position on reference plate providing receiving of an echo from a reflector
passing minimal travel distance

(b) Follow instructions of paragraph 5.2.10 of this Operating Manual to record first DAC echo

(c) Move the probe away from the reflector keeping it's echo maximized for each new DAC echo recording
paragraph 5.2.10 of this Operating Manual
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6.6.2. t-FLOORMAP L and FLOORMAP L — Implementation

6.6.2.1. t-FLOORMAP L — Prior to Scanning
t-FLOORMAP L control panel is shown below

u] A0 100 150 200
= 1 1 1
=
=
[
&
20 Length o
200 mm ‘ 1
1 Time o
10 5 ‘ 2 Scan Length not exceeding 400 mm or 16 in / Scan Time
Time-W ait I <
JE
Colonng:
IF'seul:Il:n j
[T Mommalize to DAC Empty t-FLOORMAP record field
4 = =
Start Open Save
& | [T E
- [
UDS53-6 Text Cloze

o S0 100 150 200 250 300 350 400
I 1 I 1 I 1

?l'+++++++
OF S+ o+ o+
!,++++++++
+lF o+ o+ o+ o+

Empty t-FLOORMAP record field

20 Length g
1 * Segment of Scrolled Total Scan Length
1 Time F exceeding 400 mm or 16 in / Scan Time
23s ‘ 2 . < >
Time-w ait rF
«»
Ii,':::;';g - t-FLOORMAP scrolling controls
[~ Hormalize to DAC
> = =
Start Opel

}ﬁ n Q\re%l;

UD53-6 Text Close
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Scan Length and Scan Time

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period. Time (Scan Time) is the duration of recording period

20" Length

290 mm

Time-W ait

To control Length the following
manipulations are applicable:

e Mouse /Touch Screen
B Click on corresponding

o Keyboard

-
B Press 1 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J _J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J 2J :J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 1000 mm or 2 and 40 in
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20 Lehgth

290 mm

Time-w ait
B «

To control Time P // Ve
the following manipulations are applicable: , “»
7
v/
e Mouse /Touch Screen e’

B Click on corresponding
e Keyboard

'l
s Press LJ on front panel keyboard or on external keyboard = Time fore color changes to

white - then use !J _J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Time = Time fore color changes to white - then use !J '_’J :J !J on front panel
keyboard or , , on external keyboard

®

The value of Time is adjustable between 5 and 60 sec
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Time-Wait

Time-Wait is waiting time for intermissions predcessing t-TOFD recording, which starts unconditionally upon
Time-Wait period is over

20 Length

200 R

Current value of 290 mm

. o »

Time-Out 1 Time

N 7 CHL
e

P4

\1 e By

. . . / -’
To control Time-Wait the following -
manipulations are applicable: 7 -
77
e Mouse /Touch Screen /,//
B Click on corresponding
e Keyboard
-
B Press 3 on front panel keyboard or on external keyboard = Time-Wait fore color changes
to white - then use !_ 2/, « ! on front panel keyboard or [f, , , on external
keyboard

e Combined

LJ

B Click on Time-Wait = Time-Wait fore color changes to white - then use =/,

front panel keyboard or , , , on external keyboard

» & &,

®

The value of Time-Wait is adjustable between 0 and 15 sec

t-FLOORMAP L Record Palette

There are four palettes available through — select

N
N

Coloring:
Pzeudo - I

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-6 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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Start/Stop t-FLOORMAP L recording

4
Click on ﬂl or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard to

start t-FLOORMAP L recording

{ LI
Start | button becomes invisible since t-FLOORMAP L recording starts. __3P | putton occupies its

[ |
position. Click on ﬁ' or press LJ on front panel keyboard or or <Alt>+<S> on external

keyboard to terminate t-FLOORMAP L recording prior to automatic completion

N 4 |
ﬂ' button becomes invisible after completion / termination of t-FLOORMAP L record. Start

button returns to its position

Save record into afile

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-6 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.6.2.2. t-FLOORMAP L — Scanning

a Apply probes pair to test object in the start point of selected scanning line

4 | |
O Click on 3t |or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe over the scanning line synchronously with Position Icon moving with constant speed above
t-FLOORMAP L record field — typical scanning progress display during is shown and explained below

20 Length
200 mm
1 Time
105
Time-W ait

Coloring:

I Pzeuda j

[T Mommalize to DAC
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6.6.2.3. FLOORMAP L - Prior to Scanning
FLOORMAP L control panel is shown below

u] a0 100 150 200 250 200
1 1 1 1 1

+ o+

Current A-Scan

+

+

22800 mm

+
+ o+
* +
+
+

+f"'-|-++
o+ o+ o+ o+ o+ o+

et
P

+

+
+
+

-
b

[

20 Length
«

Coloring: Scan Length not exceeding 400 mm or 16 in

IF'seudn:n j <
[ Nommalize to DAC

Encoder:

T
I Drefault jﬂk

— Empty FLOORMAP L record
4 = =

Start Open Sarve

&

UDS3-6 Text Close

0 mm

+ o+ DI 5:2! 1DID 15IE| ZDID 25|D SDID 35|D 400
Empty FLOORMAP L record

20 Length - Segment of Scrolled Total Scan Length

820 mm 1 » < exceeding 400 mm or 16.in >
Coloring:
IF'seudo j
[~ Nommalize to DAC
—— % FLOORMAP L scrolling controls
IDefauIt j

2 = =]

Start Open Save

£ g

UDS3-6| Text Close 9 q :
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Scan Length

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period

To control Length the following 7 -~
manipulations are applicable: P /’ -
e Mouse /Touch Screen 4/’ -

B Click on corresponding
o Keyboard

-
B Press 1 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J 2J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J 2J :J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 20000 mm or 2 and 800 in

FLOORMAP L Record Palette

There are four palettes available through — select
S
N

Coloring:
IPseudD vI

Select encoder to be used through appropriate box

Encoder

Encoder:

IDehuh _:J

Clamp probe into encoder — refer to Chapter 7 of this Operating Manual

Connect encoder to appropriate input on the rear panel of ISONIC 2008 instrument

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-6 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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Start/Stop FLOORMAP L recording

4
Click on ﬂl or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard to

start FLOORMAP L recording

4 | N |
stait | putton becomes invisible since FLOORMAP L recording starts. _ 2P | putton occupies its

[ |
position. Click on ﬁ' or press LJ on front panel keyboard or or <Alt>+<S> on external

keyboard to terminate FLOORMAP L recording

| 4 |
ﬂ' button becomes invisible after termination of FLOORMAP L record. __3tait | putton returns to its

position

Save record into afile

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-6 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.6.2.4. FLOORMAP L — Scanning

a Apply probes pair to test object in the start point of selected scanning line

4 |
O Click on 3t |or press '\L on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe over the scanning line — typical scanning progress display during is shown and explained
below

200

20 Length
200 mm ‘
Colonng:

IF'seuu:h:u
[T Mommalize to DAC

Encoder:
I Drefault

Text

ISONIC 2008 from Sonotron NDT - Operating Manual — Revision 1.06 - Page 244 of 316



6.6.2.5. t-FLOORMAP L / FLOORMAP L — Postprocessing
Versatile postprocessing of t-FLOORMAP L/FLOORMAP L (CB-Scan) records is featured with:

a Sizing of the defects at any location along stored images (coordinates, projection size,
amplitude-based evaluation)

a Play-back and evaluation of A-Scans obtained and captured during t-FLOORMAP L /
FLOORMAP L (CB-Scan) defects imaging and recording

a Defects outlining and pattern recognition based on A-Scan sequence analysis — Echo
Dynamic Pattern Analysis

O Reconstruction of t-FLOORMAP L / FLOORMAP L (CB-Scan) defects images for various
Gain, Reject, and off-line Gate level settings

o DAC/DGS t-FLOORMAP L / FLOORMAP L (CB-Scan) normalization

The screen as below appears upon opening file. All postprocessing procedures are performed through
— touch screen stylus or front panel or external mouse to be used

—y
*File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

t-FloorMap L
POSTPROCESSING

Menu Bar Functions

e File>Open - opens new t-FLOORMAP L / FLOORMAP L (CB-Scan) file

e File>Snapshots>Add Snapshot — stores current postprocessing screen snapshot accompanied with

appropriate settings and measurements into postprocessing session memory stack
e File>Snapshots>Restore Snapshot — recalls earlier stored postprocessing screen snapshot

accompanied with appropriate settings and measurements from postprocessing session memory stack

e File>Snapshots>Delete Snapshot — deletes earlier stored postprocessing screen snapshot

accompanied with appropriate settings and measurements from postprocessing session memory stack
e File=>Print — prints out postprocessing screen snapshot(s) accompanied with appropriate settings and

measurements
e File>Exit — returns to t-FLOORMAP L / FLOORMAP L (CB-Scan) control panel

e View-—2>Instrument — indicates setup of UDS 3-6 Pulser Receiver used for scanning when file was
created

e View->Inspection Data — indicates operator's comments entered prior to scanning
e View—>Coloring — selects palette for t-FLOORMAP L / FLOORMAP L (CB-Scan) image
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A-Scan Recovery 2ON — generates cursor representing sound path of probe's central beam in the
object under test that may be guided over t-FLOORMAP L / FLOORMAP L (CB-Scan) image using

|

either touch screen stylus or mouse or : ¥ on front panel keyboard or , on external
keyboard — corresponding A-Scan is recovered synchronously according to sound path cursor position.
Indication of starting position of cursor (L) corresponding to probe's center accompanies recovered A-
Scan. On the recovered A-Scan there is red Off-line Gate presented. Initially Off-line Gate covers
whole A-Scan range

File v|| Wiew v|| E dit v|| I easurements v|| A-Scan Recovery v|
L=129.3 mm

IR T
S S S

s =0.0mm H=55%
AVC= 3.14dB

FloorMap L e B
POSTPROCESSING a 50 100 150 200 250 300

/
|Automatic Measurements Display| accompanies recovered A-Scan and indicates (refer to
paragraphs 5.1.12, 5.2.13.1 and 5.2.13.2 of this Operating Manual):

0 sound path S between reflector and probe's center (measurement mode - Flank)

o amplitude H of the maximal signal in the Off-line Gate expressed in % of full A-Scan height

o AVC (dB to DAC) of the maximal signal in the Off-line Gate provided that DAC was active
whilst recording t-FLOORMAP L / FLOORMAP L (CB-Scan) data

To fix position of sound path cursor with corresponding recovered A-Scan and Automatic
Enfe.r |

Measurements Display data left mouse click or release touch screen stylus or press ' *=_ on front
panel keyboard or [Enter| on external keyboard

ESC
To interrupt recovery of A-Scans and empty A-Scan Recovery field right mouse click or press L)
on front panel keyboard or on external keyboard

A-Scan Recovery>OFF — erases sound path cursor with recovered A-Scan, indicator of sound path
cursor position, and Automatic Measurements Display
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Edit>Change Gain>0ON — generates cursor representing sound path of probe's central beam in the
object under test that may be guided over t-FLOORMAP L / FLOORMAP L (CB-Scan) image using

either touch screen stylus or mouse or !/ f on front panel keyboard or , on external

keyboard — corresponding A-Scan is recovered synchronously according to sound path cursor position.
Ente.r |

To select reference A-Scan release touch screen stylus or left mouse click or press ' *=_ on front

panel keyboard or [Enter|on external keyboard — this generates subwindow allowing off-line re-

adjusting of Gain for all A-Scans captured during t-FLOORMAP L / FLOORMAP L (CB-Scan)

recording in £6dB range with £0.1 dB increments through clicking or pressing and holding on ﬁ or

r §

pressing —~, _~_/ on front panel keyboard or , on external keyboard

ISONIC 2008

Select Gain Change:

+1.8 dB ﬂ

0K Cancel

During Gain re-adjusting reference A-Scan is modified accordingly. Upon completing re-adjusting Gain

DK Ente.! |
click on or press *=_J on front panel keyboard or on external keyboard — this
applies new Gain value to all captured A-Scans and redraws t-FLOORMAP L / FLOORMAP L (CB-

Scan) image accordingly

Cancel | eae
To interrupt re-adjusting of Gain click on or press LJ on front panel keyboard or

on external keyboard

Edit>Change Gain=>OFF — negates Gain re-adjustment and returns to originally recorded t-
FLOORMAP L / FLOORMAP L (CB-Scan) image and original Gain setting
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e Edit>ROI2>0ON - generates cursor representing sound path of probe's central beam in the object under
test that may be guided over t-FLOORMAP L / FLOORMAP L (CB-Scan) image using either touch

screen stylus or mouse or : : on front panel keyboard or , on external keyboard —
corresponding A-Scan is recovered synchronously according to sound path cursor position. To select

L
Enter |

reference A-Scan release touch screen stylus or left mouse click or press - *=_ on front panel
keyboard or [Enter| on external keyboard — this generates Off-line Gate controls n n n

n, u n allowing to redefine Region Of Interest for t-FLOORMAP L / FLOORMAP L (CB-
Scan) imaging

| File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

+
+
+
+
+
+
+
+

FloorMap L
POSTPROCESSING

ESC
To interrupt selection of reference of A-Scan right mouse click or press L) on front panel keyboard
or on external keyboard

To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on .
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Upon completing redefining of Region Of Interest click on — this applies new Off-line Gate to all
captured A-Scans and updates t-FLOORMAP L / FLOORMAP L (CB-Scan) image accordingly — only
segment of t-FLOORMAP L / FLOORMAP L (CB-Scan) image covered by newly adjusted Off-line
Gate remains visible

| File v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|

425.0 mm

E
E

FloorMap L | ¢
POSTPROCESSING 0 &0 100 150 200 260 300

It is possible then to perform A-Scan signal evaluation using newly adjusted Off-Line Gate through A-
Scan Recovery >ON

File: v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|
L=1286 mm

435.0 mm

+ o+
+ o+
+
+ o+
+ o+
+ o+
+ o+
+ o+
+ o+

s=2268mm H=21% m——
AVC= 79 dB o :

FloorMap L
POSTPROCESSING a 50 100 150 200 250 300

amm

e Edit>ROI2>OFF — negates Off-line Gate re-adjustment and returns to originally recorded t-
FLOORMAP L / FLOORMAP L (CB-Scan) image and initial Off-line Gate setting

ISONIC 2008 from Sonotron NDT - Operating Manual — Revision 1.06 - Page 249 of 316



Edit>Filtering>ON — generates amplitude palette bar with sliding cursor, which may be controlled

using either touch screen stylus or mouse or 2» tj on front panel keyboard or , on external
keyboard . Position of the sliding cursor on the amplitude palette bar determines filtering level, which is
indicated as Filtering. All elements of t-FLOORMAP L / FLOORMAP L (CB-Scan) image representing

signal amplitude below filtering level are suppressed:

| File v|| Wigw v|| Edit v|| Measurements v|| A-Scan Recavery v|

435.0 mm

||1

Filtering:
>33.b dB
FloorMap L
POSTPROCESSING

e Edit>Filtering>OFF — returns to originally recorded t-FLOORMAP L / FLOORMAP L (CB-Scan)
image and removes Filtering indication
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Edit>Normalize to DAC>0N - applies DAC/DGS normalized color palette to t-FLOORMAP L /
FLOORMAP L (CB-Scan) image, which was recorded with active DAC/DGS and redraws t-
FLOORMAP L / FLOORMAP L (CB-Scan) image correspondingly (dB to DAC/DGS normalization)

File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

L=8 Filering
ROl

Change Gain

3
4
»

| Momalize to DAC
- Flip Horizontal

s=948mm H=99%

AVC= 17 dB

FloorMap L
POSTPROCESSING

0 mm

0N
= OFF

T
50

T
1460

T
200

File v|| Wigw v|| Edit v|| Measurements v|| A-Scan Recavery -
L =827 mm
E
+ + E
+ + g
+ + g
+ +
+ +
¥ +
+ +
+ +
-
5=94.8mm H=59% gé e
F—a
- = [ -
AVC= 1.7 dB i —— 'l;=___ -
= o5 "-:_‘5.;_
==
= e ]
'3 _,!' -
= . = = E
FloorMap L | £
[=}

POSTPROCESSING 0

T
lule]

T
150 200

T
250

300

Edit>Normalize to DAC>OFF — negates dB to DAC/DGS normalization and returns to originally
recorded t-FLOORMAP L / FLOORMAP L (CB-Scan) image

®

Applying of Edit->Normalize to DAC->ON or Edit->Normalize to DAC->OFF negates Filtering
(Edit>Filtering>OFF)
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_ —reorders A-Scans captured during t-FLOORMAP L / FLOORMAP L (CB-Scan)
recording in reverse succession and redraws t-FLOORMAP L / FLOORMAP L (CB-Scan) image
accordingly. This service function may be useful for merging scans of neighboring sections of an object,
which were scanned in opposite direction due to access conditions, etc

Filterirg »
ROl 4
Change Gain 4
Momnalize to DAC » |

FloorMap L (Am T e e
POSTPROCESSING 200

FloorMap L
POSTPROCESSING
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Measurements>Add Measure=>Length — generates horizontal cursor that may be guided over t-

*

—

FLOORMAP L / FLOORMAP L (CB-Scan) image using either touch screen stylus or mouse or

_'.'_/ on front panel keyboard or , on external keyboard . Horizontal cursor to be positioned over

defect area, which's length along the scanning line to be evaluated. Position of horizontal cursor
characterizes its coordinate (H) relatively scanning line. To fix position of horizontal cursor left mouse

L ]
Enter |

click or release touch screen stylus or press *=_ on front panel keyboard or [Enter| on external
keyboard

File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|
H=2159mm
I £
=}
w0
7
‘éi& = e =";:_I_"
= [} S ie= -
-
= Ee
il e
e —
= = = E
FloorMap L | £
= T T T T T
PosTPnocEssl"G a an 100 180 200 280 200
File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|
H=217.0 mm
L-68 e e ==
mm I 3 F—JE-_.- = 'S"q!—— .; =
SR el
gl
E%.:’_H— =] w— -—=".-‘."
¥ — e
=== :_:- = :-i-;_
-0
h - e
= e
FloorMap L | £}
[}

POSTPROCESSING o

First vertical cursor appears upon fixing horizontal cursor, it may be guided over t-FLOORMAP L /

|

FLOORMAP L (CB-Scan) image using either touch screen stylus or mouse or ' =/, ¥ on front panel

keyboard or , on external keyboard . Coordinate of the first vertical cursor along t-FLOORMAP L /
FLOORMAP L (CB-Scan) image (L) is indicated synchronously. To fix position of the first vertical cursor

L ]
Enter |

left mouse click or release touch screen stylus or press - *=_/ on front panel keyboard or [Enter|on
external keyboard
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Second vertical cursor appears upon fixing first one, it may be manipulated by the same way. Coordinate

of the second vertical cursor along t-FLOORMAP L / FLOORMAP L (CB-Scan) image measured with
relatively first vertical cursor (dL) is indicated synchronously, it represents projection length of defect

area provided that vertical cursors are placed properly

ESC
To interrupt length measurement procedure at any moment right mouse click or press L) on front

panel keyboard or on external keyboard

File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

H=2159mm

L=68mm [dL=406 mm

435.0 mm

&%g === R .
=:...—§ :: g—% p=
e
— =1
e =3 5 —
":i!- v o
B ——
B = = E
FloorMap L | £
= T T T T T
POSTPROCESSING 0 50 100 180 200 250 300
| File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery -

FloorMap L
POSTPROCESSING

435.0 mm

’

T
50

T
100

T T
150 200

200

Horizontal [length measurement markl appears on the t-FLOORMAP L / FLOORMAP L (CB-Scan)

image upon fixing position of second vertical cursor
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Length measurement results may be recalled through double click on the length measurement mark

| File v|| Wig v|| Edit v|| Meazurements v|| A-Scan Recoverny v|

435.0 mm

Point 1:
L=6.8 mm
dL=40.6 mm
H=2159 mm

s |

0mm

Floophlap L
P PROCESSING ] 5|0 10|0 15|0 20|0 25|0 200
&
In the appearing:

o L is coordinate of left end of the length measurement mark
o dL is length of defect area covered by length measurement mark
o Hisdistance between scanning line and length measurement mark

= will print current screen snapshot accompanied with length measurement mark data

Clicking on

Clicking on ¥ will hide subwindow with length measurement mark data

Clicking on x will hide subwindow with length measurement mark data and erase corresponding

length measurement mark
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Measurements>Add Measure>Width — generates cursor representing sound path of probe's central
beam in the object under test that may be guided over t-FLOORMAP L / FLOORMAP L (CB-Scan)
image using either touch screen stylus or mouse or *_ . on front panel keyboard or , on
external keyboard — corresponding A-Scan is recovered synchronously according to sound path cursor
position. Indication of starting position of cursor (L) corresponding to probe's center accompanies
recovered A-Scan. Sound path cursor to be positioned over defect area, which's width along the sound
path line to be evaluated. To fix position of sound path cursor left mouse click or release touch screen

L
Enter
stylus or press *=_ on front panel keyboard or [Enter| on external keyboard
File v|| Wigw v|| Edit v|| Measurements v|| A-Scan Recavery v|

L=278 mm

435.0 mm

+ o+ o+

LY, P N
Pl

I+ o+ o+ o+ o+ o+ o+ o+ +

y
:
.
.
.
:
.

A

!!'.
\'h |

s=807mm  H=40% [}

AWC=25dB

%"h

27
il 'lj |I|II
L

_E 4 _l. - =
FloorMap L | ¢
POSTPROCESSING 0 50 100 180 200 260 300
File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery -
L=278 mm
E
E
N
| o
Hi“l'\\ Mll:f J:i"':':J'rd'lj\:'J = “‘“:-‘I.' Ih'L‘
s=80.7mm  H=40% U=z == e
———ge
AVC= 25 dB = = %
% _ﬂiEsL
= = =
'E = i e
= = E =
FloorMap L | ¢
POSTPROCESSING 0 s0 100 150 200 260 300
First horizontal cursor appears upon fixing sound path cursor, it may be guided over t-FLOORMAP L /
FLOORMAP L (CB-Scan) image using either touch screen stylus or mouse or ? , '.' / on front panel

keyboard or , on external keyboard . Coordinate of the first horizontal cursor along sound path (H) is
indicated synchronously
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To fix position of the first horizontal cursor left mouse click or release touch screen stylus or press

L
Enter |

)

on front panel keyboard or on external keyboard . Second horizontal cursor appears upon fixing
first one, it may be manipulated by the same way. Coordinate of the second horizontal cursor along
sound path measured with relatively first horizontal cursor (dH) is indicated synchronously, it represents
projection with of defect area provided that horizontal cursors are placed properly. To interrupt width

ESC
measurement procedure at any moment right mouse click or press L) on front panel keyboard or

on external keyboard

File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

L=278 mm

H=189.7 mm | dH=61.1 mm

435.0 mm

+
+
+
+
+
+
+
+

£ o+ ok o+ o+ o+ o+ o+

|Hw co
e

2N : — =
=_F

s=80.7mm  H=40% = = = -
AVC= 25 dB = %ﬁ
=
= Ee
'E":;!; (o
- =
£ —
= = = E
FloorMap L | £
= T T T T T
POSTPROCESSING i 50 100 150 200 250 300
| File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|
3
E
=3¢
w
¥
FloorMap L | ¢
o

POSTPROCESSING

Vertical jwidth measurement mark{ appears on the t-FLOORMAP L / FLOORMAP L (CB-Scan) image

upon fixing position of second horizontal cursor

ISONIC 2008 from Sonotron NDT - Operating Manual — Revision 1.06 - Page 257 of 316



Width measurement results may be recalled through double click on the width measurement mark This

causes appearance of corresponding A-Scan and

subwindov-vl

| File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|
+ + +
+ + + E
+ + + =3
w0
+ + + [l
+ + +
+ + +
+ + +
+ o+ o+ o+
T |
Tl e 'm
s=80.7mm H = 40% Point 2:
AVC= 25 dB 2l L=27.8 mm
[ v H=189.7 mm
== dH=61.1 mm

FloorMap L

0 mm

v |

x |

S |

T
50

POSTPROCESSING

T T
100 1460

T T
200 2480 200

In the subwindow appearing:
o L is coordinate of the width measurement mark along scanning line
o His distance between scanning line and width measurement mark
o dH is width of defect area covered by width measurement mark

Clicking on
Clicking on

Clicking on
width meas

=

v
X

urement mark

will print current screen snapshot accompanied with width measurement mark data
will hide subwindow with width measurement mark data

will hide subwindow with width measurement mark data and erase corresponding

Measurements—=>Clear Last — erases last length or with measurement mark placed on the t-

FLOORMA

PL/FLOORMAP L (CB-Scan) image

Measurements—=>Clear All — erases all length and with measurement marks placed on the t-

FLOORMA

PL/FLOORMAP L (CB-Scan) image
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/. Recording and Imaging — Multi Channel
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7.1. Multi Channel Recording — General Notes

Multi channel record may include 1 through 8 strips comprising the strip chart. Every strip is formed based
on sequence of A-Scans obtained by corresponding UDS 3-6 pulsing-receiving channel

7.1.1. TOFD Strip

256 gray levels TOFD strip represents
sequence of RF A-Scans whereas
brightness of points for each horizontal
line is modulated according to
corresponding signal level.

Main use TOFD strip is recording of
TOFD channels data for weld
inspection. TOFD strip is also useful
for recording CHIME inspection and for
some applications where obtaining of
RF B-Scan is necessary

In order to perform typical TOFD
inspection and recording of TOFD strip
the following settings to be provided for
corresponding UDS 3-6 pulsing-
receiving channel

# | Parameter or Mode Submenu | Required Settings Note
1 Pulser Mode PULSER Dual
2 Pulse Width, Firing PULSER Pulse Width and Firing Level settings To synchronize with Gain
Level to optimize signal to noise ratio setting procedure
3 Filter, Low Cut, and RECEIVER | Filter and Low Cut and High Cut To synchronize with Gain
High Cut Frequencies settings to match with probe's frequency | setting procedure
to optimize signal to noise ratio
4 Display RECEIVER | RF
5 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
6 Probe Delay MEASURE | Probe Delay setting to be equal to Accumulated Probe Pair
actual Accumulated Probe Pair Delay may be determined
Delay according to paragraph
6.5.1.1 of this Operating
Manual
7 Display Delay BASICS Display Delay and Range to provide Display Delay and Range
Range clear A-Scan representing: will be determined
0 Lateral Wave and Longitudinal according to paragraph
Wave Back Echo Signals at the 6.5.1.2 of this Operating
beginning and at the and of A-Scan | Manual
correspondingly
OR
o Lateral Wave, Longitudinal Wave
Back Echo, and Mode Conversion
Back Echo at the beginning, middle,
and at the end of A-Scan
correspondingly
OR
0 Other combination of signals
required by Inspection procedure
8 Gain BASICS Gain setting to be performed according Refer to paragraph 6.5.1.3
to inspection procedure providing of this Operating Manual
required amplitude of signals from
defects to be detected
9 | Settings for other
parameters and
modes have no
significance
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7.1.2. Map Strip
256 Colors Palette Map Strip

represents sequence of A-Scans

whereas color of points for each

horizontal line is coded according to

corresponding signal level.

Main use Map Strip is recording of
pulse echo inspections using either
longitudinal, shear, surface, or guided

waves

The following settings of UDS 3-6
pulsing-receiving channel to be
provided in order to provide pulse echo
flaw detection and recording of the Map

+
+
+
+
+
+
+
+
i

EL+ 4+ + + o+ o+ o+

actual probe delay

Strip: ]
2
4
Parameter or Submenu Required Settings Note
Mode
Gain BASICS Gain setting to be performed
according to inspection procedure
providing required echo heights
from defects to be detected
DAC/TCG DAC/TCG DAC/TCG settings to meet
requirements of inspection
procedure
Pulser Mode PULSER Dual for dual element probes
Single for single element probes
Pulse Width, Firing PULSER Pulse Width and Firing Level To synchronize with Gain
Level settings to optimize signal to noise setting procedure
ratio
Filter, Low Cut, and RECEIVER Filter and Low Cut and High Cut To synchronize with Gain
High Cut settings to match with probe's setting procedure
Frequencies frequency to optimize signal to
noise ratio
Display RECEIVER Display setting may be either Full, | The same Display mode to be
RF, PosHalf, or NegHalf used for Probe Delay
determining and Recording
USVelocity BASICS USVelocity setting to be equal to
actual value of ultrasound velocity
in the object under test
Probe Delay MEASURE Probe Delay setting to be equal to | For shear wave / longitudinal

wave angle beam inspection
probe delay may be determined
according to paragraph 5.2.13.5,
5.2.13.6 or 5.2.13.8 of this
Operating Manual or similarly

Settings for other
parameters and
modes have no
significance
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7.1.3. Amplitude / TOF Pulse Echo Strip

Amplitude / TOF Pulse Echo Strip
represents peak amplitude and time of
flight for signals matching with Gate and
exceeding it's threshold level

Position of Amplitude Line on the strip is
proportional to the signal height. Echo
amplitude equal or exceeding 100% of
A-Scan height brings Amplitude Line
trace to full strip width level

Width of gray Time of Flight (TOF)
Rectangle is proportional to the signal
position in the Gate. For signals,
which’s time of flight measurement point
matches with the Gate end width of gray
Time of Flight (TOF) Rectangle is equal
to the full strip width

For defects signals followed by strong
geometry echoes Amplitude Line may
represent either first or maximal signal
amplitude depending on operator's
choice while width of gray Time of Flight
(TOF) Rectangle will represent position
of the first signal crossing gate level

Amplitude / TOF Pulse Echo Strip
may be used for thickness/corrosion
profiling and for various flaw detection
tasks

The following settings of UDS 3-6
pulsing-receiving channel to be
provided in order to provide pulse echo
flaw detection and recording of the
Amplitude / TOF Pulse Echo Strip:

+

Amplitude
+ + + + + + + +

+
+
+
+
+
+
+
+

+ 4
:J++++++++

+ 4+ + o+ o+ o+ + o+

+++m++++

o
-
=
o
E
<

DE_}
-
] ﬂ.mnlinuleh

i

JAmplitude

4 | Thresholkl

Gate A
: Thresholid

HTOF

Fy

1TOF

Gate A
: ud

#

Parameter or
Mode

Submenu

Required Settings

Note

[

aSwitch

GATEA

ON

Gain
aThreshold

BASICS
GATEA

Gain setting to be performed according
to inspection procedure providing
required echo heights from defects to be
detected will exceed aThreshold;
signals from other reflectors less then
defined one not to exceed aThreshold

DAC/TCG

DAC/TCG

DAC/TCG settings to meet requirements
of the Inspection Procedure

Pulser Mode

PULSER

Dual for dual element probes
Single for single element probes

Pulse Width, Firing
Level

PULSER

Pulse Width and Firing Level settings
to optimize signal to noise ratio

To synchronize with Gain
and aThreshold setting
procedure

Filter, Low Cut, and
High Cut
Frequencies

RECEIVER

Filter and Low Cut and High Cut
settings to match with probe's frequency
to optimize signal to noise ratio

To synchronize with Gain
and aThreshold setting
procedure
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# | Parameter or Submenu Required Settings Note
Mode
7 Display RECEIVER Display mode may be either Full, RF, The same Display mode to
PosHalf, or NegHalf be used for Probe Delay
determining and Inspection
8 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
9 Probe Delay MEASURE Probe Delay setting to be equal to Probe delay may be
actual probe delay determined according to
paragraph 5.2.13.7 or
5.2.13.9 of this Operating
Manual or similarly
10 | Meas Mode MEASURE Flank or Flank First
11 | Range, Display BASIC Range, Display Delay, AStart, and
Delay, aStart, awidth | GATE A aWidth settings to cover the Region of
Interest completely
12 | Settings for other

parameters and
modes have no
significance
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7.1.4. Coupling Strip

Coupling Strip is formed through comparing amplitude of reference signal with the gate
threshold. Green Sufficient Coupling record is provided for signals exceeding gate
threshold; red Insufficient Coupling record is provided in opposite case

The following settings of UDS 3-6 pulsing-receiving channel to be provided in order to provide pulse echo
flaw detection and recording of the Coupling Strip:

# | Parameter or Submenu Required Settings Note
Mode
1 aSwitch GATE A ON
2 Gain BASICS Gain setting to be performed providing
aThreshold GATE A height of coupling reference signal will
exceed aThreshold on case of
satisfactory coupling conditions; will not
exceed aThreshold on case of non
satisfactory coupling conditions
3 Pulser Mode PULSER Dual for dual element probes and on
case of coupling monitor probe receiving
signhals generated by inspection probes
Single for single element probes
4 Pulse Width, Firing PULSER Pulse Width = OFF for coupling monitor | To synchronize with Gain
Level probe receiving signals generated by and aThreshold setting
inspection probes procedure
Pulse Width and Firing Level settings
to optimize signal to noise ratio on case
if channel is used for active coupling
check
5 Filter, Low Cut, and RECEIVER Filter and Low Cut and High Cut To synchronize with Gain
High Cut settings to match with probe's frequency | and aThreshold setting
Frequencies to optimize signal to noise ratio procedure
6 Display RECEIVER Display mode may be either Full, RF,
PosHalf, or NegHalf
7 Range, Display BASIC Range, Display Delay, aStart, and
Delay, aStart, aWidth | GATE A aWidth settings to cover the coupling
reference signal
8 | Settings for other

parameters and
modes have no
significance
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7.1.5. Entering into Multi Channel Recording Mode

With reference to paragraph 9.2 of this Operating Manual and depending on insonification scheme setup
Firing Mode to either Parallel or Sequential

®

+ Highest scanning speed may be achieved through simultaneous (parallel) pulsing, receiving, signal
digitizing, and recording by up to 8 channels. Measures avoiding cross talking to be taken while
placing simultaneously fired probes on the object under test — the probes must be well separated

¢ Most compact probes placement on the object under test with complete avoiding of cross talking is
provided through pulsing, receiving, signal digitizing, and recording channels separately in time in a
sequence loop (sequentially). Sequential pulsing-receiving also saves battery life

With reference to Chapter 5 of this Operating Manual calibrate all UDS 3-6 channels, for which the recording
is necessary. It is recommended that for UDS 3-6 channels, which will not be used for the recording the
following setting will be provided: Pulse Width = OFF (submenu PULSER)

Upon completion UDS 3-6 settings activate Main Recording Menu (refer to paragraph 5.2.20 of this

. ) [1]1soNic 2008 * )
Operating Manual, then click on or press 1 _J on front panel keyboard or E on external

keyboard. The Multi Channel A-Scan screen appears allowing simultaneous observation of signals for all 8
UDS 3-6 pulsing receiving channels:
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+
+
+
+
+
+
+
+
+

l + + + A+ + + 4+

+ + + + £+ + + +
o+ + + A+
=+ + + + + + + + +

+ + 4+ + + + + + +
L+ + + + + + + o+ o+
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To return to calibration of a certain UDS 3-6 pulsing receiving channel double click on it's A-Scan

I
To proceed with Multi Channel inspection and recording click on _| or press LJ on front panel
keyboard or -g| on external keyboard
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7.2. Multi Channel Recording Control Screen

Multi-Channel Recording Control Screen is shown below:

ISONIC 2008 Inspection Setup

—Channel 1

Inzpection Type:

Channel 2

Inzpection Type:

—Channel 3

Inzpection Type:

Inzpection Type:

Inzpection Type:

|Map =l | |ToFD ||| |Pulse Echo =l
Dffset: -40 mm [ Offset: -20 mm | Offset: 0 mm [
Change : Change Change
Averaging: OFF
Probe Separation: 100 mm
—Channel 4 Channel 5 —Channel b

Inzpection Type:

Pulse Echo
Map
Coupling

INune j

INune

- Channel ¥

Channel 8

Inzpection Type:

Inspection Type:

INune

INune j

~Positioning
Scan Length:

Encoder:

[ 11omm &

I Default

fid

Back

Setup Step:

¥ Fine o Medium @ Coarze

{ Continue
i

Depending on the inspection procedure and implemented calibrations of UDS 3-6 pulsing receiving channels
it is possible to select type of strip for each channel or to switch strip generation off:

—~Channel 4

Ingpection Type:

Map j

Pulze Echo
Map
Coupling

Change
For each channel, activated for recording button {j becomes visible

i
Scan Length to be keyed in through clicking on E’ while increment for setting Scan Length value may be
selected through check of appropriate option Fine, Medium, or Coarse

Encoder to be selected through appropriate box
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Change
For Map, Pulse Echo, and Coupling strip type click on u generates simple popup window for
setting Offset value, which represents positioning of the probes in the scanner relatively to each other:

Offset: —_——
b
Setup Step: [
. Cancel
# Fine

O Medium

# Coarsze [%

Increment for setting Offset value may be selected through check of appropriate option Fine, Medium, or

F 9 .
Coarse. To vary Offset value click on E’ or press L Z f.z, !L on front panel keyboard or , ,

, on external keyboard

0“ Ente.r |
To complete and store last Offset value click on {_J or press *=_ on front panel keyboard or

on external keyboard

o ) Cancel 3 }
To negate Offset value modification click on or press on front panel keyboard or

on external keyboard

®

Offset values to keyed in for each channel to be used by ISONIC 2008 while forming strip chart
automatically. Thanks to such feature the same defect detected by different probes will be indicated in
the same longitudinal position in each corresponding strip

Change
For TOFD strip type click on u generates simple popup window for setting Offset, Probe
Separation, and Averaging values:

TOFD Settings

Offset: ;

OK

4>

Probe Separation: ( = |

Y ance

100 mm MJ

Averaging:

rF

oFF & [}
Setup Step:

® Fine o Medium @ Coarse

Setting of these values to be performed by the same way. For more data about Probe Separation refer to
paragraph 6.5.1.4 of this Operating Manual; for Averaging refer to paragraph 6.5.2.1 of this Operating
Manual
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- N | e | =1
To return to calibration of UDS 3-6 pulsing receiving channels click on or press on
front panel keyboard or on external keyboard

{ Continue J I l
To proceed to inspection with strip chart recording click on or or press on front
panel keyboard or on external keyboard

7.3. Scanning and Strip Chart Forming

Scanning and Strip Chart forming are controlled through screen as below:

13 3]
+ + o+ + = -
+ o+ o+ +
+ o+ o+ +
o+ o+ +
=+ ||+ +
+ e +
et o+ +
-?‘--u._t + +
T
1|- +|'|'|.i'+ i
=
=
[t}
1 I 1
Start Stop
Ezc n
Close Save
™ Timed Mode: = £
h CH1 CH?2 CH3

Symbol BH is placed above strip, for which the A-Scan is indicated. To observe A-Scan related to another
select another strip click on the selected strip. This switch is possible before scanning and during scanning
as well

Option ' LS ims to be checked on case if there is a need in Time-Based Strip Chart Forming and
unchecked for True-to-Location (Encoded) Strip Chart Forming

For True-to-Location (Encoded) Strip Chart Forming connect encoder to appropriate terminal of ISONIC
2008 instrument
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Start/Stop Strip Chart Forming

I
Start

Clickonl____Jor press LL on front panel keyboard or on external keyboard to start strip chart
forming

Stop

Click on \eeeeJ or press LL on front panel keyboard or on external keyboard to stop strip chart
forming

Typical screen during scanning is presented below:

=

P - i

[}

Close Save o=

L)

[}

[T Timed Mode =
= ~

CH1 CH2 CH3 CHA4 CH3 CHS8

Save record into afile

u i g
Click on o ] or press \2"‘.) on front panel keyboard or on external keyboard to save captured

Strip Chart record accompanied with channels calibration dumps into a file. Refer to paragraph 5.2.17 of
this Operating Manual to proceed with file saving

Return to Multi-Channel Recording Control Screen

Ese

Esc
Close
Click on or press \L) on front panel keyboard or on external keyboard to return to Multi-
Channel Recording Control Screen
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7.4. Strip Chart Postprocessing

In the ISONIC 2008 Start Screen (refer to paragraph 4.3 of this Operating Manual) click on
> |
[2]Postprosessing J or press 2 _Jon front panel keyboard or press on external keyboard — ISONIC 2008

Save/Open dialogue appears:

ISONIC 2005 Save/Open ed Bt

Lok ir: I ) Multicharnel | nspection j = i FEEE
ZXTOFD, mii MI000003, i
SHMAP + PE + TOFD. mil MI000004, i
SxMap. mil MI00000S. i

|| BOEIN G 787 STRINGER CORMER., mil [E/ LR %
MI0D0007, ri
MIDD000S, i

3

File name: IEEIEIN G 737 STRINGER CORMER. mii Open I

Files of type: IISEINIE 2003 Multichannel Inzpection Files [:j Cancel |
o

L
Enter |

Double click on file name selected or select file then press or press =1 on front panel keyboard or [Enter
on external keyboard

\ ESC
To return to ISONIC 2008 Start Screen click on ﬂl or press L) on front panel keyboard or
on external keyboard
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Postprocessing is controlled through Menu Bar functions and featured with:

¢ Previewing and scrolling of strip chart
33 ISONIC 2008 Multichannel Inspection Postprocessing

File Wiew Defects Marking Postprocessing Recover A-Scan

= BLAE | |I|II

e

(il

e

CH1 CH2 CH3 CH4 CHS5

¢ Recovery of A-Scans for each channel through placement of cross-hair cursor above channel's strip
(Menu Bar function Recover A-Scan->ON/OFF)

33 ISONIC 2008 Multichannel Inspection Postprocessing

File Wiew Defects Marking Postprocessing an

CH1 CH2 CH4 CHS5

To freeze selected A-Scan and cross hair cursor left mouse click; to interrupt play back of A-Scans right
mouse click
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Composing combination of simultaneously visible strips (Menu Bar Function
View->Channels>Check/Uncheck CH#)

33 ISONIC 2008 Multichannel Inspection Postprocessing
NEWN Defects Marking  Postprocessing  Recover A-Scan

Channels

Coloring M wCHZ

C-5can

B
v CH4 :'!'i:ii'llfll'll W
w CHS

|.|l” gy I
k 1'!; ‘, il

v Show PE Threshold

CH1 CH2 CH3 CH4 CHS5

33 ISONIC 2008 Multichannel Inspection Postprocessing

File Wiew Defects Marking Postprocessing Recover A-Scan

i [

=
=

450

b |

CH1 CH2 CH4 CHS5
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+ Conversion of selected Map Strip into Amplitude / TOF Pulse Echo Strip and reversal (Menu Bar
Function Postprocessing=>Channel#->Convert to PE/Convert to Map) — refer to Edit=>ROI function
as per paragraph 6.3.2.5 of this Operating Manual to vary selected gate settings for Amplitude / TOF
Pulse Echo Strip

33 ISONIC 2008 Multichannel Inspection Postprocessing

File Wiew Defects Marking NaEE
Channel 1
Channel 2
Channel 3
Channel 4

=M Recover A-Scan

N CTIOTRETIJ

File Wiew Defects Marking Postprocessing

50

100
ST —

l‘.[jr'f 1 |'I
byl &1l
B |!J-'-'-"':"r'| |
g il |
!Elﬁilpf'q I l |l
SRt ol
:L;HII I.I|i f | i%'l |
5 !i‘h':'ﬁ' I 'f-,ir: I
= .".'1."ﬁ"l'lll ,f ;. :flll

400
J-":'__‘
it

450

CH1

33 ISONIC 2008 Multichannel Inspection Postprocessing

File Wiew Defects Marking Postprocessing Recover A-Scan

= 'J' [T

il Iy

g Y
Yyl gl 1

) k L

= LU

: "P'rf".ﬁ | fl 1R I"‘d |
el .
e
I

e g I

CH1 CH2 CH3
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+ Varying Region of Interest (Gate) settings for every Amplitude / TOF Pulse Echo Strip (Menu Bar
Function Postprocessing > Channel#->ROI>ON/OFF) — refer to Edit->ROI function as per paragraph
6.3.2.5 of this Operating Manual to vary selected gate settings for Amplitude / TOF Pulse Echo Strip

+ Marking defects and generating of Strip Chart Inspection Report (Menu Bar Function Defects

Marking—=>Mark Defect) which is implemented through left mouse press on the top/down end of defect
and release on the down/top end of the defect

33 ISONIC 2008 Multichannel Inspection Postprocessing

File Wiew NEEERSIEENAGN Postprocessing  Recover A-Scan

33 ISONIC 2008 Multichannel Inspection Postprocessing

File Wiew Defects Marking Postprocessing Recover A-Scan

=t

File Wiew Defects Marking Postprocessing

=t

Defect #1
Start: 97 mm
Length: 22 mm
Channels: 4

CH1 CH2 CH3 CH4 CH5
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+ Place/Remove dashed Gate A threshold line above PE strip (Menu Bar Function View—=>Show PE
Threshold)

33 ISONIC 2008 Multichannel Inspection Postprocessing

File BUEMN Defects Marking  Postprocessing  Recover A-Scan
Channels 3
Coloring 3 -

C-5can

M

33 ISONIC 2008 Multichannel Inspection Postprocessing

File Wiew Defects Marking Postprocessing Recover A-Scan

=t

e

——

—.-=:= g
e — ——
B

CH1 CH2 CH3 CH4 CHS5

Varying Color Palette for Map Strips (Menu Bar Function View=>Coloring—>Map > Palette#)
Varying Color Palette for TOFD Strips (Menu Bar Function View—=>Coloring=>TOFD-> Palette#)
Varying Contrast for TOFD Strips (Menu Bar Function View>TOFD->Contrast->Contrast#)
Varying Logic for TOFD Strips (Menu Bar Function View—>TOFD->Logic>Positive/Negative)
Printing Strip Chart (Menu Bar Function File=>Print)

* & & o o
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+ Individual postprocessing of each strip (Menu Bar Function Postprocessing—=>Scannel#-> Start
Postprocessing) — TOFD strip individual postprocessing is according to paragraph 6.5.2.5 of this
Operating Manual; Map Strip individual postprocessing is according to paragraph 6.6.2.5 of this
Operating Manual; Amplitude/TOF Pulse Echo Strip individual postprocessing is according to
paragraph 6.3.2.5 of this Operating Manual

Return to ISONIC 2008 Start Screen (Menu Bar Function File=>EXit)

Conversion of few Map or Amplitude/TOF Pulse Echo Strips into Stripped C-Scan (Menu Bar
Function View—>C-Scan)

ag ISONIC 2008 Multichannel Inspection Postprocessing

File BUEEN Defects Marking Postprocessing  Recover A-Scan

Channels
Zoloring

el |1

- |

CH1

=7 -~
%
e
o
=]
=1 L | | I N
i ] Gate Start Gate Width Gate Start Gate Width

g 244mm BNl 4emm Bl 246mm SN 44mm §
§ Gate Threshold CERIEAREREET Gate Threshold R EREY BT

g 20% EEERROTER 20y R
2 4| A r

Probe Width
20 mm

Probes Overlap
0%

Setup Step

Continue Cancel

This causes appearance of C-Scan Settings screen requiring performing of several preparations. For each

strip it is neces

sary:

e toinclude / skip it's data in the formed Stripped C-Scan (Check / Don’'t Check Use in C-Scan

option)
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to arrange Gate settings for every strip selected to submit data into the C-Scan using [EEIRSIE1gt ,
CEWCRWUTolty] . and [eEWRNIEElelle] controls; to optimize Gate settings it is recommended to play

back captured A-Scan through clicking on __>&lect &-5ean |; playing back of A-Scan is possible then
through manipulating of mouse cursor above the strip; left mouse click freezes last selected A-Scan
allowing to adjust Gate settings; increment / decrement for modifying of Gate settings is selectable

through clicking on appropriate option in the SIEWVESToLEE] field

C-5can Settings
CH1

50

300

WLJUUHL:JLJLJNL

Gate Stan Gate Width
Gate Threshnld v UszeinC-Scan
Select A-Scan

Gate Start Gate Width
Gate Threshold EETENERE
Select &-Scan

al

Praobe Width
20 mm

Probes Owverlap
0%

-]
Setup Step
i@ Fine
# bedium

Continue Cancel
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C-Scan Settings

CH3

a0

100

Gate Start Gate Width
247mm SNl 40mm 5

== Rl ¥ Usein C-Scan
50% E Select A-Scan

Gate Start Gate Width
2o B
Gate Threshold EErERNESE RS2

ig\_elect A-Scan

k

= ]
o
]
] Probe Width
=k 20 mm
]
: Probes Swerlap
e 0%
Lol
o]
=4
=T ]

Setup Step

Cancel

Navigation through all strips is possible through use of |horizontal scrolling bar|

Stripped C-Scan is generated supposing that there were brush shaped probe array used for scanning,
whereas all probes of the brush have equal width. Accumulated width of the Stripped C-Scan is defined

through keying in of [RpIIeIE and [ReT RO L

Continue ‘

On completion C-Scan settings click on

parameters

To return to complete strip chart presentation click

- this will generate Stripped C-Scan
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The following manipulations are possible for the Stripped C-Scan screen:

ISONIC 2008 C-Scan

File Coloring  Measurements

9.5 1.0 1686 221 ZVE 331 386 442 497 332

L-Coordinate:

Prajection Length:

W-Coordinate:

Frojection Width:

m
-
o

=
=1
2]

I

Varying Color Palette (Menu Bar Function Coloring=>Palette#)
Return to C-Scan Settings screen (Menu Bar Function File>Back)
Return to strip chart presentation (Menu Bar Function File=>Exit)
Printing out postprocessing results (Menu Bar Function File=>Print)

* & & o
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¢

Recovery of A-Scan and marking corresponding points on the map (Menu Bar Function
Measurements—=>Points=2>Add) — upon activating this procedure manipulating of cursor above Stripped
C-Scan screen becomes possible — A-Scans corresponding to cursor positions are recovered; on
selecting point for marking left mouse click; to interrupt the procedure without marking point right mouse
click

0 to erase last marked point from Stripped C-Scan screen select
Measurements>Points>Clear Last

0 to erase all marked points from Stripped C-Scan screen select
Measurements—->Points>Clear All

o0 to preview A-Scan for the marked point in the marked point on the Stripped C-Scan screen
double click on it's number

ISONIC 2008 C-S5can
File Coloring NEEEENEN

; Length *
L-Coardinat|  wigth  » o

17-
/

Projection Length:

W C oo ki
ISONIC 2008 C-Scan

File  Coloring  Measurements

55 10 166 221 276 331 356 442 4587 552

Project

L-Coordinate:
|

Projection Length:

WW-Coordinate:

Projection Wyidth:

55 1.0 1686 221 Z7VE 331 386 442 497 552

<]

247

258

268

278

L=149 rm, ¥ = 37.5 mm
0D=273mm

289

300
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¢ Measuring length of the indication map (Menu Bar Function Measurements>Length->0ON) — this
generates first horizontal cursor that may be guided over Stripped C-Scan image; coordinate of the first
horizontal cursor is indicated in the L-Coordinate field; to fix position of the first horizontal cursor left
mouse click; second horizontal cursor appears upon fixing first one; it may be manipulated over
Stripped C-Scan image by the same way; coordinate of the second horizontal cursor measured
relatively first horizontal cursor is indicated in the Projection Length field

ISONIC 2008 C-Scan

File  Coloring REEEENGE =R

] Length 55 110 166 221 276 331 386 442 497 552
L-Coordinat ™ yigeh

Points

ME ISONIC 2008 C-Scan

File  Coloring  Measurements

) S5 110 1868 221 ITE 331 336 442 497 552
L-Coordinate:

| 143.2 mm
Projection Length:

WW-Coordinate:

Projection Wyidth:

“187]E

ISONIC 2008 C-Scan

File Colaring  Measurements

. 25 10O 166 221 276 331 386 442 497 552
L-Coardinate: B
| 143.2 mm
Projection Length:

r
| 20.0 mm =
W-Coordinate:

fe=}

[7p)
| o
Projection Width:

fe=}

w
| 2

m

Fe

™

o

o

(]

o

=1

[1r]

[+

To interrupt L-Coordinate and Projection Length measurement right mouse click
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¢ Measuring width of the indication map (Menu Bar Function Measurements>Width=>ON) — this
generates first vertical cursor that may be guided over Stripped C-Scan image; coordinate of the first
vertical cursor is indicated in the W-Coordinate field; to fix position of the first horizontal cursor left
mouse click; second horizontal cursor appears upon fixing first one; it may be manipulated over
Stripped C-Scan image by the same way; coordinate of the second horizontal cursor measured
relatively first horizontal cursor is indicated in the Projection Width field

ISONIC 2008 C-Scan

Wy-Coo

=

Project

o

File Colaring

L-Coordinat

Measurements
Length  »
Width
Paints

How

ISONIC 2008 C-Scan

File Colaring  Measurements

245

10 166 221 ZVE 331 386 442 497 532

L-Coordinate:

| 1432 mm
Projection Length:

| 20.0 mm
WeCoordinate:

| 336 mm
Projection Width:
| 338 mm

ISONIC 2008 C-Scan

File  Coloring  Measurements

245

10 166 221 276 331 356 442 497 532

L-Coordinate:

B
| 1432 mm
Projection Length:
r\-\._
| 20.0 mim 3
W-Coordinate:
o
| 33.6 mm 0
Frojection Wyidth:
fus]
| 10.5 ram 7
=]
o r
=]
&
=
o

To interrupt W-Coordinate and Projection Width measurement right mouse click
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8. Incremental Encoders
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8.1. Standard Encoder SK 2001108 ABI — Single Channel
Operation

Encoder SK 2001108 ABI is originally designed for BScan(Th) and ABISCan recording with ISONIC 2001,
ISONIC 2005, ISONIC 2006, ISONIC 2007, ISONIC 2008 instruments — single channel operation

To start use of the encoder refer to simple guidance as below
Step 1

Fit probe into appropriate probe holder and connect
signal cable(s) to probe

Step 2

Fit probe holder with probe into encoder

Step 3

Connect probe signal cable(s) to appropriate coaxial
socket on ISONIC 2008 instrument — refer to
paragraph 4.2 of this Operating Manual

Connect encoder data cable to the appropriate D-
Type connector on rear panel pf ISONIC 2008
instrument — refer to paragraph 4.2 of this Operating
Manual
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8.2. Standard Encoder SK 2001108 FM — Single Channel
Operation
Encoder SK 2001108 FM is originally designed for TOFD and FLOORMAP L recording with ISONIC 2001,

ISONIC 2005, ISONIC 2006, ISONIC 2007, ISONIC 2008 instruments — single channel operation. To start
use of the encoder refer to simple guidance as below

8.2.1. TOFD

Insert ultrasonic probes into their probe holders then:

O Fit probe holders with probes on TOFD bar and fix them at at necessary separation distance

O Fix twister S 904050 on the TOFD bar

O Fit encoder SK 2001108 FM into twister S 904050 and provide necessary orientation of encoder's
wheel — it must be oriented at parallel to the desired probes' trace either along or across the weld —
refer to the sketch and photos below

Base 2

7
070w

Encoder

Encoder YWheel

TOFD Fixture and encoder positioning
for scanning along the weld

TOFD Fixture and encoder positioning
for scanning across the weld
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8.2.2. FLOORMAP L

Encoder SK 2001108 FM allows 2 ways of direct fitting of S 544 series guided wave probes or other probes

fitted into appropriate probe holders:

O Both encoder's wheel and probe contact face are situated on scanning surface:

Fitting probe into encoder

Ready to scan

a Encoder's wheel is situated on surface, which is rectangular to scanning surface:

Fitting probe into encoder

Ready to scan
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8.3. Customized Encoders for Proprietary Inspection Tasks —
Single and Multi Channel Operation

Various custom made encoders for proprietary inspection tasks may be used with ISONIC 2008. For
appropriate encoder data cable and connector pin-out contact

O Nearest Sonotron NDT representative
OR

O Directly to Sonotron NDT — mail to Support@sonotronndt.com with subject ISONIC 2008
encoder connection

®

Improper cable out-coming from custom made encoder for proprietary inspection tasks may lead to
warranty exempted damaging ISONIC 2008 instrument

8.4. Encoder Calibration

All encoders to be calibrated once for further use with ISONIC 2008.

[ 1 |operate

[2]Postprocessing

[3]setting

[4]Exit To Window:

|?_ Shut Down

! |
To proceed with the calibration in the ISONIC 2008 Start Screen or press 3 on front panel

keyboard or press on external keyboard

| 1 |Instrument

[2]international

lE‘ Encoders

] Printer Selection

|?]Back

[

i
In the appeared ISONIC 2008 Settings Menu or press _3 J on front panel keyboard or on
external keyboard
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In the appeared ISONIC Encoder Settings window

ISONIC Encoder Settings

Fiegiztered Encoders:

or press <Alt>+<A> on external keyboard

Eemame
Tiesf
[Ealitarate..

Hemave

[Fns
T
=
=

Cancel

oKk |

The Calibrate Encoder window appears; it contains simple instructions to follow:

Cahbrate Encoder I Cahbrate Encoder I

= Place the Encoder &t Zero Point and click on Step 1
Mowe the Encoder to End Poirt and click on Step 2

\f Place the Encoder st Zero Point and click on Step 1
= hove the Encoder to End Point and click on Step 2

Fero Point End Point
{+300 mm}
[Hestart | StEp Z |

End Point
{+300 mm}

Fero Point

Step 1@ _Bosar|

Cancel |

Cancel |

Encoder’s wheel while calibrating must pass linearly

the distance of 300 mm (12 in) between Zero Point

designated through clicking on Step 1 or pressing <Alt>+<1> on external keyboard and End Point along

scale bar attached to flat surface

Upon reaching End Point and clicking on Step 2 or pressing <Alt>+<2> on external keyboard new

Encoder Test window appears

®

If it's necessary to re-designate Zero Point click on Restart or press <Alt>+<R> on external keyboard
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In the Encoder Test window:

Q Click on Reset or press <Alt>+<R> on
external keyboard to designate local zero

point o antining = ercoerten

L
Enter |

O  Click on Yes or press *=_ on front panel Emzereey el il
keyboard or Enter| or <Alt>+<Y> on I =-3.0 mm Beset

external keyboard to name the selected
encoder — Key in the Encoder Name

window appears Click on ez if the shown coordinate iz conrect,
ESC Click on Mo to recalibrate the Encoder.

Q Click on No or press - X" _J on front panel
keyboard or press or <Alt>+<N> on
external keyboard to recalibrate the

encoder — return to Calibrate Encoder
window

K.ey in the Encoder Hame |

IMyNewEncnder

~Nrlle@l s e~ Halz1cl) il [

o/lwlE[R[THyllulltllolrP] ]}

m FlIUX|CHHVYIB|IHNIM
iﬂve Cancel

Upon keying in new Encoder name ISONIC Encoder Settings window returns upon

.
W
~

Del BS

ISONIC Encoder Settings

Fiegiztered Encoders:

Fiename
Test. ..
Calibrate. ..

Bemowve

G,

aE, | Cancel
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L
Enter

To update the reiistry of ISONIC 2008 with new encoder data click on the OK or press = J on front panel

keyboard or Enter| or <Alt>+<Y> on external keyboard — this will automatically return to ISONIC 2008
Settings Menu

ISONIC Encoder Settings |

Reqistered Encoders:

b yuM ewE ncader

dd

Rename

Test...

[l

Bemove |

E, | Cancel |

While running encoder calibration next time:

a

a

Click on Add... or press <Alt>+<A> on external keyboard to proceed with next new encoder by the
same way as described above

Click on Rename or press <Alt>+<N> on external keyboard to rename the selected encoder

Click on Test or press <Alt>+<T> on external keyboard to check the accuracy of selected encoder
calibration

Click on Calibrate or press <Alt>+<L> on external keyboard to recalibrate selected encoder

Click on Remove or press <Alt>+<R> on external keyboard to remove selected encoder from the
registry of ISONIC 2008

ESC
Click on the Cancel or press L) on front panel keyboard or press or <Alt>+<C> on external
keyboard to negate all changes and return to ISONIC 2008 Settings Menu
Ente.r |
Click on the OK or press ' *=_ on front panel keyboard or or <Alt>+<K> on external keyboard
to update the registry of ISONIC 2008 and return to ISONIC 2008 Settings Menu
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9. Miscellaneous
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9.1. International Settings

[ 1]|operate

[zl Postprocessing

@satings

/ [4]Exit To Windows

m Shut Down

-
In the ISONIC 2008 Start Screen or press 3 Jon front panel keyboard or press |[F3| on external
keyboard

[ 1]instrument

[2]international

@ Encoders

Iﬂz‘rimer Selection
Back
\|—I J lz

In the appeared ISONIC 2008 Settings Menu or press _J on front panel keyboard or press
on external keyboard, the International Settings screen appears:

E‘Language [§

[ 2|measurement Unit

[ 3 |Back

rd | ESC
or press 3 o Q on front panel keyboard or

To return to ISONIC 2008 Settings Menu

or on external keyboard
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9.1.1. Language

-,
In the International Settings screen or press ' on front panel keyboard or F1 on external

keyboard

ISONIC Language Selection |

Select language then

®

Standard languages of ISONIC 2008 ate English and German. Other languages are available upon request
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9.1.2. Metric and Imperial Units

E‘Language [3

[ 2|measurement Unit
/ [ 3 |Back
F

. . - |
In the International Settings screen or press 2 on front panel keyboard or on external
keyboard

Measurement Unit:
1 | © Metric

2 | 2 Imperial

Cancel |

/

Select measurement units then |c|ick onl
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9.2. Instrument Settings

[ 1]|operate

[zl Postprocessing

* [3]settings

/ [ 4 |Exit To Windows

‘ m Shut Down

-
In the ISONIC 2008 Start Screen or press 3 J on front panel keyboard or on external

keyboard

In the appeared ISONIC 2008 Settings Menu or press

[ 1]instrument

12 |international

E‘ Encoders

IZ] inter Selection

\5 Back

1

external keyboard, the Instrument Settings screen appears:

Clicking on
return to ISONIC 2008 Start Screen

[ 1|Firing Mode

[2]zero calibration

[3]A-scan Colors

Elmaging

F]Back

[

-
21 J on front panel keyboard or [F1] on

' -
Jor pressingon ' _3 J on front panel keyboard or on external keyboard will
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9.2.1. Firing Mode

[ 1|Firing Mode

[2]zero calibration

[3]A-scan Colors

Elmaging
|?]Back

-
Clicking on [1Firing Mode or pressing L/r on front panel keyboard or on external keyboard will
open simple dialogue for selection of Firing Mode for Multi Channel inspection:

Firing Mode:
1 | © Parallel

2 | ® Sequential

Cancel |
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9.2.2. Base Line Zero Calibration

[ 1|Firing Mode

[2]zero calibration

[3]A-scan Colors

Ilmaging

F‘Back

F
or pressing 2 _Jon front panel keyboard or on external keyboard will

EZem Calibration J

Clicking on ‘

open simple dialogue for zeroing base lines in UDS 3-6 channels:

ISOMIC 2008 Zero Calibration

Calibrate | -« | Channel 3

®

ALL PROBE TERMINALS MUST BE
FREE FOR ZEROING BASE LINES
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9.2.3. A-Scan Color Scheme

[ 1|Firing Mode

[2]zero calibration

[3]A-scan Colors

Elmaging
|?]Back

E‘A—Sc an Colors 1

|
Clicking on or pressing _3 Jon front panel keyboard or on external keyboard will
open simple dialogue for selection of A-Scan color scheme for each of 8 UDS 3-6 pulsing receiving
channels:

Select A-Scan Color

Channel 1 Channel 5

Black AT [
Channel 2 Channel b

IElay j IEra}- j
Channel 3 Channel 7

IBIue j IBIue j
Channel 4 Channel 8

| wrhite =] |white =

Save Cancel |
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9.2.4. TOFD and Map Imaging

[ 1|Firing Mode
[2]zero calibration
I
EA—Scan Colors
Elmaging
|?]Back
m N -
Clicking on [4)meging ‘or pressing _“_J on front panel keyboard or on external keyboard will
open simple dialogue for selection of TOFD image logic and contrast and palette for Map Strip:
— TOFD Imaging
— Logic — Contrast
® Negative O Natural
O Soft
O Positive ® Sharp
— Map Imaging
Coloring:  |Pseudo 2 =]
[ Save | [ Cancel |

o [ Save I , :
On completion click on to activate new settings
i [ Cancel | )
Click on to negate new settings
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®

Natural Contrast TOFD Display

Negative

256 brightness levels of TOFD Map from absolutely white to absolutely black are distributed for RF signals,
which's half waves do vary from minus 100% to plus 100% of A-Scan display height. Positive half wave
signals equal or exceeding plus 100% of A-Scan display height are represented by absolutely black color.
Negative half wave signals equal or exceeding minus 100% of A-Scan display height are represented by
absolutely white color

Positive

256 brightness levels of TOFD Map from absolutely black to absolutely white are distributed for RF signals,
which's half waves do vary from minus 100% to plus 100% of A-Scan display height. Positive half wave
signals equal or exceeding plus 100% of A-Scan display height are represented by absolutely white color.
Negative half wave signals equal or exceeding minus 100% of A-Scan display height are represented by
absolutely black color

Negative Positive
+200% +200%

+ 100% + 100%
# #

& &

i # i #
5 5
P base line 0% »"  base line 0%
4 4
Jiﬁip Jiﬁip

- 100% - 100%
- 200% - 200%
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®

Soft Contrast TOFD Display

Negative

256 brightness levels of TOFD Map from absolutely white to absolutely black are distributed for RF signals,
which's half waves do vary from minus 200% to plus 200% of A-Scan display height. Positive half wave
signals equal or exceeding plus 200% of A-Scan display height are represented by absolutely black color.
Negative half wave signals equal or exceeding minus 200% of A-Scan display height are represented by
absolutely white color

Positive

256 brightness levels of TOFD Map from absolutely black to absolutely white are distributed for RF signals,
which's half waves do vary from minus 200% to plus 200% of A-Scan display height. Positive half wave
signals equal or exceeding plus 200% of A-Scan display height are represented by absolutely white color.
Negative half wave signals equal or exceeding minus 200% of A-Scan display height are represented by
absolutely black color

Negative Positive
+200% +200%
+ 100% + 100%
e a
& &
g g
9r1 @ﬂ
[ éﬁ
. p base line 0% , p’ base line 0%
I I
v
Jiﬁip \;ifii

- 100%

- 100%

- 200%

- 200%
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®

Sharp Contrast TOFD Display

Negative

256 brightness levels of TOFD Map from absolutely white to absolutely black are distributed for RF signals,
which's half waves do vary from minus 50% to plus 50% of A-Scan display height. Positive half wave
signals equal or exceeding plus 50% of A-Scan display height are represented by absolutely black color.
Negative half wave signals equal or exceeding minus 50% of A-Scan display height are represented by
absolutely white color

Positive

256 brightness levels of TOFD Map from absolutely black to absolutely white are distributed for RF signals,
which's half waves do vary from minus 50% to plus 50% of A-Scan display height. Positive half wave
signals equal or exceeding plus 50% of A-Scan display height are represented by absolutely white color.
Negative half wave signals equal or exceeding minus 50% of A-Scan display height are represented by
absolutely black color

Negative Positive
+200% +200%
+ 100% + 100%
A A
é &
g i
@[1 +50% 9[1 +509,
5° 5
. [ base line 0% , p base line 0%
| I
Ji?ip \;iﬁil:r
-50% 50%
-100% - 100%
- 200% - 200%
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9.3. Printer Selection

This option is available if there are more than 1 printer drivers installed in ISONIC 2008

[ 1]|operate

[zl Postprocessing

@Seﬂlngs

/ [4]Exit To Windows

‘ |?] Shut Down

A
In the ISONIC 2008 Start Screen or press 2 _J on front panel keyboard or on external

keyboard

[ 1]instrument

[2]international

E‘Encoders

lz‘ Printer Selection

5 Back

lz
-

In the appeared ISONIC 2008 Settings Menu or press _,.‘.'_JI on front panel keyboard or on
external keyboard

Select Printer:
HP Laserlet 6P -

Save Cancel | A,

Select printer then
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9.4. Exit to Windows

[ 1 |operate

zl Postprocessing

[3]settings

E Exit To Windows

|?_ Shut Down

-
In the ISONIC 2008 Start Screen or press _4 J on front panel keyboard or on external

keyboard

located in the Windows Desktop

To return to ISONIC 2008 Operation double click on icon

®

Exit to Windows is required for:
O Connection to network
0 Printing inspection results to network printer
o Transferring data to / from remote PC
O Installing printer driver(s)
O Quasi-disk management
In order to prevent overloading of ISONIC 2008 quasi-disk and memory with data and non ISONIC 2008
software that may affect instrument performance it's not allowed to install non ISONIC 2008 software except
drivers noted above. Affecting of instrument performance through installing on non ISONIC 2008 software
except drivers noted above is the warranty exemption damage

9.5. Connection to Network

To connect ISONIC 2008 to local area network using Ethernet connector (refer to paragraph 4.2 of this
Operating Manual) and standard Windows rules
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9.6. External USB Devices
9.6.1. Mouse

Use one of 2 USB Connectors (refer to paragraph 4.2 of this Operating Manual). ISONIC 2008 founds and
registers external USB mouse automatically through standard Windows routine. Microsoft optical mouse is
recommended

9.6.2. Keyboard

Use one of 2 USB Connectors (refer to paragraph 4.2 of this Operating Manual). ISONIC 2008 founds and
registers USB keyboard automatically through standard Windows routine. Microsoft keyboard is
recommended

9.6.3. Memory Stick (Disk on Key)

Use one of 2 USB Connectors (refer to paragraph 4.2 of this Operating Manual)

ISONIC 2008 running under Windows XP Embedded founds and registers USB memory stick (disk on key)
automatically through standard Windows routine.

9.6.4. Printer

Use one of 2 USB Connectors (refer to paragraph 4.2 of this Operating Manual). Preliminary driver setup is
required. To install driver use network connection (refer to paragraph 8.5 of this Operating Manual) or USB
memory stick (disk on key) if it's already registered in ISONIC 2008
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9.6.5. ISONIC Alarmer
For a variety of manual and automatic inspection applications it may be necessary:

genrating sound alarm on defect detection

controlling some external devices, such as sorters, multi-element go/no go display panels, etc
starting inspection and recording process upon receiving triggering signal from an external device
etc

A variety of above tasks is resolved by simple ISONIC Alarmer (part # SE 554780987), which is interfaced
to ISONIC 2005, 2006, 2007, 2008 instrument through USB port

e |SONIC Alarmer may be connected to the instrument at any moment since ISONIC 2008 Start
Screen became active (refer to paragraph 4.3 of this Operating Manual)

e |SONIC Alarmer may be disconnected from the instrument at any moment prior to shut down (refer
to paragraph 4.3 of this Operating Manual)
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ISONIC Alarmer includes:

Internal Speaker, which is switched ON / OF according to alarm logic settings of UDS 3-5 Pulser
Receiver in the ISONIC 2005, 2006, 2007 instruments / UDS 3-6 Pulser Receiver of ISONIC 2008
Instrument

Speaker Volume Control Wheel

Headphone Connector

Input / Output Control chip

25-pin programmable Input / Output interface

Input / Output 25-pin programmable Input
Controller Chip / Output interface

Internal
Speaker

USB Port for Headphone Speaker Volume
connection to ISONIC Connector Control Wheel
2005, 2006, 2007,

2008 Instrument

Initially ISONIC Alarmer is configured to deliver sound through speaker and headphone connector (standard
configuration)

25-pin input / output interface is configured according to the duty book, which is agreed with the customer
(optional configuration)
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Standard configuration pin-out of 25-pin input / output interface D-Type connector is shown below:

3
_ 0
GBI o 27_GND
GB2__15
~GB3 3| _Oo 26 GND
— T .°
—Tme T °
—GB 5 1.°
J
GAD 18 °
GAL__6 0
GAr 101 °
GA3 7 0
—_——0
—GasgT©
—Ga6 o1 1 °
Al o 1.°
— > [ °
o O
PR
11 0
P
P PR
%510
E] O
_o
/ ~
D Comnector 25
Pin Function

Numbe

Ground

Alarm Gate B — Channel 1 (Only Channel for ISONIC 2005, 2006)

Alarm Gate B — Channel 3

Alarm Gate B — Channel 5

Alarm Gate B — Channel 7

Alarm Gate A — Channel 1 (Only Channel for ISONIC 2005, 2006)

Alarm Gate A — Channel 3

Alarm Gate A — Channel 5

Alarm Gate A — Channel 7

NC

NC

NC

NC

Alarm Gate B — Channel 0

Alarm Gate B — Channel 2

Alarm Gate B — Channel 4

Alarm Gate B — Channel 6

Alarm Gate A — Channel 0

Alarm Gate A — Channel 2

Alarm Gate A — Channel 4

Alarm Gate A — Channel 6

NC

NC

NC

NINNNNN (R (R (R(R PR Rk
g~ W|N|P|O|o|m|~N|o|o|r|w|N|k|o|©R (N o0~ IWIN -

NC
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9.7. External VGA screen / VGA projector

Connect to appropriate connector (refer to paragraph 4.2 of this Operating Manual) while at least one of 2
devices either ISONIC 2008 or external screen / projector is switched OFF then switch on one or both
devices

9.8. Software Upgrade

Refer to http://www.sonotronndt.com/support.htm in the Internet
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9.9. Charging Battery

Battery of ISONIC 2008 may be charged while disconnected from the unit. The special charger is required
(refer to Chapter 3 of this Operating Manual). Connect charger to the battery as it is shown below

— T

i

There is Charge LED on the charger. While charging the battery this LED emits solid light. Charge LED
starts flashing upon charge is completed

®

If a battery is new and almost completely discharged then "boiling" effect in the electrolyte may start earlier
than battery is fully charged. In order to prevent battery charger stops on detecting boiling "boiling" effect:

O |If temperature inside battery does not exceed 60°C deg limit then Charge LED starts flashing — for
such case it is necessary to disconnect charger from mains for few minutes and to connect it to
mains again. The normal charging will continue

Q If temperature inside battery exceeds 60°C deg limit then Temp LED starts flashing — for such case
it is necessary to disconnect charger from mains for at least 2 hours and to connect it to mains
again. The normal charging will continue

After few charge / discharge cycles battery becomes "trained" and probability of "boiling" effect decreases to
almost zero
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9.10. Silicon Rubber Jacket

Establishing Image:

POWER® LOW-BAT®

Sonotron NDT

POWER® LOW-BAT®
Sonotron NDT

&)
&) @
3 @==
e @

4
-

®)(%)

ISONIC 2008
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Lift-up and remove the handle:
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Slip the Silicone Rubber Jacket around the machine until it fits properly and covers all edges:

POWER® LOW-BAT® .
Sonotron NDT

@

2 @
(3] (e)=)=)
@
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Put the handle back in position and twist it until it locks in place:

DONE!

POWER® LOW-BAT®
Sonotron NDT
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10. Dual Channel TOFD preamplifier
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SA 80442 Fixed Gain Dual Channel

Preamplifier Package from Sonotron NDT

improves long cable connection to

ultrasonic probes, which may be required

in NDT practice very often. Typical
applications are TOFD, Corrosion
Detection, and the like implemented
through use of probes fitted into the
scanner / crawler frame

Technical Data:
Independent Channels

Frequency Band

Advanced Low Noise Design

Gain
Output Impedance
Output Driving Capacity — Cable Length

Terminals

Power

Flashing LED Indicators

Housing
Dimensions

Weight

0.2...25 MHz at -3dB

34 nV peak to peak input referred to 20 dB gain / 25
MHz bandwidth

20dB
50 Q
<30m

Input 2 X LEMO 00
Output 2 X LEMO 01

4 X Dry Alkaline Batteries AA Size
Channel 1 Switch ON

Channel 2 Switch ON

Low Battery

Sealed IP 67 Rugged Aluminum Case
62 X 30X 112mm (2.44 X 1.18 X4.4")

320 g (0.7 Ibs)
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